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International Business Machines Corporation Armonk, New York 10504 

IBM Program License Agreement 
BEFORE OPENING THIS PACKAGE, YOU SHOULD CAREFULLY READ 
THE FOLLOWING TERMS AND CONDITIONS. OPENING THIS 
PACKAGE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND 
CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD 
PROMPTLY RETURN THE PACKAGE UNOPENED AND YOUR MONEY 
Will BE REFUNDED. 

This is a license agreement and not an 
agreement for sale. IBM owns, or has 
licensed from the owner, copyrights in 
the Program. You obtain no rights other 
than the license granted you by this 
Agreement. Title to the enclosed copy of 
the Program, and any copy made from it, 
is retained by IBM. IBM licenses your 
use of the Program in the United States 
and Puerto Rico. You assume all respon­
sibility for the selection of the Program 
to achieve your intended results and for 
the installation of, use of, and results 
obtained from, the Program. 

The Section in the enclosed docu­
mentation entitled "License Information" 
contains additional information con­
cerning the Program and any related 
Program Services. 

LICENSE 
You may: 
1) use the Program on only one 

machine at any one time, unless 
permission to use it on more than 
one machine at any one time is 
granted in the License Information 
(Authorized Use); 

2) make a copy of the Program for 
backup or modification purposes 
only in support of your Authorized 
Use. However, Programs marked 
"Copy Protected" limit copying; 

3) modify the Program and/or merge it 
into another program only in support 
of your Authorized Use; and 

4) transfer possession of copies of the 
Program to another party by trans­
ferring this copy of the IBM Program 
License Agreement, the License 
Information, and all other documen­
tation along with at least one 
complete, unaltered copy of the 
Program. You must, at the same 
time, either transfer to such other 
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party or destroy all your other copies 
of the Program, including modified 
copies or portions of the Program 
merged into other programs. Such 
transfer of possession terminates 
your license from IBM. Such other 
party shall be licensed, under the 
terms of this Agreement, upon 
acceptance of this Agreement by its 
initial use of the Program. 

You shall reproduce and include the 
copyright notice(s) on all such copies of 
the Program, in whole or in part. 

You shall not: 
1) use, copy, modify, merge, or transfer 

copies of the Program except as 
provided in this Agreement; 

2) reverse assemble or reverse compile 
the Program; 
and/or 

3) sublicense, rent, lease, or assign the 
Program or any copy thereof. 

LIMITED WARRANTY 
Warranty details and limitations are 
described in the Statement of Limited 
Warranty which is available upon request 
from IBM, its Authorized Dealer or its 
approved supplier and is also contained 
in the License Information. IBM provides 
a three-month limited warranty on the 
media for all Programs. For selected 
Programs, as indicated on the outside of 
the package, a limited warranty on the 
Program is available. The applicable 
Warranty Period is measured from the 
date of delivery to the original user as 
evidenced by a receipt. 

Certain Programs, as indicated on the 
outside of the package, are not warranted 
and are provided "AS IS." 

Continued on inside back cover. 
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Second Edition (September 1987) 

Changes are periodically made to the information herein; these 
changes will be incorporated in new editions of this 
publication. 

This manual contains examples of data and reports used in 
daily business operations. To illustrate them as completely as (\, 
possible, the examples contain the names of individuals, 
companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used 
by an actual business enterprise is entirely coincidental. 

References in this publication to IBM products, programs, or 
services do not imply that IBM intends to make these available 
in all countries in which IBM operates. Any reference to an 
IBM licensed program in this publication is not intended to 
state or imply that only IBM's licensed program may be used. 
Any functionally equivalent program may be used instead. 

The following paragraph applies only to the United States and 
Puerto Rico: A form for reader's comments is provided at the 
back of this publication. You may use this form to 
communicate your comments about this publication, its ｾ＠

organization, or subject matter with the understanding that 
any of the information you supply may be used by IBM in any 
way without becoming obligated to you. If the form has been 
removed, address your comments to: IBM Corporation, P.O. 
Box 720576, Atlanta, GA 30358-2576. 

© Copyright International Business Machines Corporation 
1987 
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Preface 

Where to Find Information 

Book 

This book teaches you how to use Storyboard Plus. It also 
contains reference information and your program 
diskettes. 

Quick Reference 

The reference card is an easy way to find information you 
need when using your keyboard with Picture Maker, 
Story Editor and Text Maker. 

Fl Key 

If you have a question about Storyboard Plus while you're 
using it, use the Fl key for help. 
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How This Book is Organized 

Introducing Storyboard Plus 

Defines the five major parts used to create and display 
stories. It also explains the software and hardware 
requirements, how to use the Storyboard Plus 
Backup/Install and the Quick Menu/Setup program, and 
how to start and select Storyboard Plus tools. 

Tutorial 

Gives you step-by-step instructions on the most commonly 
used commands in Picture Maker, Story Editor, and Story 
Teller. 

Reference 

Explains in detail all the commands used in Picture 
Maker, Picture Taker, Story Editor, Story Teller, and ｾ＠

Text Maker. 

Appendixes 

Appendix A. Lists the messages Storyboard Plus 
produces and their meanings. 

Appendix B. Describes all of the hardware Storyboard 
Plus supports. 

Appendix C. Explains how to add Storyboard Plus to the 
Assistant Series Quick Menu/Setup 
Program Menu. 

Appendix D. Explains where to obtain information on ("' 

lV 

the Picture Maker and Digitize Driver file 
formats. 



Appendix E. Describes how to set up a Kodak Remote 
Control Adapter. 

Appendix F. Explains how to set up Storyboard Plus to 
work on the IBM PC Local Area Network 

Ｎｾ＠ (LAN). 

Prerequisite Knowledge 

To use Storyboard Plus, you need some knowledge of how 
to use the IBM Personal Computer Disk Operating System 
(DOS) or an equivalent operating system. It is assumed 
that you have this prerequisite knowledge, because we do 
not attempt to teach DOS concepts in this book. For infor­
mation about DOS, see your DOS book. 

Related Programs 

In this book, we refer to the DOS 2.10 (or later) program 
that you purchase separately. 

How to Obtain Service for 
Storyboard Plus 

Program service is available for this Personal Computer 
licensed program (P/N6024401 FC 4401) during the first 90 
days from the date of delivery to you by IBM or IBM's 
authorized representative. You must register for this 
service by completing and mailing the attached postage 
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paid Service Registration card enclosed in the Read This 
Information First package 

IBM Corporation 
P. 0. Box 720576 
Atlanta, GA 30358-2576 

Available Service 

If you determine that you have a problem caused by a defect 
in an unmodified portion of the program during the 90-day 
service period, you may mail to IBM a description of the 
problem using the Program Problem Report form contained in 
the Read This Information First package. Or you can print the 
Program Problem Report form out on your printer. Here's 
how: 

1. Place DOS in the default drive and turn on your computer. 

2. Align the paper and turn on your printer. 

3. At the DOS prompt, remove the DOS diskette from the 
drive and insert the Storyboard Plus Diskette 1. 

4. Type pcsprob and press Enter. 

5. A copy of the Program Problem Report form will be 
printed. 

IBM will evaluate your documentation to determine if a 
program correction is necessary and: 

1. If the problem is an error and has been fixed, you will be 
sent a notice of availability or an update containing the 
correction; 

OR 
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2. If the problem is an error that has not previously been 
reported, IBM will make reasonable efforts to develop 
a correction and send it to you; 

OR 

Ｎｾ＠ 3. You will be advised that the problem is not caused by 
a program defect. 

A response to a defect will be made only if the defect 
occurs when the program is used in the operating environ­
ment described in this document. 

IBM does not guarantee that the program will be error­
free, or that all program defects will be corrected. 

Duration of Program Service 

Service will be available during the first 90 days from the 
date of delivery to you by IBM or IBM's authorized repre­
sentatives, but not later than June 30, 1989. During the 
service period, if you transfer this license to another 
party, you must provide IBM with information about the 
new user: name, company, telephone number, and the 
service registration number (instructions for displaying 
the service registration number are located in the support 
information brochure). This information must be sub­
mitted to the following address: 

IBM Corporation 
P. 0. Box 720576 
Atlanta, GA 30358-2576 
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Program Specifications 

Licensing 

The use of Storyboard Plus is subject to the terms 
and conditions of the IBM Program License 
Agreement (Z125-3301-02) contained in this book, 
except as specifically stated here with respect to the 
Story Teller module. 

The Story Teller module (ST.EXE and STl.PDR) 
allows Storyboard Plus stories to be displayed. 
Additional copies of only this module may be made to 
allow the user to distribute and show stories, 
provided that each diskette copy is labeled as 
follows: 

(\, 

CONTAINS Ｎｾ＠
IBM Story Teller program (ST.EXE & STl.PDR) 
©Copyright IBM Corp. 1985, 1986, 1987 
All Rights Reserved 

Program Updates 

viii 

We want you to have the most recent update to the 
program that you have licensed. Upon receipt of 
your Service Registration Card, IBM will send you a 
program update if changes have been made since 
your copy was manufactured. 

Licensed users beyond the 90 days Program Service 
period may request updates for supported licensed 
programs before the program service end date. 
Program updates contain all currently available 



IBM Extended Support - 12 Month 
Subscription Period 

IBM Extended Support continues your IBM support for 12 
ｾ＠ months. 

• Toll-free telephone assistance 
• Program service 
• IBM Extended Support Response Journal 
• Program updates (one copy per required update). 

To purchase this service, you must register by completing 
and mailing the IBM Extended Support Subscription 
Application provided with the Extended Support Offering 
information contained in the Read This Information First 
package. This information defines in detail the terms of 
this service agreement. A postage-paid envelope is pro­
vided along with your application. 

Extended support pricing information will be sent to you 
upon receipt of your application. Or, you can call the toll­
free number provided below. 

1-800-IBM-2266 

IX 



OTHER SERVICES OFFERED BY IBM INCLUDE: 

Single Incident Service 

If you have not subscribed to 12 months of IBM Extended 
Support, you can still obtain IBM support on an indi­
vidual problem basis. If you have a question or a problem 
with a supported program, then for a fee you may receive 
(as applicable): 

• Toll-free telephone assistance 
• The current issue of the IBM Extended Support 

Response Journal 
• Program service (includes a program update if one is 

required). 

For Additional Information 

For additional support information and prices, check the 
box on the Service Registration Card, or call the IBM 
Problem Support Center at 1-800-IBM-2266. 

Operating Environment 

To use Sto;ryboard Plus, you need the following equipment 
and programs: 

• A supported computer from the IBM Personal Com-

x 

puter or Personal System/2 family with at least 320Kb f". 
of memory and one 5.25-inch, double-sided, diskette 
drive or one 3.5-inch diskette drive. 



• A supported graphic display from the IBM Personal 
Computer or Personal System family or a compatible 
80-column personal computer display capable of dis­
playing graphics. 

• A keyboard or supported mouse input device. (The 
mouse is recommended when using either Picture 
Maker or Story Editor.) 

• The IBM Disk Operating System (DOS) Version 2.10 or 
later for most IBM Personal Computers, except: 

The IBM PCjr requires DOS 2.10. 
The IBM Personal Computer AT® requires DOS 
3.00 or later. 
The IBM PC Convertible requires DOS 3.20. 
The IBM Personal System/2 Models 30, 50, and 60 
requires 3.30. 

• The four 5.25-inch, double-sided, double-density 
Storyboard Plus diskettes or two 3.5-inch, double-sided, 
diskettes and this instruction book. 

Optional Equipment 

• Mouse 
• Joystick 
• Graphic tablet 
• A supported printer from the IBM Personal Computer 

family or a compatible serial or parallel printer. 
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About Storyboard Plus 

Storyboard Plus is a productivity aid that can be used by 
people who present information to others. A business or 
professional user can use this tool to create computer con­
trolled presentations which can be shown directly on the 
IBM Personal Computer, projected with a video projector, 
or transferred to. other media such as video tape, slides, or 
paper. 

Storyboard Plus consists of the following five major parts 
that are used for story creation and display: 

• Picture Maker 

• Picture Taker 

• Story Editor 

• Story Teller 

• Text Maker . 

Picture Maker 

Picture Maker allows you to create pictures and modify 
previous pictures saved by Picture Maker or graphic pic­
tures taken with Picture Taker. We recommend that you 
use a "mouse" to draw with, although you can also use a 
keyboard, joystick, or graphic tablet to draw free-form 
figures, boxes, lines, and ellipses. You can select various 
color patterns to paint your picture. You can create busi­
ness charts, including horizontal and vertical bar graphs, 
line graphs, and pie charts. You can "magnify" a part of 
the picture so that very detailed work can be done. 

For text characters (graphic text) created in Picture 
Maker, you can choose from several typefaces and styles. 
You can also create your own text characters. The c;harac-
ters may be displayed in boldface. You can italicize, (\ 
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underline, shadow, or outline any group of characters. 
You can display your characters in five different sizes, set 
the amount of spacing between characters, and justify 
lines of text. 

Depending on the display, the adapter card, and the resol­
ution mode you have selected, you can use several dif­
ferent colors with which to draw lines, rectangles, and 
circles. 

Picture Taker 

Picture Taker allows the contents of screens created by 
IBM Personal Computer DOS programs to be "captured" 
and saved on disk for later inclusion in a story. Screen 
contents are written to diskette or fixed disk in a com­
pressed format. Pictures can all be saved in one file or 
saved individually. Various screen formats may be taken, 
including 40-column and 80-column color text modes, and 
medium and high resolution color graphics modes. 

Story Editor 

Story Editor allows you to display pictures previously 
made by Picture Maker, Picture Taker, or Text Maker 
and sequence those pictures into stories using special dis­
solve techniques both between pictures and within pic­
tures. 

As you interactively create a story, you can see the 
results of an addition or change immediately. You can 
display pictures sequentially forward or backward, or 
jump to specific lines in the story table. After you create 
or modify a story, you can save it on diskette or fixed 
disk. 
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Story Teller 

Story Teller allows you to display stories previously 
created by Story Editor. You can make presentations to 
large groups on a large monitor or video projector, if the 
monitor or projector is supported by the hardware being f".., 
used. If you are using the IBM Personal Computer Color 
Graphics Adapter (CGA) card, you can record the entire 
show on video tape by connecting the "video out" port on 
the CGA card to the "video in" jack on a standard VCR. 

Text Maker 

Text Maker allows you to create or modify text screens 
created with Text Maker or text screens taken with 
Picture Taker. Later, using Story Editor you assemble 
these text screens, along with graphic pictures created by 
Picture Maker, into your story. 

Getting Started 

The tutorial demonstrates how to combine some of the 
most commonly used tools in Picture Maker, Story Editor, 
and Story Teller to create a story presentation. 

The first part of this tutorial, "Picture Maker," takes you 
step-by-step through the process of creating pictures for a 
presentation. You'll draw and color boxes, enter text, and 
make graphs. In the second part, "Story Editor," you will 
organize pictures created in Picture Maker into stories 
that can be presented with a wide variety of special effects 
and timings. In the last part of this tutorial, "Story 
Teller," you will present_the story on your display. 

This book assumes you are familiar with your system 
hardware and know how to start DOS. 

1. Turn on your IBM Personal Computer and start DOS. 
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2. Copy the SYSTEM.PIG, OPENLPIC, OPEN2.PIC, 
ENDSTB.PIC, and TUTORIAL.SH- files from Diskette 
1 onto your work diskette. 

Later in the tutorial you will use these pictures to build 
your story. 

Refer to your Disk Operating System (DOS) book for 
information on how to use the DOS Copy command. 

If you install your program on a disk other than Drive A, 
use the appropriate drive names for your system when you 
work through the exercises in this book. Your DOS book 
can help you set up directory paths. 

If you have one diskette drive on your computer system, 
you will need to replace the program diskette with your 
work diskette after you start Storyboard Plus. As you 
work, leave the work diskette in the drive. 

Using Fl= Help 

As you continue with this chapter, you'll discover that 
instructions appear on the screen as needed and that 
menus lead you through each procedure. 

If you need information about any of the options on the 
Quick Menu/Setup or Main menus, highlight the option 
you want help with and press Fl. At the Picture Maker 
drawing screen and Story Editor screen, place the pointer 
over the item that you want help with and press Fl on the 
keyboard. To get help at the Text Maker Create or Edit 
screen, press Fl. A list of topics on Text Maker appears 
on the screen. Use the i or L key to highlight the topic 
and press Enter to display the help information. To 
remove a Help panel, press the Esc key. 
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Start Backup/Install Program 

Before you begin using Storyboard Plus, use the 
Backup/Install program to make a backup copy of each of 
the original program diskettes, so that if one copy 
becomes damaged, you can use the other to run 
Storyboard Plus. With the Backup/Install program, you 
can also install Storyboard Plus on a disk (which can be 
either a diskette or a fixed disk), or you can remove 
Storyboard Plus from a fixed disk. 

Before entering the Backup/Install program: 

• At the DOS prompt, specify A> as the default drive. 
(See your IBM Disk Operating System (DOS) book for 
an explanation of default drive.) 

• If you want to backup the Storyboard Plus diskettes, 
format and label one blank diskette for each 
Storyboard Plus diskette to be backed up. If you are 
using the 5.25-inch, double-sided, double-density 

(\ 

Storyboard Plus diskettes, you will need four of the ｾ＠

same type 5.25-inch formatted diskettes. If you are 
using the 3.5-inch (double-sided) diskettes, you will 
need two of the same type 3.5-inch formatted diskettes. 

Note: If you intend to store the pictures you create on a 
diskette, you should format one additional diskette. 

At the DOS prompt A>, insert the Storyboard Plus 
Diskette 1 in Drive A and close the diskette drive door. 
Type install and press Enter. The Backup/Install Menu 
appears, listing the three options (also known as tasks) 
you can perform. 
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ie:XX/XXIXX IBM Storyboard Plus 
Backup/Install 

BackuPlinstall Menu 

2. Install an a disk 

3. Remove program from a fixed disk 

To select, use t ar ｾ＠ and press ｾ＠ , 

VereianlOO 
Copyright IBM Corporatian l988. llllr7 

Fl=Help Eec=Exil 

Note that the first option is highlighted in the 
Backup/Install Menu. You can select an option either by: 

• Pressing the number that corresponds to the option on 
the menu. This causes the program to respond imme­
diately, so you don't have to press Enter. 

OR 

• Using the i or ! keys to highlight another option and 
press Enter to select it. To get help, highlight the 
option and press Fl on the keyboard. 

Making a Backup Copy of 
Storyboard Plus 

Make a backup copy of the Storyboard Plus diskettes 
before you begin to use Storyboard Plus. 

At the Backup/Install Menu, follow these steps to back up 
the Storyboard Plus program diskettes: 

1. Select Backup program diskette from the 
Backup/Install Menu. 
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2. Follow the instructions that appear on the screen. 
Remember if you need help, use the Fl key. 

Note: When the backup program option prompts you to 
insert a diskette into the drive, it is referring to the ori­
ginal program diskette. When the backup program option 
prompts you to insert the Backup diskette, it is referring (\, 
to the formatted diskettes to which you are copying the 
program. 

The backup process is complete when the message 
Backup is complete appears. Press the Enter key to 
return to the Backup/Install menu. Store the original 
diskette in a safe place and use the backup copy of 
Storyboard Plus to run the program. If the backup copy 
becomes damaged, you can make another backup copy 
using the Backup/Install program. If you want to install 
Storyboard Plus on a fixed disk, read the next section, 
"Installing Storyboard Plus on a Fixed Disk"; otherwise, 
press Esc and go on to "Starting Storyboard Plus" in this 
chapter. 

Installing Storyboard Plus on a Fixed r\. 
Disk 

Although you can use diskettes to run Storyboard Plus, 
you may choose to install the program on a fixed disk. 
Installing Storyboard Plus on a fixed disk eliminates the 
need to start the program from the diskettes each time 
you want to use it. 

On a fixed disk, we recommend that you install the 
Storyboard Plus programs in a subdirectory named 
STORYBD. 

You can store your data files in any subdirectory, regard­
less of where you install the program. 
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Installation Steps 

The following procedure includes the creation of one sub­
directory which you can name STORYBD or another 
name of your choice. 

At the Backup/Install Menu, follow these steps to install 
the Storyboard Plus program on a fixed disk: 

1. Select Install on a disk from the Backup/Install Menu 
and press Enter. 

Note: The Install on a disk option creates the subdi­
rectory for you automatically. 

2. Follow the instructions that appear on the screen. The 
subdirectory C:\STORYBD appears as the default 
drive and directory path. If you want Storyboard Plus 
installed in a different location, type over 
C:\STORYBD to specify the drive and directory path 
you want. 

ｾ＠ 3. Press Enter and a prompt appears asking you to 
confirm the locations of your disks. Follow the 
instructions that appear on the screen. 

4. Installation is complete when you see the message 
Installation is complete. Press Enter to return to 
the Backup/Install Menu. 

5. If you are using 5.25 inch diskettes, remove Diskette 4 
from the default drive and insert Diskette 1. If you are 
using 3.50 inch diskettes, remove Diskette 2 and insert 
Diskette 1. 

6. Press Esc; then press Y to return to DOS. Store the 
original diskettes in a safe place and use the installed 
program. Go on to "Starting Storyboard Plus" in this 
chapter. 
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Removing Storyboard Plus from a 
Fixed Disk 

If you want to reorganize your fixed disk or move 
Storyboard Plus to another fixed-disk system, you should 
first remove Storyboard Plus from the location where it is (\ 
currently installed. When Remove program from a 
fixed disk is selected, only the program files shipped with 
the product are removed. Any files created by the user 
will remain in the subdirectory. 

Note: This procedure removes Storyboard Plus from your 
fixed disk only, not from diskette. 

Follow these steps: 

1. At the DOS prompt A>, put your Storyboard Plus 
Diskette 1 in Drive A. 

2. Type install and press Enter. The Backup/Install 
menu appears. 

3. Select Remove program from a fixed disk. The sub- (\ 
directory C:\STORYBD appears as the default drive 
and directory path. 

4. If Storyboard Plus is in this directory, press Enter. If 
not, type the name of the directory path where 
Storyboard Plus resides over the default directory path 
and press Enter. 

5. Storyboard Plus is removed from your fixed disk. 

6. Press Enter to return to the Backup/Install Menu. 

7. Press Esc to return to DOS. 
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Starting Storyboard Plus 

With Two Diskette Drives 

ｾＮ＠ To start Storyboard Plus from a two drive system: 

1. At the DOS prompt A>, place the Storyboard Plus 
Diskette 1 in Drive A and your work diskette in Drive 
B. 

2. Type sbmenu and press Enter. 

The Quick Menu/Setup screen appears, with Picture 
Maker highlighted. 

With a Fixed Disk 

To start Storyboard Plus from a fixed disk: 

1. At the DOS prompt C > , change to the subdirectory 
where Storyboard Plus resides and press Enter. 

Example: cd\storybd 

(Refer to your DOS book for information about changing 
subdirectories.) 

2. Type sbmenu and press Enter. 

The Quick Menu/Setup screen appears with Picture 
Maker highlighted. 
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Quick Menu/Setup 

The Quick Menu/Setup program provides a menu to start 
Storyboard Plus. From this menu, you can start the fol­
lowing programs: 

Picture Maker (PM) 
Picture Taker (PT) 
Story Editor (SE) 
Story Teller (ST) 
Text Maker (TM). 

te:XX/XX/XX IBM Storyboard Plus 
Quick Menu/Setup 

Prograrn.s Menu 

ｊＧＮＧｬｩｾｾｴＡＺＱＥＥＱＺｅ｜ｴ｜Ｑ＠
Picture Taker 
Story Editor 
Story Teller 
Text Maker 

Tu start a program use ｴｯｲｾ＠ keyB to 
bigbl.ight the program, then press ｾ＠ . 

Version LOO 
Copyright IBM Corporation 19B6, 1987 

Fl=Help F2-Setup F3=Meau Mainlenance 

Fl=Help 

Esc=Exit 

Fl= Help explains the program options on the Quick 
Menu/Setup menu. Help is available for all options and 
functions in Storyboard Plus. 
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F2=Setup 

F2 =Setup allows you to customize the Storyboard Plus 
program for the type of equipment you have installed on 
your system. Use F2=Setup to indicate how you want 
information displayed or printed. For example, you can 
change the format used to display the date on the Picture 
Maker Main Menu or change the error message screen 
colors. 

Storyboard Plus is preset to work with: 

• An IBM Personal Computer with Drive A as the 
default data path. 

• A keyboard as the input device, and an IBM Pro­
printer as the printer. 

• An IBM Color Display using 320 x 200-4 color as the 
screen resolution. 

If you have other equipment, you must use the Setup 
ｾ＠ Menu to change the default settings for your computer 

system. 

Press F2 to select F2 =Setup. 

te:XX/XX/XX IBM Storyboard Plus 
Quick Menu/Setup 

Program Setup 
ﾷｾ＠

Picture Taker ｕｬｬｦＦｾｾＲ＿ＴＦﾥＣｩ＠
st.cry Editor Default data path 
st.cry Teller Input device 
Text Maker Printer 

Screen color 
Resolution modes 

To start a program 
Sound onfoti 

highligb1 the-== To select, use t or ｾ＠
and press 4-J . 
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Note that the Setup menu (often referred to as a panel) is 
displayed in front of the Program menu. Throughout the 
Storyboard Plus program, successive panels are displayed 
so that you can see your steps as you follow a procedure. 
To go back one step, press Esc. 

Use the j and l to highlight the Setup options and press (\ 
Enter to select them. If there is more than one panel 
assigned to an option, use the PgUp and PgDn keys to 
view the other panel. Now that you know how to select 
options in the Setup menu, you will no longer be asked to 
use the j and l to highlight and press Enter to select the 
option. You will simply be asked to select the option. Go 
ahead and set up Storyboard Plus for your computer 
system, starting with Date Format. 

Date Format 

Date format allows you to change the format of the day, 
month, and year which appears on all of the Program 
main menus. The date format panel displays three formats 
at a time. 

Date formats 
DD.MM.YY 
DD-MM-YY 

YY/MM/DD 
YY.MM.DD 
YY-MM-DD 
MM/DD/YYYY 
MM.DD.YYYY 
MM-DD-YYYY 

DD/MM/YYYY 
DD.MM.YYYY 
DD-MM-YYYY 
YYYY/MM/DD 
YYYY.MM.DD 
YYYY-MM-DD 
MM/DD/YY 
MM.DD.YY 
MM-DD-YY 
DD/MM/YY 
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1. Select Date format. 

2. Select the date format you want to use. 

Default Data Path 

Date:XX/XX/XX 

Fl!l=File Services 

IBM Storyboard Plus 
Quick Merru/Setup 

Derault Data Path 

Type the DOS drive and dlrect.ory path. 

Tb start a P"'l!l"'1l1 wie tort keys to 
bigblight the program, then pres•fJ. 

Eec=Elr:it 

Default Data Path allows you to change the drive and 
path that lead to the subdirectory you want to use to 
retrieve, save, or remove your drawings. Let's change the 
default data path B:\. If you intend to set up a different 
default data path, do so now. When the Default Data Path 
menu appears, type the name of the drive and path (subdi­
rectory) you want to use and press Enter. 

Note: Make sure you've created the directory on the spec­
ified disk before you attempt to change directories. For 
information on creating directories, refer to the "MKDIR 
(Make Directory) Command" in the DOS book. 
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Input Device 

Input device tells Storyboard Plus which input device you 
intend to use. The keyboard is the default input device. 
The input device you select here will be the default 
selection each time you start Storyboard Plus. Change 
your input device to the type you have installed on your 
system. The tutorial assumes you are using a mouse. 

1. Select Input Device. 

When the Input Device panel appears: 

Date:XX/XX/XX 

Fl=Help 

IBM Storyboard Plus 
Quick Menu/Setup 

Programs Merru l 

ｾｾﾷ＠ I 
stmy EditoJ Input Device 
ｓｴＮｯｲｹｔ･ｬｬ･ｲＱＮＭＭｾｾｾｾｾｾｾＭＭ

Terl Maker ｾＧｴ｜ｾｩｽ［ｾＧｴｩｩＪｴ＠

To start a"" IDgbl!ght r.:: 

To select, use tor ｾ＠
and ーｲ･ｳｳｾﾷ＠

Press FlD to accept en changes. 

2. Press Enter to -obtain a list of Input devices to select 
from. 
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Llat of 
Input devices 

IBM Personal System/2 
Keyboard 
Klirta Series One Tablet 
Kurta Series Two Tablet 
Microsoft (seria1) 
Mouse Systems ｾ＠ button) 
Mouse Systems (3 button} 
Summaslret.ch MM1201 Tablet 
Visi On 
Other 

3. Select the input device you are going to use. 

If your Input Device is on a communication line (CO Ml or 
COM2), read the next topic, "DOS Device Name." 

If not, 

1. Press FlO on your keyboard to accept all changes. 

2. Skip the next topic, "DOS Device Name." 

3. Go to "Input Device (Hand and Button Action)." 

DOS Device Name 

If your input device is located on a communication line, 
you need to let Storyboard Plus know if it is on COMl or 
COM2 (communication line 1or2 ). The default for DOS 
Device Name is COMl. 

1. Select either COMl or COM2 (depending on which 
communication line you are using for your input 
device). 

2. Press FlO on your keyboard to accept all changes. 

If your input device is a mouse, read the next topic, 
"Input Device (Hand and Button Action)." This tells 
Storyboard Plus which hand you intend to use to operate 
the mouse and how you want your buttons to operate. If 
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your input device is not a mouse, skip the next topic, 
"Input Device (Hand and Button Action)" and go to 
"Printer." 

Input Device (Hand and Button 
Action) 

Hand 

If you select any of the mouse options, Storyboard Plus 
asks if you want your mouse to be set up for right- or left­
handed operation. The default for Hand is right-handed. A 
right-handed selection makes Button 1 the one on the left 
and Button 2 the one on the right. A left-handed selection 
makes Button 1 the one on the right and Button 2 the one 
on the left. 

Date:XX/XX/XX 

Fl=llelp 
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IBM Storyboard Plus 
Quick Menu/Setup 

Programs Menu 

ｭ･ｾｩＡｴＴｾＱＥＱＱ｜ｩｩ＠

I 

I 
story Editm Input Device 1 
ｳｴＮｯ｣ｹｔ･ｬｬ･ｲＱＭＭｾｾｾｾｾｾｾＭＭＱ＠

Teld.Malmr Ｇｾｩｴ｀ＺｾｩｾｾＰＭｾﾷﾷﾷｾｾｾｾｾｧ｟｟｟ｌＬｉ＠
Input Device 

1b start a pre 
bigblight tllf 

'lb select, use tor ｾ＠
end ーｲ･ｳｳｾＮ＠

Press FlD to accept all changes. 

Esc=Em. 



Button 

You can operate your mouse in two different ways. You 
are given this option so you can select the type of mouse 
operation you feel most comfortable using. Operate the 
default, Button press, by pressing and releasing the 
button to start or stop most commands. 

Operate Button release by pressing and holding the 
button to start most commands, and then releasing the 
button to stop. 

Note: The manual assumes you are using the Button 
press operation. 

Select which hand and button action you intend to use to 
operate your mouse and press Enter. 

Press FlO to accept all changes. 

Using a Joystick as the Input Device 

When you want to use an IBM PCjr Joystick or an IBM 
compatible joystick, you need to install the joystick driver 
program supplied with Storyboard Plus. After you have 
loaded DOS, you must load the joystick driver program 
(which resides on Storyboard Plus Diskette 2) into 
memory before starting Storyboard Plus. 

At the DOS prompt: 

1. Insert Storyboard Plus Diskette 2 in Drive A and type 
joystick. 

You will be instructed to position your joystick in the fol­
lowing positions: 

2. In the upper left corner and press one of the buttons 
on the joystick. 

3. In the center and press one of the buttons on the 
joystick. 
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4. In the lower right corner and press one of the buttons 
on the joystick. 

After the last button has been pressed, a message appears 
indicating the successful installation of the joystick driver 
program. 

When the DOS prompt reappears: 

5. Remove the Storyboard Plus Diskette 2 from Drive A 
and insert Storyboard Plus Diskette 1 into Drive A. 

6. Type sbmenu to start the Storyboard Plus program. 

From the Quick Menu/Setup screen you need to: 

7. Press F2=Setup. 

8. Select Input Device. 

9. Select Other. 

10. Press FlO to accept all changes. 

Remember: When using a joystick, or any other external 
input device, you must install the driver program into 
memory each time before starting Storyboard Plus. The 
driver program will stay in memory until you load another 
input device that requires an external driver program, 
reboot (pressing Ctrl-Alt-Del keys), or turn off your 
machine. 
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Printer 

The Printer option tells Storyboard Plus the kind of 
printer you have installed on your system, the model, the 
type of paper you intend to use, and to what port the 
printer is attached. 

Fl=Help 

IBM Storyboard Plus 
Quick Menu/Setup 

ｾ＠
Model 
Paper feed 
DOS device name 

'lb select., use ｴｯｲｾ＠
and ーｲ･ｳｳｾＮ＠

Press FJD ta eccepl ell clw!pa. 

The printer you select here will be the default selection 
each time you start Storyboard Plus. IBM Proprinter is 
the default for this option. 

1. Select which printer you intend to use with Storyboard 
Plus. 
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Printers 
IBM Color 
IBM Color Jetprinter 
IBM Compact 
IBM 5140 System Printer 
IBM Graphics 
IBM Pageprinter ｾＧ＠
IBM Proprinter 
IBM Proprinter X24 
IBM Proprinter XL 
IBM Proprinter XL24 
IBM QuietWriter Model II 
IBM QuietWriter III 
IDS Prism 123 
NEC8023 
Oki.data 82A 
Quadram Quadjet QJ9000 
Other 
C. Itoh ProWriter 
Epson 
HP LaserJet+ 
HP LaserJet 500+ 

The Model option tells Storyboard Plus if the printer will ｾ＠
be used as a United States printer or as an Other coun-
tries printer. The default is United States. 

2. Select the model you intend to use with Storyboard 
Plus. 

The Paper feed option tells Storyboard Plus the type of 
paper you intend to use. The default is continuous feed. 

3. Select the type of paper you intend to use with your 
printer. 

The DOS device name option tells Storyboard Plus to 
which port your printer is connected. The DOS device 
name panel displays three port positions at a time. 

Hint: Select the LPT device you intend to use (if it is ｾ＠
other than the default, LPTl) for a parallel printer, or 
COMl or COM2 for serial printer. 
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4. Select the port your printer is connected to and press 
Enter. 

DOS device 
names 

LPT1 
LPT2 
LPT3 
CO Ml 
COM2 

5. Press FlO to accept all changes. 

Screen Color 

Screen color allows you to change the colors of text error 
message panels, help text, instructions, screens, and the 
Main Menu. You are given this option so you can change 
screen colors to the ones you feel most comfortable 
viewing. Use the keys described on the panel to make 
your menu item selections. Use Fl= Help for a description 
of each menu item. 

Select the screen colors you want to use and press FlO to 
accept all changes. 

Resolution Modes and Memory 
Requirements 

Storyboard Plus works in four different resolution modes 
and with 4, 16, or 256 drawing colors. 

The "resolution" or sharpness of your drawing is deter­
mined by the number of pixels (also referred to as dots, 
points or pels) on your display. 
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The following chart shows the resolution modes and 
number of colors available in Storyboard Plus: 

# Screen Mimimum Number of 
resolution memory colors 

(Kb) available 

1 320 x 200 320 Kb 4/16 

2 320 x 200 384 Kb 256/256,000 

3 640 x 200 384 Kb 16 

4 640 x 350 512 Kb 16/64 

5 640 x 480 512 Kb 16/64 

Note: Using Storyboard Plus with the 3270 PC Control 
Program requires 640Kb of memory. 

To determine which resolution mode or modes work with 
the hardware you have, locate your display and graphics 
adapter in the following chart. You cannot draw in a 
mode for which you do not have the appropriate hard­
ware. 

If you have this You can 
run in 
modes 

IBM Convertible 320 x 200-4 color 
CGA Option 

PCjr. with PCjr. 320 x 200-4 color 
Color Display 

Portable Personal 320 x 200-4 color 
Computer and 
Color display 

Color Display and 320 x 200-4 color 
Color/Graphics 
Monitor Adapter 

Color Display and 320 x 200-4 color 
Enhanced 
Graphics Adapter 
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If you have this You can 
run in 
modes 

Enhanced 320 x 200-4 color 
Graphics Display 
and Enhanced 
Graphics Adapter 

Enhanced 320 x 200-4color, 
Graphics Display 640 x 200-16 color, 
and Enhanced 640 x 350-16 color 
Graphics Adapter 
(with Memory 
Expansion Card 
and Memory Kit) 

IBM Personal All modes 
System/2 Models 
50 and 60 with 
Color Display 8512 
or 8513 

IBM Personal 320 x 200-4, 320 x 
System/2 Model 30 200-256 color 
with Color Display 
8512 or 8513 

IBM Personal All modes 
System/2 Display 
Adapter with 
Color Display 8512 
or 8513 

3270 PC with AP A 320 x 200-4 color 
adapter 

3270 PC\G 320 x 200-4 color 

3270 PC AT 320 x 200-4 color 

Note: If you select a mode without the proper hardware 
installed, Storyboard Plus will put you in the 320 x 200-4 
color mode. 

Select the resolution mode you intend to use and press 
Enter. 
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Transferring Files into Higher Modes 

The following chart shows which resolution modes (the 
pictures created in the various resolutions) can be trans­
ferred into higher modes. Use the numbers 1 through 5 at 
the top of the chart to represent the resolution modes for 
tr an sf erring your pictures. 

Modes 1 2 3 4 5 

If your 320 x 320 x 640 640 640 
picture 200-4 200-256 x x x 
was color color 200-16 350-16 480-16 
created color color color 
in mode 

You can 1, 2, 2 3, 4, 4, 5 5 
transfer 3, 4, 5 
it into 5 
mode(s) 

Remember: You can switch between the various modes 
only if you have the appropriate equipment. 

Sound On/Off 

You can choose whether or not the program will notify 
you with sound tones when tasks are completed and when 
errors occur. 

1. Select Sound on/off. 

2. Select whether you want the sound on or off. 

Saving the Setup Changes 

1. Press Esc to save your setup selections. A screen 
appears indicating your selections have been saved. ｾ＠

2. Press Enter to continue. 
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F3 =Menu Maintenance 

F3 =Menu Maintenance allows you to change the Quick 
Menu screen colors and edit and sort the program names. 

ｾ＠ Use Menu Maintenance to change the following options 
for the Quick Menu screen: 

• Date format 
• Screen colors 
• Program names 
• Sort the program names. 

After you select an option, use the keys described on the 
panel to make your menu item selections. Select the 
appropriate option to perform the following operations: 

• Select Change Quick Menu date format to change 
the format of the date for the Quick Menu/Setup 
screen. 

• Select Change Quick Menu screen colors to change 
ｾ＠ the color combinations for the Quick Menu/Setup 

screen. 

• Select Edit a program name to change the names on 
the Programs menu. 

• Select Sort program names to rearrange the names 
alphabetically on the Programs menu. 

Summary 

You can install Storyboard Plus on a fixed disk so that 
you don't have to change diskettes as you work with the 
program. 

ｾ＠ Use Setup to customize Storyboard Plus for your computer 
. · system. 
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Use Menu Maintenance to customize your Quick 
Menu/Setup screen colors and edit and sort the program 
names. 
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Creating a Story 

This section explains how to select Storyboard Plus's dif-
ferent types of drawing tools. When you complete this Ｌｾ＠

chapter, you'll have a good working knowledge of Picture 
Maker, Story Editor, and Story Teller. 

The first part of this tutorial, "Picture Maker," takes you 
step-by-step through the process of creating pictures for a 
presentation. You'll draw and color boxes, enter text, and 
make graphs. In the second part, "Story Editor," you will 
organize pictures created in Picture Maker into stories 
that can be presented with a wide variety of special effects 
and timings. In the last part of this tutorial, "Story 
Teller," you will present the story on your display. 

The tutorial assumes that you are using a system that has 
two diskette drives. The program diskette is in Drive A 
and the work diskette is in Drive B. In setting up the 
Storyboard Plus program, the default data path is Drive B, 
your input device is a mouse, your hand action is Button ｾ＠
press, and you have selected resolution mode 320 x 200-4 
color. 
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Using Picture Maker 

Select Picture Maker on the Quick Menu/Setup menu. 
When the Picture Maker Main Menu appears, Draw is 
already highlighted, displaying the resolution mode you 
selected. 

Date:XX/XX/XX Picture Maker 

Fl=lfslp 

Main Menu 
Ｍｾ＠ -

2. IIJput device setup 
3. Input device 
4.Printer 
5. Printer port 

To select, use t or ｾ＠ and press 4-J • 

VersianlOO 

Copyrigbl; ｉｂｍｾ＠ ISll5,llll!7 
CopyrlsJil. Marek end Rafa! Krepec Inc ISll5, llll!7 

There are three methods for selecting Draw: 

• If you are using a mouse, press Button 1. 

• If you are using the keyboard, press the (number) 1 
key. 

• Press the Enter key on the keyboard. 

When the drawing screen appears, you are ready to begin 
drawing. But before you do, let's briefly describe the tools 
used to create and edit your drawings. 

2-3 



Moving the Pointer 

The pointer is located in the upper left-hand corner of the 
drawing screen. This pointer is used to select icons, pat­
terns, and options from the menus and to perform their 
functions in the drawing space. 

i e Edit Modes Tools Text 

--ＱＰＰＮ｟｟ｾｾｾｾｾｾｾｾｾｾＭＭＭＧ＠
You can move the pointer with a mouse, keyboard, or 
other input device that has the appropriate device driver 
installed. The four main areas of the drawing screen are: 

• Menu area 
• Icon area 
• Color pattern area 
• Drawing area. 
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Ed t Modes Tools 

D= --loo 

Icon 
area 

Menu area 

Menu area 

Drawing 
area Color 

pattern 
area 

The Menu area manages your picture files. Each key word 
in the Menu area represents different menus you can use 
to manage your pictures. 

ｾ＠ Iconarea 

The Icon area uses the following items to help draw your 
pictures: 

Icons 

Color Palette 

The drawing and painting symbols 
called icons represent the tools 
available to use with Picture Maker. 
For a description of each icon, use 
the Help function. 

Displays the various drawing colors 
that can be used to draw your 
picture. Drawing colors affect the 
Text, Pencil, Line, Rectangle, Circle, 
and Microscope icons. If the 
drawing color is made the active 
color pattern, then it also affects the 
Brush, Fill, and Spray icon. 
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Line styles Displays the different widths and 
styles of lines that can be used to 
draw your pictures. 

Active pattern box Displays the current color pattern or 
drawing color being used to paint. 

Color number 

Button status 

Color pattern area 

The Brush, Fill, and Spray icons and (\. 
the Fill Shape mode are affected by 
the color pattern displayed in this 
box. 

Displays the number that corre­
sponds to the color that is currently 
selected. 

Displays which button is active on 
your input device. 

The Color pattern area displays the colors and patterns 
available to use with the different drawing tools. Some 
resolution modes have two sets of color patterns for your 
use. 

Let's retrieve our first picture to edit. 

Retrieving a Picture 

The first thing you need to do is retrieve the first illus­
tration copied to your work diskette. 

Here's how to retrieve the SYSTEM.PIC file from the 
work diskette. 

1. Select File in the Menu area of the drawing screen by 
moving the pointer to File and pressing Button 1. The 
File menu will be displayed showing all of the options 
available. ｾ＠

2-6 



2. Select Get Picture by moving the pointer to Get 
Picture and pressing Button 1. 

Ed t Modes Tools Text 

Show Page 
Print 

Main Menu 

3. Move the pointer to the Filename box in the lower 
right-hand corner, place it directly over the filename 
SYSTEM.PIC, and press Button 1. 

- - -
C:::J ,___ ,___ 
c:=i Drive Directory Ff lename --c:=i 

A < Previous > ,___ ,___ ,...__ 
- ..... ..... ..... D= B --- - -- " --c ,...__ .... .... '\ .... --- --
100 --

Note: If the SYSTEM.PIC file is not displayed on the 
first page of the Filename box, move the pointer to the 
Page Down arrow on the right of the Filename box 
and press Button 1 until the SYSTEM.PIC filename 
appears. 

4. Move the pointer to YES in the GET Picture file box 
and press Button 1. 

e Edit Modes Tools Text 
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This retrieves the SYSTEM.PIC file from the work 
diskette. 

F le Edit Modes Tools Text 

ｉｾ＠ E:Jai 

()= --ｬｯｯｾｾｾｾｾｾｾｾｾｾｾｾ＠
Let's draw a display for your story using the Rectangle 
and Circle icons. 

To draw your display unit, use the Rectangle and the (\ 
Circle icons. The Rectangle icon is used to draw boxes of 
any size or shape. The Circle icon is used to draw circles 
or ellipses of any size or shape. 

Using the Rectangle Icon 

1. Move the pointer to the Rectangle icon and press 
Button 1. 

D 
When the Rectangle icon is selected: 
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• Use Button 1 to start and undo a rectangle. 
• Use Button 2 to fix the rectangle in the drawing 

space and create more rectangles from the same 
corner. 

• Your pointer becomes a crosshair in the drawing 
space. 

Hint: If you find that you can draw only squares, 
select· Modes (in the Menu area) move your pointer to 
Constrain, and press Button 1. This enables you to 
draw rectangles other than squares. 

ii d 
Cr sshafr 
Buffer Fill 
Compos I te V 1 deo 
Transparent Co 1 or 
Back ound Co 1 or 

For information on any option in the icon area, posi­
tion the pointer on the option and press Fl for help. 

Note when Button 1 is pressed that the center of the 
crosshair symbol anchors the first corner of the rec­
tangle. From the anchored corner you can pivot and 
expand the rectangle in any direction. 

Draw three boxes, using the following steps: 

2. Move the pointer to the drawing space as shown in the 
picture and press Button 1. 
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e Edlt Modes Tools Text 

+ 

C>= --ＱｄｄＧＭＭｾｾｾｾｾｾｾｾｾｾＭＭｊ＠
3. Expand the rectangle by moving the mouse, like the 

one shown and press Button 2 to fix it in the drawing 
space. 

e Edit Modes Tools Text (c) IBM 1987 

-ＡｄｄＮ｟｟ｾｾｾｾｾｾｾｾｾｾｾｾ＠
4. Press Button 1 to reposition the crosshair symbol and 

begin the second rectangle. 

Note: If you make a mistake, select Undo in the Edit 
menu and try again. 
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5. Place the crosshair symbol inside the rectangle you've 
already drawn (as shown) and press Button 1 to start 
the second rectangle. 

1 e Edit Modes Tools Text 
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6. Expand the rectangle (as shown) and press Button 2 

to fix it in the drawing space. Make sure you leave 
enough space on the right side to draw the third box 
and the knobs of your display. 

D= --

1 e Edit Modes Tools Text 

Leave space 
for the thlrd 

ｾＧＧＢＧＢＧＧＧﾷ＠

ｬｯｯＬ｟｟ｾｾｾｾｾｾｾｾｾｾＭＭＭＧ＠

7. Press Button 1 to reposition the crosshair for the 
third rectangle. 
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8. Now make the third rectangle. 

SYSTEM.Pie F le Ed t Modes Tools Text 

+r 

-ＱｄｄｌＭＭｾｾｾｾｾｾｾｾｾｾｾＭＭＧ＠
Remember: To select a new icon, both status boxes in 
the lower left corner of the icon area have to be inac­
tive. 

D= - Status 
boxes 

Button 
1&2 
inactive 

DD 

Button Butt.on 
1 2 

active active 
•D D• 

Move the crosshair symbol to the icon area and select 
Circle. 

0 
When the Circle icon is selected: 
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• Use Button 1 to start and undo the circle. 
• Use Button 2 to fix the circle on the drawing space 

and create more circles from the same center point. 
• Your pointer now becomes a crosshair in the drawing 

space. 

ｾ＠ The Circle icon uses Buttons 1 and 2 just as the Rectangle 
lCOn. 

Hint: If you cannot draw perfect circles of any size, select 
the Modes menu and select Constrain. When Constrain 
is turned on, it enables you to draw circles rather than 
ellipses. 

Draw two knobs on your PC, as shown. As you draw the 
circles, note that the center of the crosshair is the center 
of the circle. 

e Edit Modes Tools Text (cl IBM 1987 

nKnobs 

ｾ＠
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Saving a Picture 

Now let's save the drawing and name it PCl. 

ｾ＠ 1. Select File in the Menu area of the drawing screen by 
moving the pointer to File and pressing Button 1. The 
File menu will be displayed showing all of the options 
available. 
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2. Select Save Picture by moving the pointer to Save 
Picture and pressing Button 1. 

+T 
[]Ji 

_,.,,,Edit Modes Tools Text 

Get Picture 

ＱＡＡｾｾｾ＠
Show Page 
Print 

Main Menu 

3. Move the pointer to New in the Filename box and 
press Button 1. The word New disappears and the line 
becomes highlighted with a blinking cursor. The 
blinking cursor lets you know that you can now type 
your filename. The filename can contain up to 8 alpha­
numeric characters. 

--
Dr1ve Directory Ff lename --A < Previous > 

..... ..... ..... 
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Notes: 

a. If .PIC files is highlighted, the file extension of all 
files displayed in the Filename column will be .PIC. 
While .PIC files is highlighted, any pictures saved 
will use .PIC as the file extension. 

b. If All files is highlighted, all of the files in the 
selected directory will be displayed. You can save a 
picture using any three characters as the file exten­
sion. To change the extension, type the filename and 
then press the "." key. The cursor will move into the 
extension field for you to enter a new file extension. 

4. Type PCl and press Enter on your keyboard. 

5. Move the pointer to YES in the SA VE Picture file box 
and press Button 1. Your file is saved in the drive and 
directory shown in the top box. The File Services 
panel is removed and the new filename appears in the 
upper left corner of the drawing space. A copy of the 
file remains in the drawing space for you to continue 
editing. 

PC! .Pre 1 e Ed t Modes Tools Text 

+r 
18 :\ 

2-15 



Using the Select Icon with Move 
Option 

Let's move the PC to a new location on the drawing space 
using the Select icon and the Move option. 

r--, 
I I 
I I 
L __ _. 

1. Choose the Select icon. 

When the Select icon is selected: 

• Use Button 1 to start and undo the Select box. 
• Use Button 2 to fix the Select box on the drawing 

space. 
• Your pointer becomes a small crosshair in the 

drawing space. 

2. Move the crosshair to the outside right-hand corner of 
the PC (as shown) and press Button 1. 

le Ed t Modes Tools Text (CJ IBM 1987 
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3. Move your input device to expand the size of the 
Select box around the PC and press Button 2 to fix 
the Select box in the drawing space. 

F1 le Edit Modes Tools Text 

ｲｾＭＭＭＭＭＭ Ｐ ＭＭＭＭＭＭＭｾＭＭｩ＠
: 0 : 

: 0 ! 

ｩＭｾＭＭｾ｟ｪ＠
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4. Select the Modes menu by moving the pointer to 

Modes and pressing Button 1. 

Move 
tCopy 

Transparent 
t Opaque 

F1 l l Shape 
t Hollow Shape 

Constrain 
Grid 
Crosshalr 
Buffer F1 l l 
Compos! te V1 deo 
Transparent Co 1 or 
Back ound Color 

Remember: For information on any option in a menu, 
move the pointer to the option and press Fl for help. 

5. Select the Move option by moving the pointer to Move 
and pressing Button 1. 
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t Opaque 

F111 Shape 
t Ho 11 ow Shape 

Constrain 
Grid 
Crosshair 
Buffer F111 
Compos! te V1 deo 
Transparent Co 1 or 
Back round Co 1 or 

(Cl IBM t•B7 

6. Position the pointer inside the Select box and press 
Button 1. 

e Edit Modes Tools Text 
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! 0 ! 

ｌｾ＠ ____________ J 

D= --1 DD '------------------' 

7. Move the PC over to the right side of your drawing 
space (as shown) and press Button 2. 
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8. Press Button 1 to exit the Move option. Notice the 
Select box returns to its original position on the 
drawing space. To remove the Select box from the 
drawing space, ensure the pointer is outside the Select 
box and press Button 1. 

le Edlt Modes Tools Text 
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ｾ＠ Now let's make three copies and position them in the 
drawing space using the Select icon with the Copy option. 

1. Select Modes in the Menu area. 
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2. Select the Copy option. 

3. Position the Select box around the PC and press 
Button 2. 

D= --

Edit Modes Tools Text 

ＬｾＭＭＭＭＭＭＭＭＭＭＭＭＭＭＭＭＭＺ＠

i DD! 
: 0 l 

! 0 l 
I CJ =-=-i I 

ｌｾＭＭｾＭｊ＠

ＱＰＰｾｾｾｾｾｾｾｾｾｾｾｾ＠

4. Position the pointer inside the Select box and press 
Button 1. ｾ＠

Note that as you move your mouse you have a copy of the 
PC drawing. 

5. Move the copy to the upper left-hand side of the 
drawing space and press Button 2. You have another 
copy of the PC. 
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6. Position the other two copies as shown. 

Text 

ＱｾＭＭＭＭＭＭ
Ｐ
ＭＭＭＭＭＭＭｾＭＱ＠

: 0 : 

I o ! 
ｩｾｳ］ｩｩ＠, ________________ ..! 
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7. Press Button 1 to remove the fourth copy of the PC 

and to exit the Copy option. Notice the pointer and the 
Select box return to the drawing space. To remove the 
Select box from the drawing space, ensure the pointer 
is outside the Select box and press Button 1. 
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The Erase Icon 

If you want to erase a mistake, use the Erase icon. 

When the Erase icon is selected: 

• Use Button 1 to start and stop the erase function. 
• Use Button 2 to restore the images that were just 

erased. 
• Your pointer becomes a solid block in the drawing 

space. 

1. Select the Erase icon. 

2. Position the solid block on the last PC you've copied 
and press Button 1. 

Tools Text 

D= --ＱＰＰｾｾｾｾｾｾｾｾｾｾｾｾ＠
3. Erase the PC by moving the pointer back and forth 

over the PC until it is erased. 
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4. Press Button 1 to stop the Erase function. 

Using the Fill Icon 

Let's add some color to the displays, using the Fill icon. 

When the Fill icon is selected: 

• Use Button 1 to start filling an area. 
• Use Button 2 to stop filling an area. 

1. Select a color pattern by moving the pointer to a spe­
cific pattern and pressing Button 1. 

Color 
patterns 

2. Select the Fill icon. 
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3. Move the pointer inside a blank display and press 
Button 1. 

Ed t Modes Tools Text 

-ＱｯｯｌＭＭｾｾｾｾｾｾｾｾｾｾＭｊ＠
4. Fill the other two displays. 

Save this picture and name it PC2. 

Filling an Area Automatically 

Here's a technique you can use to fill boxes or circles 
automatically as you draw them: 

1. Select Modes. 

2. Select Fill Shape. 
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Tools Text 

3. Select the Rectangle icon and make a box. 

4. Notice after you press Button 2 that the box is auto­
matically filled with the active color pattern displayed 
in the Active pattern box. This also works the same 
way when you use the Circle icon. 

D= 
- Active pattern 

bax 

5. Select Modes again and change Fill Shape to Hollow 
Shape. 
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Selecting Undo 

Before we go on, let's undo the filled box you just created. 

1. Select Edit 

2. Select Undo. The filled box is removed from the 
drawing space. 

Using the Line Icon 

Let's connect the three PCs together. To do this, use the 
Line icon. 

When the Line icon is selected: 

• Use Button 1 to start, undo, and end the Line func­
tion. 

• Use Button 2 to fix the line in the drawing space 
or allow the line being drawn to start in a new 
direction. 

Let's try it. 

1. Select the Line icon. 
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2. Move the pointer to the PC on the right side of the 
drawing space, position the pointer as the one shown 
and press Button 1 to start your line. 

Modes Tools Text 

D= --1DDL--------------J 

3. Draw a short line and press Button 2 to start the first 
corner. Extend the line up, position it as shown, and 

Ｎｾ＠ press Button 2 to start the second corner. Extend the 
line to touch the System unit in the center and press 
Button 2. 

D= --

Modes Tools Text 

＾ＭＭＭＭＭｾ＠

Second 
/corner 

First 
corner 

1 OD L----------------J 
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4. Press Button 1 to reposition the line function to start 
the second line. 

5. Position the second line as shown. 

C>= --

F1 le Edit Modes Tools Text 

rn 
ｾ＠

\Do not touch 
the PC 

ｬｯｯＬ｟｟ｾｾｾｾｾｾｾｾｾｾｾｾ＠

The Microscope Icon 

To magnify a part of your drawing for detailed editing, 
use the Microscope icon. 

When the Microscope icon is selected: 

The following icons/areas are active: 
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• 

• 

Color palette area 
Color patterns. 

Use Button 1 to: 

Start and stop Microscope 
Select the Pencil or Erase icons 
Select the six brush shapes. 

Use Button 2 to: 

Scroll the entire picture 
Erase currently drawn pixels (dots) or color pat­
terns. 

1. Select Microscope. 

2. Move your pointer to the line not touching the second 
PC and press Button 1 to magnify it in the drawing 
space. 

Modes Too 1 s Text (C) IBM 1987 
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That section of the drawing is magnified and a small 
window appears in the upper left-hand corner. As you 
move your pointer to change the dots (pixels), the changes 
will appear in this window. 
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3. Move your pointer to the line and and press Button 1 
to connect the line to the PC. 

"i"'Q:: .PIC F le Edit Modes Tools Text I Cc> IBM 1987 

[! [ffiH --
. - -= -· - -... 

ｾｾ＠ - -
ｾｌ＠ - -

- -- -
ｾ＠ --
c:::::::J --
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Right side --
-I>= of PC --

- - -
- --- - -

100 --

4. When the line touches the right side of the PC, press 
Button 1. 

Hint: The default color is black. To change drawing ｾ＠
colors, select a different color from the Color palette area. 

Color palettes 

320 x 200 -4 
mode 

I 
OR 

All other 
modes 

rnrn 
com 
DJW 
ITJ[]] 

1. To scroll the picture, move the pointer inside the small 
window and press Button 2. 

2. Move your pointer to view a new area of your picture (\ 
and press Button 2 again. The new area you scroll to 
is magnified in the drawing space. 
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To exit Microscope: 

Position the pointer inside the small window and press 
Button 1. 

You're out of Microscope. 

Save this picture and name it PC3. 

Using the Text Icon 

Let's add some text to our drawing, using the Text icon. 

T 
ｾ＠ When the Text icon is selected: 

• Use Button 1 to start writing text. Press Button 1 
again to display the Set Attributes panel. 

• Use Button 2 to fix the text in the drawing space. 
• Your pointer now becomes a small crosshair in the 

drawing space. 

1. Select the Text icon. 

2. Position the crosshair as shown and press Button 1. 
Note the crosshair disappears and a blinking cursor 
appears where the first position of your text will be 
placed. 

3. Type PCl. 
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4. Press Button 2. 

5. Continue labeling the other PCs as shown. 

Modes Tools Text 

ＮｾＮ＠

-ｬｯｯＬ｟｟ｾｾｾｾｾｾｾｾｾｾｾＭＭＭＧ＠
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Changing Typeface 

To change the typeface, you can either: 

• Select the Text menu and then the Set Attributes 
option. 

OR 

• While the Text icon is active and displaying a blinking 
cursor, press Button 1 to display the Set Attributes 
menu. The defaults for Set Attributes are Proportional 
and Left Justified. 

1. Select Set Attributes from the Text Menu. 

Font Editor 

ｾ＠ 2. Select Change Font 

File Edit Modes Tools Text- Cc) IBM H87 

Enter Text 

c::ITLI Dill::::] 
ｬＭ］ＭＭＭＭＧＭＺｾｾＭＭＭＭＱ＠

3. Select MODERN.FAC in the Filename box. 

c:::::J 
c:::::J 
c:::::J Drive Directory 

c:::::J 
A < Previous > 

.... .... I>= ｾ＠

ｾ＠ - c - .... .... 

1 DD 
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4. Move the pointer to the YES box and press Button 1. 

Edit Modes Tools Text 

An example of a MODERN.FAC character appears in the 
box. To change the color of the font, move the pointer to 
the Color palette area and select a color. Note the char­
acter in the box reflects the new color you selected. 

Change Font Enter Text 
Set s pac i ng c:::m::::J c::::::EJ&::J 

Change Position MODERN.FAG 

ｧｩｸｳｲ［ｾｄ＠
Right ｊｵｾｴｩｦｩ･､＠ f=l 

Centered 

Bold 

Underline Slze 1 I 
Italic - Outline Double Hor1z I - ｾＭＭｓ｟ｨ｡｟､｟ｯ｟ｷ＠ ｟ｾ＠ ._ __ oo_ub_l_e _ve_r_tl__,I 

ＱＰＰＱＺＺＺＺＺ］］］］］］］］］］］］］］］］］］］］］］］］ｾ＠

5. To change the size of the font you selected, move the 
pointer to Size 1 and press Button 1 to change the 
size to 2. 
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Bold 

Underline 

Italic 
Outline - Shadow 

1DDt::::====================::::::'..J 

6. Try selecting each of the following options and notice 
how as each option is selected, the text character in 
the box reflects the selection. 

Bold 
Underline 
Italic 

Outlining Your Text 

When the Outline option is selected: 

• Use Button 1 to select and display the active outline 
color. 

• Use Button 2 to change and remove the outline panel. 

1. To outline your text, position the pointer over Outline 
and press Button 1. This turns on the Outline option 
and places the active outline color around your text. 

2. To change the outline color, position the pointer over 
Outline and press Button 2 to display the Outline 
Color panel. 

Double Horlz 

Double Vert! 
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3. Move the pointer to the Color palette area, position 
the pointer on a color and press Button 1 to change 
the outline color. 

i e Ed t Modes Tools Text 

Outline Color 

Shadow 

4. Move the pointer inside the drawing space and press 
Button 2 to remove the Outline panel and return to 
the Set Attributes panel. Ｎｾ＠

Hint: A void pressing Button 2 in the Color Palette area, 
because you might accidentally place your pointer over 
the first or second drawing color and change the screen 
mask color. 

Shadowing Text 

When the Shadow option is selected: 

• Use Button 1 to select and display the active shadow 
color. 

• Use Button 2 to display and remove the shadow panel. 

1. To shadow your text, position the pointer over ｾ＠

Shadow and press Button 1. This turns on the 
Shadow option and places the active shadow color 
around your text. 
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To change the shadow color, position the pointer over
Shadow and press Button 2 to display the Shadow
Color panel.

Bold

Under1ine

Itali c

• Outline Double Horiz

Double Vert1

3. Move the pointer to the Color Palette area and select
a color different from the one you selected for out
lining and press Button 1.

PC3 PlClFile Edit Modes Tools Text I (ci ibm im?''

II Change Font I Enter Text
Set Spacing PyeS | | NO | ——

_1__L Change Position

Shadow

Color

Double Horiz

Double Verti

4. Move the pointer inside the Shadow Color panel and
position the pointer over any of the arrows.
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Enter Text 

c:::ITD Dfil:::J 

Each box you select will change the direction and the 
amount of shadow on your text. 

Box Direction 

Top Moves the shadow down. 

Right Moves the shadow to the left. 

Bottom Moves the shadow up. 

Left Moves the shadow to the right. 

5. Move your pointer inside the top box. 
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6. Press Button 1 to change the direction of the shadow 
and increase or decrease the amount of shadow you 
want to use. 

7. When you have the amount of shadow you want to 
use, press Button 2. 

Hint: Avoid pressing Button 2 in the Color palette area, 
because you might accidentally place your pointer over 
the first or second drawing color in the palette and 
change the screen mask color. 

When you have finished changing your text attributes and 
you are satisfied with the results: 

1. Move the pointer to the YES box and press Button 1 
to return to the drawing space for text entry. 

2. A large crosshair appears showing the current position 
of where your text will be displayed on the screen. As 
you move your input device, a second large crosshair 
appears to indicate where the new position of your text 

ｾ＠ will be placed. 

3. Position the second crosshair as shown and press 
Button 1. 
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4. Press Button 2 and type Host. 

5. Press FlO to preview the shadow on your text. If your 
text is positioned correctly, press Button 2. If not, 
press Button 1 and select Change Position from the 
Set Attributes panel. Position the crosshair where you ｾＮ＠

want your text to appear and press Button 1. The text 
is moved to the new position. 

6. Press Button 2 to continue adding text to your picture 
or press Button 2 again to fix the text to the drawing 
space. 

Use the sample picture as a guide to label the other 
two PCs. · · 
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Disk 
server 

server 

Host 

(CJ IBM 1987 
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7. Save the drawing and name it PC4. 

8. Select Clear from the Edit menu to clear the drawing 
space. 

ｾ＠ Using the Graph Option 

Now let's create a graph that will illustrate the projected 
sales of local area network software from 1986 to 1993. 

1. Select Graph from the Tools menu. 

lP,Q'}S- Text cc> IBM 1987 

w c age 
Brush Shape 
Edit Pattern 
Switch Page 
Set Shadow 
x, y Coordinate 
Zoom 

•Fix Palette 
Full Screen 

::L' Jlh; ,':,'-:C\_>, ,, 
L ary 
Di itize 
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When the Graph option is selected: 

• Use Button 1 to select options, change graph 
colors, and display and select colors for graph 
shadows. 

• Use Button 2 to remove the shadow panel and turn 
Shadow on/ off. (\. 

Note: You can enter up to 36 data points. You can 
view 12 data values at a time by usihg the PgUp and 
PgDn keys. Data values can be expressed as either 
positive, negative, whole, or decimal numbers. 

2. Move the pointer to the first field in the Data column 
and press Button 1. 

i e Edit Modes Tools Text 

Data Draw Graph 

CYIT::J [}!L] 
Graph t pe 

3. Type 50 and press Enter on the keyboard. The high- ｾＮ＠
light moves down to the second field in the Data 
column. Continue typing the following numbers into 
the Data column. 

80 
20 
60 
30 

-25 
-35 

4. Type 70 and press Button 1 to accept all of the 
numbers. 

5. To represent a vertical bar graph, highlight (V)BAR 
in the Graph type column. ｾＮ＠
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50 ｾ＠ ｾ＠
80 Graph type 
20 (H)BAR 
60 ii 

30 
(P) 

-25 (L)INE 
-35 

70 Gra h parame 

Let's define the graph's parameters: 

1. Move the pointer to the first field in Graph parameters 
and press Button 1. 

-
- E8 ＱＰＰＧＭＭｾｾＭＧＭｾｾｾｾｾｾｾｾｾ＠

2. Type 50 in the Graph value field and press Enter on 
the keyboard. Graph value indicates the amount of 
space to leave between the columns of the (H)BAR and 
(V)BAR graph. 

3. Type 10 in the Scale interval field and press Enter. 
The Scale interval indicates the increments by which 
your graph will be divided. 

4. Type -50 in the Low mark field and press Enter. The 
Low mark indicates the lowest scale mark you want to 
use. 

ｾ＠ 5. Type 100 in the High mark field. The High mark indi­
cates the highest scale mark you want to use. 

6. Press Button 1 to accept all of the information. 
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To put shadow on your graph do the following: 

Position your pointer as shown and press Button 1. 

11,__ _ ___, ,_ __ -___,4 Low mark 

12 12 High mark 

- f=+j One color flll 
1 DD ,________,_l__.___ __ 

To change the shadow setting: 

1. Use the shadow panel to set the amount of shadow you 
want to use on your graph. Use the Color palette to 
change the shadow color. 

1 le Edit Modes Tools Text 

Shadow 
Color 

II 
rs 

ue 

erval 

2. Place the pointer inside the drawing space and press 
Button 2 to accept the changes. The shadow boxes 
will display the color and the amount of shadow that 
will be on placed on your graph. 

3. Select YES. The graph panel is removed and the 
framed graph is displayed in the upper left-hand corner 
in the drawing space. 
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To move the graph to a different location within the 
drawing space: 

1. Position the pointer inside the Select box that is sur­
rounding the graph and press Button 1. 

Fi le Ed t Modes Tools Text 
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Note: The graph remains in the upper left-hand corner 
as you move the Select box to a new location. 
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D= --ｬｯｯｾｾｾｾｾｾｾｾｾｾｾｾｾ＠
2. Use the pointer to move the select box to the new 

location and press Button 1. The graph is moved from 
the upper left-hand corner to the new location. 

To increase or decrease the size of the graph: 

3. Position the pointer inside the Select box and press ｾＮ＠
Button 2. 

D= --

e Ed t Modes Tools Text 

,..--------------------------------------
! 
! 
! 
! 
! 
!-j.l-J...1.-L-.L....L-<-'-'--_.__,__h-T-'-L..! 

f 

L _______________________________________ _ 

(cl IBM 1987 

ｬｯｯＮ｟｟ｾｾｾｾｾｾｾｾｾｾｾｾ＠
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4. Move the input device to increase or decrease the size 
of the Select box and press Button 2. The graph is 
resized and displayed inside the Select box. 

1 le Edit Modes Tools Text 

D= --ｬｯｯＧＭＭｾｾｾｾｾｾｾｾｾｾｾ＠
5. Position the pointer outside the Select box and press 

Button 1 to fix the graph to the screen. 

1 le Edit Modes Tools Text 

D= --ｬｯｯＧＭＭｾｾｾｾｾｾｾｾｾｾｾ＠
6. Press Button 1 to remove the Select box from screen. 
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Hint: If you want to use the same values but change 
the graph type, select Graph again from the Tools 
menu and select a different Graph type. 

Let's add some text to your graph, using the Text icon. 

1. Select the Text icon. 

2. Select a new font and position the information in the 
drawing space as shown here. 

D= --

Fi le Edit Modes Tools Text 

Projected Sales 
of LAN software 

+ 

ｬｯｯＮ｟｟ｾｾｾｾｾｾｾｾｾｾＭＭＭＭＭＭＧ＠

3. Save the graph and name it GRAPH. 

Exiting Draw 

Here's how to exit Draw: 

1. Select File. 

2. Select Main Menu. 

3. Press the Esc key on your keyboard. 
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A message appears to remind you that you are about to 
exit Picture Maker. 

4. Type Y to return to the Quick Menu/Setup menu. 

You have completed the drawing portion of Storyboard 
Plus. 

Using Story Editor 

In Story Editor you will find several special features to 
help you make attractive presentations. You can select 
any of several picture-to-picture transition methods that 
allow one picture to dissolve into another. 

You can: 

• Vary the speed of the dissolve and the length of time 
each picture is displayed. 

• Display a picture in its entirety or develop it as a 
series of partial pictures that result in a full picture. 

• Easily enter, move or change the selections in your 
story, often without having to type in the filename. 

• Run your story in part or in full while using Story 
Editor, so you can quickly experiment with various 
presentation techniques. 

1. At the Quick Menu/Setup menu for Storyboard, select 
Story Editor. 
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te:XX/XX/XX IBM Storyboard Plus 
Quick Menu/Setup 

Programs Menu 

Picture Maker 
Picture Taker 

ｾＭｴｴ•ｩｩｾ＠
Text Maker 

To start a prcgram use t ｯｲｾ＠ keye to 
blgbllgb1 the prcgram. tben press fJ . 

VersianLOO 
Capyright. IBM Corporatlcn lSllfl, 1967 

Fl=Help F2=Setup F3=Memi Mahrtename 

2. Select Edit Story. 

Date: XX/XX/XX Story Editor 

Main Menu 

*9!!!!f!l"Wtll 
3. Input device 
4.Printer 
5. Printer port 

To select, use t or + and press 4-' . 

VenrumLOO 

Copyrlglit. IBM Corporat!an !985, l967 
CcwrlsJt Marek and Rafa! Krepec Inc lS85, l967 

The Story Table Screen is divided into three areas: 

• Menu area 
• Story Table area 
• Story Monitor area. 
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Menu area 
A 

I File Edit Modes 

Ｂｾ＠ LABEL COMMAND 

-1rnw11n 

2 I /•Story Last L l.ne 

EDIT LINE 

ｾ＠ Memory Used: oz 

Run 

PARAMETERS 

Story 
Monitor 
area 

I (c) IBM 1!187 

TT"" WATT 

ｾｬＡｾｬｩＱＱｭ•＠

0 ( 

1 

> 
Story 
Table 
area 

The Menu area manages your story files. Each key 
word in the Menu area represents different menus you 
can use to manage your story. 

The Story Table is the part of the screen where you 
select the options for each line of your story. In the 
Story Table there is one line which is highlighted . 
This line is referred to as the Story Editing Line. 

I ｾ＠ 1 le Edit Modes Run I Cc> IBM 1987 

NC LABEL COMMAND PARAMETERS TIME ILIA 1 

2 -- ｾ｡ｳｴ＠ L1ne 

ｾｴｯｲ［＠
Editing 
Line 

-----
ｩＮＭＭＭｾ＠ ( 

The Story Monitor area is used when you want to run 
or step through your story while viewing each story 
line at the same time. The pictures of your story will 
be displayed at the bottom right-hand of the screen 
below the Story Table area. 

Note: The pictures that appear on the monitor will 
not be of same quality as those on the full screen. 
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Each line on the Story Editing Line represents one step in 
the story. Let's begin building your story. 

2. Select Get Story from the File menu. 

0 0 

3. The File Services panel appears for you to select a story. 

4. Select TUTORIAL.SH-. 

Now you're ready to describe how you want your story to 
appear by entering the information at the Story Editing Line. 

Because you are building on an existing story, lines 1, 2, 11, 
12, and 13 have already been completed. 

Input your information on lines 3 through 10 on the Story 
Editing Line. When you have completed describing how you f"., 
want a particular picture in your story to be displayed, move 
your story line up to begin describing how you want the next 
picture in your story to be displayed. 

To select any of the following options: 

• NO 

• LABEL 

• COMMAND 

• PARAMETERS 

• TIME 

• WAIT . 

Position your pointer on the highlighted column you want 
to select and press Button 1. 
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i le Edit Modes Run (c) ISM 1987 

COMMAND PARAMETERS TIME WAIT 

2 

Let's move line 3 to the Story Editing Line to begin 
entering information for our story. 

6. Position the tip of the pointer slightly below the Story 
Editing Line as shown to scroll down. 

Note: The pointer changes to a vertical position 
pointing down. To scroll up place the pointer slightly 
above the Story Editing line. 

TUTORIAL. slf'I F 1 l e Edit Modes Run I (cl IBM 1987 

NO LABEL COMMAND PARAMETERS TIME WAIT 

/ .. ). 
-

2 /•DISPLAY* OP.2 .PIC MED 2 

- ｾ＠-

7. Press Button 1 two times to scroll to the third line of 
your story. 

8. Select COMMAND from the Story Editing Line. 

Hint: The menu for the COMMAND column is dis­
played. The COMMAND menu has two menus. Posi­
tion your pointer inside the menu and use Button 2 to 
scroll between the two menus. 
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e Ed t Modes Run 

PARAMETERS 
OPEN! 
OPEN2 

9. Select /CLEAR. This command is used to clear all or 
part of a picture displayed in a story. 

10. Select PARAMETERS from the Story Editing Line. 

ｲＧｦｩｬｔｏｒｉａｌＮｓｾ＠ T11 e Edit Modes Run l Cc) IBM 1987 

"1Q LABEL COMMAND PARAMETERS TIME luarT 

1 /DISPLAY* OPENl .PIC FAST 1 
2 /DISPLAY* OPEN2 .PI.C MED ; 

ＧＧＮＷｾｗｩｾｾｾｾ＼ｩ€ＱＷｾｾ＠ ｾｗＺＺＺＺＺ＠ ＧＮＧｾＧＮ•［Ｂ＠ ' 

4 /* Get 'lor 
0 0 

5 /* 0 ( 

ｾ＠

11. Select Get Color to select a color to clear all or part 
of the screen. 

12. Select white (number 4) from the Get Color panel. 

13. Select TIME from the Story Editing Line to enter the 
amount of transition time needed to go from one 
screen to the next. 

14. Select FAST. 
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This completes line three of your story. Go to line four 
and insert the following information: 

1. Select COMMAND from the Story Editing Line. 

2. Select /DISPLAY and press Button 1. 

3. Select PARAMETERS from the Story Editing Line. 

4. When the File Services panel appears, select PC2.PIC. 

5. Select FADE from the METHOD column. 

Note: When the FADE method is selected, 
DIR and LINE are not active. 

Ensure FULL is in the AREA column. 

This completes line four of your story. Go to line five and 
insert the following information: 

1. Select COMMAND from the Story Editing Line. 

2. Select /DISPLAY and press Button 1. 

3. Select PARAMETERS from the Story Editing Line. 

4. Select Get Existing Name. 

5. Select PC3.PIC from the File Services panel. 

6. Select REPLACE from the METHOD column. 

7. Select LEFT from the DIR column. 

Ensure FULL is in the AREA column. 

This completes line five of your story. Go to line six and 
insert the following information: 

1. Select /DISPLAY from the COMMAND column. 

2. Select Get Existing Name from the PARAMETERS 
column. 
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3. Select PC4.PIC 

4. Select REPLACE from the METHOD column. 

5. Select RIGHT from the DIR column. 

Ensure FULL is in the AREA column. 

This completes line six of your story. Go to line seven and 
insert the following information: 

1. Select /CLEAR from the COMMAND column. 

2. Select Get Color from the PARAMETERS column. 

3. Select the color white (number 4). 

4. Select REPLACE from the METHOD column. 

5. Select LEFT from the DIR column. 

Ensure FULL is in the AREA column. 

This completes line seven of your story. Go to line eight 
and insert the following information: 

1. Select /DISPLAY from the COMMAND column. 

2. Select Get Existing Name from the PARAMETERS 
column. 

3. Select GRAPH.PIC 

4. Select FADE from the METHOD column. 

5. Select PART from the AREA column. 

METHOD DIR LINE AREA 
FADE NONE NONE PART 

ｆｯｾｯＺ｡＠ ｐｉｾｔｏｕｏｾｅＱＱＵ＠ ｔｾＳ＠ ｴＡｩｦ］ｴＷ＿ｩｾｾ［ｾ＠

Current Story Drlve\Path 
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Selecting PART allows you to have certain pictures 
"develop" on your display screen as a series of partial pic­
tures. As with full pictures, each line in the table repres­
ents one step in the resulting show, so each partial 
picture must be on a separate line in the story. 

ｾＧ＠ 6. Select TO SCREEN. 

METHOD DIR LINE AREA 
FADE NONE NONE PART 

FROM PICTURE TO SCREEN 
0-20 100-115 
Set on Monitor 
Set on Full Screen 
In ut Coordinates 

7. Select Set on Monitor. This allows you to use a 
Select box to define the coordinates or location of the 
partial picture and the location where you want the 
partial picture to be displayed . 

. ｾ＠ 8. Move the pointer into the monitor area but outside the 
Select box. 

9. Press Button 1. The pointer becomes a crosshair. 

10. Position the crosshair as shown and press Button 1. 

ED IT LINE 

c::ic::i Memory Used : 2 Z 

Projected Sales 
100 of LAN softwar!f---

1 

11. Move your input device to enlarge the select box and 
surround the title of your graph. 
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12. Press Button 2 to fix the Select box to the screen. 

Leave the selected area in the same location: 

13. Move the pointer inside the Select box and press 
Button 1. The previous picture in the PARAMETERS 
column will appear as background with the area (\. 
framed by the Select box over it. Move the pointer 
inside the Select box and press Button 2. The coordi-
nates in the From Picture To Screen column of the 
story table change to reflect the new location. 

To move the selected area to a new location: 

14. Move the pointer inside the Select box and press 
Button 1. Move the selected area to a new location 
and press Button 2 to set the Select box in the new 
location. 

This completes line eight of your story. Go to line nine 
and insert the following information: 

1. Select /DISPLAY from the COMMAND column. 

2. Select Get Existing Name from the PARAMETERS 
column. 

3. Select GRAPH.PIC. 

4. Select FADE from the METHOD column. 

5. Select PART from the AREA column. 

6. Select TO SCREEN. 

7. Select Set on Monitor. 

8. Move the pointer into the monitor area but outside the 
Select box and press Button 1. The pointer becomes a 
crosshair. 

9. Position the crosshair as shown and press Button 1. 
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EDIT LINE 

cc Memory Used: 22: 

Projected Sales 
100 of _LAN ｳｯｦｴｷ｡ｲｾ＠

10. Move your input device to enlarge the Select box and 
surround the graph. 

11. Press Button 2 to fix the Select box to the screen. 

12. Move the pointer inside the Select box and press 
Button 1. The previous picture in the PARAMETERS 
will appear as background with the area framed by the 
Select box over it. 

Ｑ ｾ＠ 13. Move the pointer inside the Select box and press 
Button 1 again. 

14. Align the text framed with the select box with the 
graph and press Button 2. 

If your text is too close to your graph and you're having 
difficulty surrounding the area with the Select box, you 
can return to Picture Maker from Story Editor to move 
the text away from the graph using the Move option. 

1. Select Modes from the Story Editor menu area. 

2. Select Picture Maker. This puts you in Picture Maker 
where you can use the Move option with the Select 
icon to increase the space between your graph and 
text. 

3. Select File from the Picture Maker menu area. 
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4. Use the Get Picture to retrieve the GRAPH.PIC file 
and correct your problem. 

5. Use the Save Picture to save the GRAPH.PIC file 
using the same directory path. 

6. Select Story Editor from the File menu in Picture (\ 
Maker to return to Story Editor. Retrieve the GRAPH 
file, again. 

Note: This option is only available from Story Editor 
program. 

Now that you have defined how you want to present your 
story, let's have a trial run. 

1. Press the Home key to return to the first line of the 
story. 

2. Select Modes from the Menu area. 

3. Select Full Screen. 

4. Select Run from the Menu area. 

5. Select Run Story. 

The story will be shown on the full screen. When the 
program reaches the last line of the story and there is no 
command (GOTO) that starts the story over again, Story 
Editor will exit the Run Story mode and return to the 
Story Table. 

Before exiting the Story Editor program, be sure to save 
your story. 

To save your story: 

1. Select Save Story from the File menu. 

2. Save the story and name it TUTOR. 
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This completes the Story Editor part of the tutorial. Exit 
Story Editor and return to the IBM Storyboard Plus 
Quick Menu/Setup screen. 

Using Story Teller 

Story Teller is the program you use to run stories previ­
ously created with Story Editor. 

Story Teller begins with the first line in your show and 
continues in the same way as when you select Run Story 
in Story Editor. 

1. At the Quick Menu/Setup Menu for Storyboard, select 
Story Teller. 

ate:XX/XX,IXX IBM Storyboard Plus 
Quick Menu/Setup 

Programs Menu 

Picture Maker 
Picture Taker 

·=i:%i!i1t\\JiL .. 
Text Maker 

'lb start a program use tort keys to 
highlight the program, then press +-' , 

Version LOO 
Copyright. IBM Corporatian l9B6, 1967 

ｆｬｾｈ･ｬｰ＠ re-setup F3=MemJ. Mainhmanre Esc=Exit 

A screen appears for you to type the name of the story 
you want to show. 

2. Type TUTOR and press Enter. 

3. The Story Teller screen appears requesting you to 
press any key. 
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Note: After 30 seconds, your story will run whether 
you press any key or not. 

This completes the tutorial section of Storyboard Plus. 
For information on any of the menus, options, icons, or 
commands, see the reference section of this book. 
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Picture Maker 

Picture Maker is the program you use to create pictures 
or edit existing pictures. When done, you can store your 
picture as a new picture file or update an existing picture (\ 
file. Later, using Story Editor, you can assemble these pic-
tures into a story. 

Starting Picture Maker 

Type PM to start the program from the DOS prompt, or 
type SBMENU to start Picture Maker from the IBM 
Storyboard Plus Quick Menu/Setup program. At the IBM 
Storyboard Plus Quick Menu/Setup menu, you can change 
the Setup options of your product and then select Picture 
Maker from the menu. 

Read the following section that applies to your input (\. 
device. 

Using the Mouse with PM 

If you are using a mouse, the pointer moves around the 
screen as you move your mouse, relative to the position of 
the device. If the pointer doesn't move, you may have 
selected the wrong input device. Press Esc to return to 
the Picture Maker Main Menu. Then select Input device 
to change the input device for the current drawing 
session. To change the input device permanently, go to 
the Quick Menu/Setup Menu. Select F2 =Setup and 
change the input device to the one you have installed on 
your system. 
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The mouse has two buttons you can press to select tools 
from the drawing screen and perform functions. 

Two-button mouse 

If you have a two-button mouse, the button closest to your 
ｾ＠ thumb is Button 1 and the button closest to your little 

finger is Button 2. 

Three-button mouse 

If you have a three-button mouse, the button closest to 
your thumb is Button 1 and the center button is Button 2. 
(Button 3 is inactive.) 

The button Status Boxes display which button is currently 
active. 

Status 
boxes 

Button 
1&2 
inactive 

DD 

Button Button 
1 2 

active active 
•D D • 

Right-handed operation 

If your mouse is set for right-handed operation, Button 1 
is active when the left button status box is highlighted. 
When the right button status box is highlighted, Button 2 
is active. 

Left-handed operation 

If your mouse is set for left-handed operation, Button 1 is 
active when the right button status box is highlighted. 
When the left button status box is highlighted, Button 2 is 
active. 
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Using the Keyboard with PM 

When the keyboard is selected as the input device, the 
pointer appears in the middle of the drawing space in the 
Picture Maker drawing screen. 

1 e Edit Modes Tools Text 

+ T 
r-, 
!_J .I!.. 
l i Pointer 

'm' / G) ... D 
ｾ＠ 0 
C=:::J 
C=:::J 
C=:::J 
C=:::J 

I)= --1 DD 

The keyboard has two keys that you can use to select (\ 
menu options. Use the numeric keypad plus (+)key as 
Button 1 and the minus(-) key as Button 2. 

To help you select icons and menu options and also 
change current drawing colors, patterns, and line widths, 
certain keys are assigned specific areas on the screen. 

The screen areas and their assigned keys are: 

Icon area F3 

Color palette F4 

Line style area F5 

Color pattern area F6 

Active pattern box F9 

3-6 



File Menu 1 

Edit Menu 2 

Modes Menu 3 

Tools Menu 4 

Text Menu 5 

Pressing one of these keys will move the pointer from its 
current position on the drawing space to a specific area 
on the screen. You can make your menu selection by 
using the j and ! keys to highlight your choice and 
pressing the + key (Button 1) to select the option. The 
pointer returns to the drawing space ready to use the new 
selection. 

For example, suppose you were using the Pencil icon and 
you wanted to draw a circle. 

1. First, press the F3 key to move the pointer into the 
Icon area. 

ｾ＠ The currently selected icon is highlighted. 

2. Use the cursor movement keys to move the pointer to 
the icon you want to select. 

In this example, press the ! key three times to move to the 
Circle icon. 

3. Now press the + key (Button 1) to select the Circle 
icon. Notice that your pointer returns to its original 
location on the drawing space. 

For pointer movment within the drawing area: 

-+ -
The direction of arrow 

i ! The direction of arrow 
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Home Diagonally towards the 
upper left 

End Diagonally towards the 
lower left 

Pg Up Diagonally towards the 
upper right 

PgDn Diagonally towards the 
lower right 

Shift - Arrow One pixel in direction 
Key of arrow 

Shift - Diagonal One pixel in direction 
Key of diagonal 

For pointer movement within a panel: 

Tab Moves one right one 
column 

Shift-Tab Moves left one column 

Pg Up Displays previous panel 
selections 

PgDn Displays additional 
panel selections 

y Confirms selection 

N Exits panel without 
executing selection 

Getting Help 

To get specific information on any of the key words (File, 
Edit, Modes, Tools, Text) in the Menu area: 

1. Position the pointer over a key word in the Menu area 
and press Fl on the keyboard. 

(', 

2. Use the PgUp and PgDn keys to scroll through the r-'\ 
help panels. 

3. To exit and remove the help panel, press the Esc key. 
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To get help on any options within a menu: 

1. Select a menu. 

2. Position the pointer over an option within the menu 
and press Fl. 

3. Use the PgUp and PgDn keys to scroll through the 
help panels. 

4. To exit and remove the help panel, press the Esc key. 

To get specific information on any item in the Icon area 
or Color pattern area, move the pointer to the item and 
press Fl for help information. 

File Services Panel 

When either Get, Save, or Remove a file is selected, the 
ｾ｜＠ File Services panel is opened. 

e Edit Modes Tools Text 

GET Picture file 

OELJL:]L) 

Drive Directory Fl lename 

A < Previous .. .. .. D= - c 
iSYST,.PIC 

t--

• -ＱＰＰｾｾｾｾｾｾｾｾｾｾｾｾｾ＠
e 

ervices 

The top line of the panel shows you the current drive and 
directory accessed. 
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The middle of the panel gives you the option of viewing a 
specific type of files or all files. The specific type of files 
will be determined by the function you choose. It also has 
an area for you to confirm that you want to select a file 
by responding with a YES or NO. 

The bottom of the panel lets you select the drive, direc­
tory, and file that you want. If you have saved any files 
on the disk, a list of those files will appear in the 
Filename column in the lower right corner of the screen. 
If no files are on this disk, the entry None is displayed. If 
you are saving a file, the entry New is displayed as an 
option. 

Using the File Services Panel 

To select a file from the File Services panel: 

1. Select either the highlighted file type or all files. 

2. If you wish to see all file types, move the pointer to 
All Files and press Button 1. 

3. Place the pointer on the drive letter for the correct 
drive and press Button 1. If the drive displayed at the 
top of the panel is correct, this step is not required. 

If you have more drives than are displayed, move the 
pointer to the t box on the right of the drive column and 
press Button 1 to see the other installed drives. Continue 
pressing Button 1 until you find the correct drive. You 
can see previous drives by moving the pointer to the j box 
and pressing Button 1. 

4. Place the pointer on the correct directory and press 
Button 1. If the directory displayed at the top of the ｾ＠

panel is correct, this step is not required. 

If you have more directories than are displayed, move the 
pointer to the t box on the right of the directory column 

3-10 



and press Button 1 to see the other directories. Continue 
pressing Button 1 until you find the correct directory. 
You can see previous directories by moving the pointer to 
the j box and pressing Button 1. 

5. Place the pointer on the file you want to get and press 
ｾ＠ Button 1. 

That file is now highlighted. If you have more files than 
are displayed, move the pointer to the ! box on the right 
of the filename column and press Button 1 to see the 
other files. Continue pressing Button 1 until you find the 
correct file. You can see previous files by moving the 
pointer to the j box and pressing Button 1. 

Storyboard Plus arranges the files in alphabetical order 
by file extension and then by filename so you can easily 
locate your file. 

6. When you have highlighted the file you want to get, 
move the pointer to YES and press Button 1. 

The File Services panel closes. 

7. If you decide you don't want to get a file after all, 
place the pointer on NO and press Button 1. 

Picture Maker Menus 
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Opening a Menu 

To open a menu, move the pointer to the menu you want 
and press Button 1. To select an option, move the pointer 
to the item you want and press Button 1 again. This 
selects the option and closes the menu. 

In the Modes and Tools menus, you can make more than 
one selection at a time without having to reopen the 
menu. After opening the menu, highlight your choice and 
press Button 2 (instead of Button 1) to select the option. 
An arrow beside an option indicates that the option is cur­
rently active. (Active means the mode is currently avail­
able for operation at any given time.) Continue using 
Button 2 to select the options. When you are finished 
making your selections, move the pointer outside the 
menu and press Button 1 to close the menu. 

Exiting a Menu 

To return to the drawing area without selecting any 

(\ 

options, position the pointer outside the Menu area and ｾ＠

press Button 1. 

Note: If you select an option in the Modes or Tools menu 
and the arrow doesn't appear, the option can only be 
selected using Button 1. 

File Menu (PM) 
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Get Picture 

Use Get Picture to retrieve picture files previously saved 
on a disk. After you get the picture, you can edit or print 
it. 

Ｌｾ＠ To get a file: 

1. Select Get Picture from the File menu. 

The File Services panel will appear. 

2. Select the file you want to get. (If you need help using 
the File Services panel, see "File Services Panel" in 
this section.) 

Notice that the name of the picture appears in the upper 
left-hand corner of the drawing screen. Whenever you get 
an existing picture or save a picture, the picture name 
appears here. 

If you select a file that has more than one image saved 
under the filename, the Get Capture File Panel will 
display. 

Get Capture File Panel 

If you select a file that has more than one image file saved 
by Picture Taker, under the filename (usually with a .CAP 
or .LIB extension), the Get Capture File panel will be 
displayed. You can then select a specific image in the file. 

There are three options on the Get Capture File panel: 

• Get Picture 
• View Picture 
• Exit. 

Note: Picture Maker can only get or view graphic 
images. Use Text Maker to get or view text images. 
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Using Get Picture 

Select Get Picture to get a graphic image. 

To get a graphic image: 

1. Place the pointer on the graphic image you want to ｾ＠
get and press Button 1. 

The image is now highlighted. If you have more images 
than are displayed, move the pointer to the t box on the 
right of the image column and press Button 1 to see the 
other images. Continue pressing Button 1 until you find 
the correct image. You can see previous images by moving 
the pointer to the f box and pressing Button 1. 

2. When you have highlighted the image you want to get, 
move the pointer to Get Picture and press Button 1. 

The Get Capture File panel closes and the image is dis­
played in the drawing space. 

Using View Picture 

Select View Picture to preview graphic images. 

To view a graphic image: 

1. Position the pointer on the graphic image you want to 
view and press Button 1. 

2. Move the pointer to View Picture and press 
Button 1. 

To view all of the graphic images in a file one at a time: 

3. After the first image is displayed, press Button 1 to 
display the second. Continue this procedure until each 
image in the captured file has been displayed. ｾ＠

4. Press Button 2 to return to the Get Capture File 
panel. 
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Exiting the Get Capture File Panel 

To exit the Get Capture File Panel without making a 
selection and return to the Get Picture File Services 
panel, move the pointer to Exit and press Button 1. 

Save Picture 

After you create a drawing, you can save it on disk by 
selecting Save Picture. 

Note: Unless you save the picture, you will lose it when 
you clear the screen or turn off the power. When you 
make changes to a picture that has been previously saved, 
you must save the picture again in order to keep those 
changes. 

To save a picture: 

1. Select Save Picture on the File menu. 

The File Services panel will appear. 

2. Select an existing picture name if you want to replace 
a previously saved picture or New if you want to 
create a new picture. (If you need help using the File 
Services panel, see "File Services Panel" in this 
section.) 

3. If you selected New, the word New disappears and the 
line becomes highlighted with a blinking cursor. The 
blinking cursor lets you know that you can now type 
your filename. The filename can use up to 8 alphanu­
meric characters. Use the keyboard to type in the 
name you want to give your picture and press Enter. 

Notes: 

a. If .PIC files is highlighted, the file extension of all 
files displayed in the Filename column will be .PIC. 
While .PIC files is highlighted, any pictures saved 
will use .PIC as the file extension. 
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b. If All files is highlighted, all of the files in the 
selected directory will be displayed. You can save a 
picture using any three characters as the file exten­
sion. To change the extension, type the filename and 
then press the"." key. The cursor will move into the 
extension field for you to enter a new file extension. 

4. Move the pointer to YES and press Button 1 . 

The picture is saved and the name appears at the upper 
left-hand corner of the screen. Although the picture is 
saved on disk, a copy remains in memory for you to con­
tinue editing. 

Save BSave 

Select the Save BSave option to save drawings in the 
standard BSave file format. The Save BSave option is 
valid only if you are using the 320 X 200 - 4 color resol­
ution mode. 

To save a BSave file: 

1. Select Save BSave on the File menu. 

See "Save Picture" for steps to save the picture. 

Saving a Portion of a Picture 

If you have a portion of the screen framed using the 
Select icon and choose the Save option, only the area 
framed will be saved. 

1. Choose the Select icon and frame a small area of a 
picture. 

2. Position your pointer on the File menu and select the 
Save Picture or BSave option. 

3. The File Services panel is displayed. Enter a filename 
and select YES. 
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A message appears informing you that only the area 
framed will be saved. 

4. Move the pointer to YES and press Button 1 to save 
the selected area. 

Remove Picture 

Use Remove Picture to erase files from your disk. You 
may want to delete old pictures or make room on your 
disk for new pictures. 

To remove a picture: 

1. Select Remove Picture on the File menu. 

The File Services panel will appear. 

2. Select the picture you want to remove. (If you need 
help using the File Services panel, see "File Services 
Panel" in this section.) 

f""".... The picture will be removed from your disk. 

Show Page 

Show Page removes the Icon, Menu, and Pattern areas to 
display the entire picture. There are no icons or menu 
options available when the Show Page option is selected. 

To return to the Icon, Menu, and Color pattern areas, 
press Button 1 or 2. 

Print 

Use Print to print the picture that is currently displayed 
in the drawing space. You have two choices in selecting 
how your picture will be printed. They are: 

• Normal - used to print the picture vertically on the 
paper. 
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• Turn Page - used to rotate your picture 90 degrees and 
print the picture horizontally on the paper. 

• Use Shades - used to represent colors with gray shades 
when using a black and white printer. 

• Use Patterns - used to represent colors with patterns when 
using a black and white printer. :r-'\ 

When you are ready to print a picture: 

1. Select Print from the File menu. 

A panel appears displaying the print options. 

2. Select the direction you want to print your picture and 
select YES. 

3. To exit from the Print option panel without printing, select 
NO. 

4. To cancel a print job once you have started it, press the 
Esc key. 

5. When printing is finished, select NO to return to the 
drawing area. 

Main Menu 

To return to the Picture Maker Main Menu, select Main Menu 
from the File menu. 

To return to the Picture Maker drawing screen, select Draw 
from the Picture Maker Main Menu. 

Exiting File Menu 

To return to the drawing screen without selecting any option, 
position the pointer outside the File menu and press Button 1 
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Edit Menu (PM) 

Undo 

Modes 

Invert 
Flip Ver. 
Flip Hor. 
Rotate 
Scale 
Cut 
Paste 
Alter Colo 
Clear 

Use Undo from the Edit menu to undo everything done 
since you last selected an icon. 

Note: During the active Fill session, the Undo option 
removes all fills since the last pattern was selected. 

For instance, suppose you select the Brush icon and paint 
several strokes, and then decide you don't like the pattern 
you have chosen. Just select the Undo option in the Edit 
menu and your brush strokes will be removed. You return 
to the drawing as it was before you began using the brush. 

Invert 

Use Invert from the Edit menu to reverse the colors on 
your screen. If you select Invert again, the original colors 
will return to the drawing space. 

To invert only a portion of the picture: 

1. Choose the Select icon and frame the portion of the 
picture you want inverted. 

2. Select Invert. 

ｾ＠ The framed portion of the picture is inverted and anything 
outside the framed area remains the same. 
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Flip Vertical 

Use Flip Vertical from the Edit menu to flip the entire 
picture from top to bottom. 

To flip just a portion of the picture vertically: 

1. Choose the Select icon. 

2. Frame the portion of the picture you want flipped and 
select Flip Ver. from the Edit menu. 

The framed portion of the picture is flipped vertically and 
anything outside the framed area remains in its original 
position. 

Flip Horizontal 

Use Flip Horizontal from the Edit menu to flip the entire 
picture left tq right. 

To flip a portion of the picture horizontally: 

1. Choose the Select icon. 

2. Frame the portion of the picture you want flipped and 
select Flip Hor. from the Edit menu. 

The framed portion of the picture is flipped horizontally 
and anything outside the framed area remains in its ori­
ginal position. 

Rotate 

Select Rotate to rotate part of your picture in five degree 
increments. The Rotate option uses the Move and Copy 
options. If you rotate an image and move the image to 
another location, make sure the Move option in the 
Modes menu is active. Otherwise, a copy of the picture is 
rotated and the original remains in its initial location. 
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To rotate a portion of the picture: 

1. Choose the Select icon and frame the portion of your 
picture you want to rotate. 

2. Select Rotate from the Edit menu. 

As you move your input device, the area framed by the 
Select box is rotated. A number showing the degree of 
rotation will appear in the Line style area of the 
screen. 

Note: When rotating in Full Screen mode, the number 
showing the degree of rotation will not be displayed on 
the screen. 

3. Press Button 2 to fix the rotated picture to the screen. 

To move or copy the rotated area to a new location: 

1. Choose the Select icon to frame the portion of your 
picture you want to rotate. 

2. Select Rotate from the Edit menu. 

3. Rotate your picture. 

4. Press Button 1, move the framed area to the desired 
location on the screen, and press Button 2. 

5. Press Button 1 to end the move or copy action. 

Notes: 

1. Depending on the resolution mode and the amount the 
image is rotated, your picture may be displayed with 
some distortion. 

2. If the Select icon starts flashing and you cannot rotate 
the area that you surrounded by the Select box, try 
reducing the area you framed. 
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Scale 

Select Scale to increase or decrease the size of your 
picture. The Scale option uses the Move and Copy modes. 
If you scale an image and move the image to another 
location, make sure the Move option in the Modes menu 
is active. Otherwise, a copy of the picture is scaled and 
the original remains in its initial location. If you scale an 
image and want to copy the image, make sure Copy is 
active. 

To scale a portion of the screen: 

1. Choose the Select icon to frame the portion of your 
picture you want to scale. 

2. Select Scale from the Edit menu. 

As you move your input device, the area framed by the 
Select box is scaled. Two numbers appear in the Line 
Style area of the screen. The top number shows the per­
centage of horizontal scaling and the bottom number 
shows the percentage of vertical scaling. ｾ＠

Note: When scaling in Full Screen mode, the numbers 
showing the percentage of horizontal and vertical scaling 
will not be displayed on the screen. 

3. Press Button 2 to set the scaled picture in the drawing 
space. 

To move or copy the scaled area to a new location: 

1. Choose the Select icon to frame the portion of your 
picture you want to scale. 

2. Select Scale from the Edit menu. 

3. Scale your picture. 

4. Press Button 1, move the framed area to the desired 
location on the screen, and press Button 2. 
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5. Press Button 1 to end the move or copy action. 

Notes: 

1. Depending on the resolution mode and the amount the 
image is scaled, your picture may be displayed with 
some distortion. 

2. If the Select icon starts flashing and you cannot scale 
the area that you surrounded by the Select box, try 
reducing the area you framed. 

Cut 

Select this option to cut an area of your picture and store 
it in a "hidden" buffer to use later in the current drawing 
session with the Paste or Buffer Fill options. 

To cut a portion of your picture: 

1. Choose the Select icon to frame the portion of the 
ｾ＠ picture you want to cut. 

2. Select Cut from the Edit menu. 

The framed portion of the picture is stored in a 
"hidden" buffer and is available for later use with 
Paste or Buffer Fill. 

Notes: 

1. If the Select box changes to a dash dot style (normally 
the box is made of dashes), it means the area you have 
surrounded is too large to cut. If you want to perform 
this option, reduce the size of the area you surrounded 
with the Select box until the box changes back to 
dashes. The area you can surround before the Select box 
changes to the dash dot style depends upon the resol­
ution mode you selected in Setup. 

2. If you hear a beep after you select Cut, the Cut process 
was not completed successfully. 
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Paste 

Select this option to paste the last image stored in the 
hidden buffer by the Cut option. The image is placed in 
the upper left-hand corner of the screen. This image can 
now be moved or copied to other areas of the screen. 

Using the Cut and Paste Options 

To cut a portion of a picture and paste it in another file: 

1. Use the Select icon to frame the area of the current 
picture you want to cut. 

2. Select Cut from the Edit menu. The framed area is cut 
and placed in a hidden buffer. 

3. Select the File menu. 

4. Select Get Picture. 

5. Retrieve the picture you want to use. 

6. Select Paste from the Edit menu. 

The picture in the hidden buffer appears in the upper left 
corner of the screen. This image can now be moved or 
copied to other areas of the screen, by using the Move or 
Copy options in the Modes menu. 

Alter Color 

Use Alter Color to change a color in the drawing space to 
the active drawing color. 

To use Alter Color: 

1. Select Alter Color from the Edit menu. 

2. Move the pointer into the drawing space and a box 
pointer will be displayed. As the pointer tip touches 
the colors in the drawing space, it displays the pixel 
colors in the connected box. 
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3. Identify the color you want to change and press 
Button 1. Every pixel that color in the drawing space 
(also referred to as drawing area) will be changed to 
the active drawing color. 

4. Press Button 2 to exit Alter Color. 

To alter the color of just a portion of the screen: 

1. Choose the Select icon and frame the portion you 
want to alter. 

2. Select Alter Color, move the pointer inside of the 
framed area to the color you want to change, and press 
Button 1. 

3. Press Button 2 to exit Alter Color. 

Clear 

To clear the Picture Maker screen: 

1. Select Clear from the Edit menu. 

A window appears asking you to confirm that you 
really want to clear the drawing space. 

2. Select YES. The drawing space is cleared. 

3. If you decide not to clear, select NO. 

To clear part of a picture: 

4. Use the Select icon to frame the area you want to 
clear. 

5. Now select Clear and the area framed is removed. 
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Notes: 

1. No panel appears when you use Clear to remove a 
portion of a picture. 

2. If you clear the screen before saving a new drawing or 
an old one you've just edited, you'll lose the drawing or (\ 
the changes. 

To use Clear and update the drawing space to a new back­
ground color, do the following: 

1. Select Background Color from the Modes menu. The 
Background Color panel appears, displaying the active 
background color. 

2. Select a color from the Color palette area. The color 
selected is displayed in the background color box as 
the new background color. 

3. Press Button 2 to remove the Background Color 
panel. 

4. Select Clear from the Edit menu. 

5. Select YES. 

The drawing space is cleared and the active background 
color replaces the previous background color. 

To use Clear to replace a portion of the screen to a new 
background color: 

1. Select Background Color from the Modes menu. 

2. Select a color from the Color palette area. The color 
selected is displayed in the background color box as 
the new background color. 

3. Press Button 2 to remove the Background Color (\ 
panel. 

4. Choose the Select icon and frame the area that you 
want to change the background color. 
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5. Select Clear from the Edit menu. 

The framed area is cleared and the active background 
color replaces the previous background color. 

ｾ＠ Modes Menu (PM) 

ｾＭ ON 

Blank - OFF 

(c) IBM 1987 

When you start Picture Maker, the Copy, Opaque, and 
Hollow Shape modes are active. 

Move 

You may have a portion of a picture that you would like 
to move to a different location within the picture. 

1. Select Move from the Modes menu. 

2. Use the Select icon to frame the part of the drawing 
that you want to move. 

3. Then position the pointer anywhere inside the section 
that you just framed. 

4. Press Button 1 to move the framed section to a new 
location in the drawing space. Note the pointer and 
the frame disappear, and the area framed can be moved 
anywhere in the drawing space. 

5. When you are satisfied with the new location, press 
Button 2. 

6. Press Button 1 to end the Move option. 
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7. Move outside the framed section and press Button 1 to 
remove the Select box from the screen. 

Note: If the Select icon starts flashing, it means the area 
you have surrounded is too large to move. If you want to 
use the Move option, reduce the size of the area you have 
surrounded until the Select icon stops flashing. The area r-", 
you can surround before the icon starts flashing varies, 
depending on the resolution mode you selected in 
F2=Setup. 

Copy 

Copy allows you to make as many copies as the drawing 
space can hold. Copy works similar to Move, but with 
Copy you still have your original design in its original 
position when you're finished. Follow these steps to copy: 

1. Select Copy from the Modes menu. 

2. Frame the design or object you want to copy using the 
Select icon. r-"'\ 

3. Position the pointer inside the Select box. 

4. Press Button 1, move the copied section to the new 
location, and press Button 2. 

5. Press Button 1 to end the Copy option. 

6. Press Button 1 to remove the Select box from the 
screen. 

Now you have two identical objects or designs. 

Note: If the Select icon starts flashing, it means the area 
you have surrounded is too large to copy. If you want to 
use the Copy option, reduce the size of the area you have 
surrounded until the Select icon stops flashing. The area ｾ＠
you can surround before the icon starts flashing varies, 
depending on the resolution mode you selected in 
F2=Setup. 
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Transparent 

If you select Transparent from the Modes menu, the active 
transparent color that appears within a framed area is 
not moved or copied. For instance, if black is the active 
transparent color, here's how to move just the text written 
in white on a black background: 

1. Select the Modes menu. 

2. Select Transparent Color and select the color black 
from the Color palette area. 

3. Move the pointer into the drawing space and press 
Button 2 to remove the Transparent Color panel. 

4. Select Transparent in the Modes menu. 

5. Use the Select icon to frame the text. 

6. Position the pointer inside the framed area and press 
ｾ＠ Button 1. Move the text to the new location and press 

Button 2. Only the white text inside the framed area 
is moved to the new location. 

The opposite option to Transparent is Opaque. 

Opaque 

If you choose Opaque, all colors that appears within a 
section being moved or copied are moved or copied along 
with the object you are moving or copying. F'or instance, 
here's how to move text written in white with a black 
background: 

1. Select the Modes menu. 

2. Select Opaque (if it's not already selected) in the 
Modes menu. 

3. Use the Select icon to frame the box and text. 
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4. Position the pointer inside the framed area and press 
Button 1. Move the text to the new location and press 
Button 2. Both the white text and the black back­
ground inside the framed area move to the new 
location. 

The opposite option to Opaque is Transparent. 

Fill Shape 

If you want to fill your circles and rectangles as you 
create them, select Fill Shape. 

For example: 

1. Select Fill Shape from the Modes menu. 

2. Select the color pattern with which you want to fill 
your shapes. 

3. Select the Circle icon. 

4. Move the pointer to the drawing area and make a 
circle. 

5. Press Button 2 and the shape is filled with the active 
color pattern. 

To fill areas that are already drawn, use the Fill icon. 

Hollow Shape 

Select Hollow Shape to draw circles and rectangles 
without filling them with the color pattern displayed in 
the Active pattern box. Then you'll get only the outline of 
the circle or rectangle. 
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Constrain 

To draw squares, perfect circles, or lines at multiples of 45 
degrees, select Constrain from the Modes menu. When 
this option is on, you get only squares and circles (rather 
than rectangles and ellipses) when you use the Rectangle 
or Circle icon. With the Line icon, you get lines drawn at 
multiples of 45 degrees. 

Note: When using the keyboard as the input device, use 
the diagonal cursor movement keys (Home, End, PgUp, 
and PgDn) to draw squares and circles with Constrain on. 

When Constrain is turned off, you can create ellipses or 
rectangles using the Circle or Rectangle icons or lines at 
any angle using the Line icon. 

Grid 

Using Grid is similar to using graph paper to help you 
draw. The grid does not appear on the screen. It is an 

ｾ＠ invisible grid that helps you do things like: 

1. Align text properly. 

2. Draw parallel lines that are equal distances from each 
other. 

3. Position circles or rectangles on the same line. 

With Grid, you cannot access every pixel (dot) on the 
screen. The grid makes your lines, text, and rectangles 
start at a point on the grid. They cannot start at a point 
that isn't on the grid. 

Select Grid from the Tools menu before drawing objects 
or typing text that you want to align. 

Note: Grid is not valid when using the keyboard as your 
input device. 
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Crosshair 

Select Crosshair to use a large crosshair pointer with the 
Circle, Rectangle, Line, Select, and Text icons option. 

Buffer Fill 

Select Buffer Fill to fill an area of the drawing screen 
with the last image stored in the hidden buffer using Cut. 

The steps to use Buff er Fill are: 

1. Select Buffer Fill from the Modes menu. 

2. Select the Fill icon. 

3. Position the tip of the pointer inside the geometric 
shape or area that you want to fill. 

4. Press Button 1. 

The area is first filled with the lower case "c" to show 
that it is being filled with the last image cut. After the 
area is filled, the image from the hidden buffer overlays 
the area. 

Buffer Fill continues to fill an area until it meets another 
pattern or enclosed area. You can stop a fill by pressing 
Button 2. 

If the area you want to fill is not completely closed, sur­
rounding areas get filled as well. Before you fill an area, 
make sure it has closed boundaries. 

Composite Video 

Select Composite to turn Composite Video mode on and 
off. 

Note: This option is active only for the 320 X 200 - 4 color 
mode. 
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Picture Maker produces pictures that can be displayed in 
two ways. Normally, pictures are displayed on an RGB 
color display monitor. However, pictures can also be dis­
played in composite video mode on a video monitor, video 
projector, or television screen. If you intend to record 
your stories on a video cassette recorder (VCR), you 
should use Composite Video mode. 

Further information about the attachment of Composite 
Video and RGB monitors to the Color/Graphics Monitor 
Adapter board in the IBM Personal Computer can be 
found in the Guide to Operations book. 

To prepare pictures for correct display in Composite 
Video, you must first use this option. This option will 
assure that images are aligned on even pixel boundaries, 
as required for Composite Video display technology. 

Note: Pictures that are prepared or edited for Composite 
Video display without the composite video mode ON may 
not produce acceptable results. 

Transparent Color 

To change the color being used when the Transparent 
option is active, select Transparent Color. 

To change the active Transparent Color: 

1. Select the Modes menu. 

2. Select Transparent Color. 

3. Position the pointer over the drawing color you want 
to use as the Transparent Color and press Button 1. 
The color you selected is now the active Transparent 
Color. 

ｾ＠ 4. Press Button 2 to remove the Transparent Color 
panel. 

To scroll through the available transparent colors while 
using any option that requires the Select icon, press the 
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F7 or F8 key. Press F7 to scroll through the available 
colors in one direction and press F8 to scroll through the 
available colors in the other direction. For example: 

1. Select the Modes menu. 

2. Select Transparent. 

3. Frame an area with the Select icon that has the active 
transparent color within the frame. 

4. Position the pointer inside the framed area and press 
Button 1. 

5. Move the selected area to a new location. 

6. Press F7 or F8 to scroll through the active colors 
available within the selected area. 

7. When the combination of colors you want to use is dis­
played, press Button 2. 

Note: If the Select box moves without the image, you (\ 
cannot rotate through the transparent colors. 

Background Color 

Select Background Color to change the color being used 
for the background color in the drawing space. 

To change the background color: 

1. Select Background Color from the Modes menu. 

2. Select a color from the available drawing colors by 
moving the pointer to the specific color and pressing 
Button 1. 

3. Press Button 2 to exit the Background Color panel. (\ 

You can use the Erase icon to change to the active back­
ground color. 
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OR 

To change the entire drawing area to the active back­
ground color, select the Clear option from the Edit menu. 

OR 

To change the background of a specific area, frame the 
area using the Select icon and select the Clear option 
from the Edit menu. 

Tools Menu (PM) 

i e Ed t Modes,, , 

t- ON 

Blank - OFF 

w1 c age 
Brush Shape 
Edit Pattern 
Set Shadow 
X,Y coordlnate 
Zoom 

tFf x Palette 
Full Screen 
Graph 
Llbrary 
Df gltlze 

When you start Picture Maker, Fix Palette in the Tools 
menu is active. 

Note: In the 320 x 200-4 color mode, Fix Palette will not 
be displayed in the Tools menu. 

Switch Page 

You can have two drawings in memory at the same time. 
One drawing can appear on your screen while a second 
drawing is hidden until you are ready to work with it. 
This allows you to move or copy parts of one drawing to 
the other quickly and easily. 
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Your computer must have additional memory to use 
Switch Page in four of the resolution modes. The addi­
tional memory required for each mode is: 

Mode Minimum Additional 
memory memory 
required (Kb) required 

320 x 200 - 4 320 Kb OKb 

320 x 200 - 256 384 Kb 64Kb 

640 x 200 - 16 384 Kb 64Kb 

640 x 350 - 16 512 Kb 128Kb 

640 x 480 - 16 512 Kb 128Kb 

Note: If you want to use both the Switch Page and the 
Font Editor options during the same drawing session, add 
the additional memory required for the Switch Page 
option to the additional memory required for the Font 
Editor option to determine how much additional memory 
is needed for your system. If you are running in the 640 X 
480 - 16 color mode, you can only use one of the options at 
a time. (\ 

To use Switch Page: 

1. When you have a picture on your screen that you want 
to temporarily hide, select Switch Page from the 
Tools menu. 

The picture is hidden and remains hidden until you 
select Switch Page again. 

2. Next, get or create a second picture. 

You can use Move or Copy to move part of the second 
picture to the first or from the first to the second. Just 
surround the area you want to move or copy with a Select 
box and then select Switch Page. The other picture 
appears along with the area you outlined with the Select 
box. 
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Brush Shapes 

You can choose from 15 different brush shapes to get a 
variety of effects when you are painting with the Brush 
icon. 

ｾ＠ 1. Select Brush Shape from the Tools menu. 

A panel appears showing the various choices. The 
active shape is outlined with a small box. 

2. Move the pointer to the shape you want and press 
Button 1. 

The panel closes. After you select the Brush icon, 
you're ready to begin painting with the active brush 
shape. 

Edit Pattern 

You may need a pattern that is different from those that 
are available on the screen. In that case, you can design 
your own. 

Any patterns that are created during a working session to 
help make the picture or chart can be saved with that 
picture or chart. 

The original patterns return when you restart the 
program. 

To create your own pattern: 

1. Select the pattern that can be most easily modified to 
achieve the effect you want. 

2. Select Edit Pattern from the Tools menu. 

ｾ＠ A panel with two large boxes appears. The left box is a 
magnified portion of the pattern. Use this box to create 
a new color pattern. 

3-37 



The box on the right shows the overall pattern in the 
same size you'll see when you're finished. 

3. Position the pointer inside the large box on the left. 

4. Press Button 1 to change the pattern pixel-by-pixel. 
To add a different color to your pattern select a color r-'\ 
from the Color palette area. 

Each individual pixel you touch with the pointer 
changes color. The large box on the right shows each 
change that you make and lets you know if you're 
achieving the effect you want. 

Press Button 2 if you want to change a point back to 
its original color. 

5. When you're satisfied with the pattern, move the 
pointer to YES and press Button 1. 

The changes are saved. Look at the pattern you 
selected originally. It is temporarily replaced with the 
pattern you just created. 

6. If you don't want to save the changes for the current 
drawing, move the pointer to NO and press Button 1. 

Set Shadow 

Set Shadow is used to place emphasis on objects within a 
picture. With Set Shadow active, you can make objects in 
your picture appear to have a shadow. Set Shadow is used 
to adjust and change the shadow color of the Line, Circle, 
and Rectangle icons, Move, Copy, Graph, and Library 
options. The Set Shadow option does not work when 
making Lines, Circles, or Rectangles with the dash line 
style. 

To change the shadow setting or color: 

1. Select the Tools menu. 
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2. Position the pointer on the Set Shadow option and 
press Button 1 to change the shadow color and the 
amount of shadow. 

3. Move the pointer to the Color palette area and press 
Button 1 to select a new shadow color. The color 

ｾ｜＠ selected is displayed in the Shadow Color panel. 

4. Move the pointer to one of the four direction boxes 
surrounding the shadow box and press Button 1 to 
adjust the shadow settings. The more Button 1 is 
pressed, the more the shadow is adjusted. 

5. To exit from the Set Shadow panel, be sure the pointer 
is outside the Color palette area and press Button 2. 

Here's how to use the Select icon to move and shadow an 
image and make the background color transparent: 

1. Select the Modes menu. 

2. Position the pointer on the Transparent Color option 
ｾ＠ and press Button 1 to change the transparent color. 

3. Move the pointer to the Color palette area and set the 
Transparent Color the same as the background color of 
the area you intend to move. The color selected is dis­
played in the Transparent Color panel. For instance, if 
the background color inside the Select box (the area 
you intend to move) is white, select white. 

4. To exit the Transparent Color panel, be sure the 
pointer is outside of the Color palette area and press 
Button 2. 

5. Move the pointer to the Select icon and press Button 
1. 

6. Use the Select box to frame the area you want to 
move. 

7. Select the Modes menu. 

8. Select Transparent. 
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9. Select the Move option. 

10. Position the pointer inside the Select box and press 
Button 1. The pointer and the Select box disappear 
and the image can now be moved. 

11. Move the image contained inside the Select box to a 
new location and press Button 2. Because Set Shadow 
is still turned on, the image has a shadow. 

12. Press Button 1 to remove the copy of the image and 
return the pointer and the Select box to the screen. 

Note: If the Select box moves without the image, no 
shadow will be drawn. 

To turn the Set Shadow option off and on, move the 
pointer to the Set Shadow option in the Tools menu and 
press Button 2. Then move the pointer outside of the 
menu and press Button 1. 

X, Y Coordinates 

Select X, Y Coordinates to display the current location of 
the pointer in pixels and as a percent of the screen for the 
X and Y axes. These numbers are displayed in the Line 
Styles area and are updated as you move the pointer. 

Zoom 

When Zoom is turned on, a grid appears in the Line 
Styles area of the screen when you move the pointer into 
the drawing space. This grid shows the area of the screen 
surrounding the pointer in detail. The grid provides 
greater accuracy in editing your picture. 

Zoom works with the following options: Pencil, Line, Rec-
tangle, Circle, Select, Fill, Brush, Spray, and Erase icons. ｾ＠
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Fix Palette 

Use the Fix Palette option in the Tools menu to alter the 
colors in the Color palette area. 

When Fix Palette is turned on, you will not be able to 
change any of the colors in the color palette. The number 
of colors available will vary with the resolution mode you 
are using. 

The resolution modes and the fixed number of colors are: 

320 X 200 - 256 colors 
640 X 200 - 16 colors 
640 X 350 - 16 colors 
640 X 480 - 16 colors. 

Note: Fix Palette is not valid in the 320 x 200-4 color 
mode. 

Fix Palette is used to maintain consistency between pic­
tures as you create and run stories with Story Editor and 

ｾ＠ Story Teller. 

When Fix Palette is turned off, you will be able to change 
the colors that can be used to draw your pictures. The 
number of colors available will vary with the resolution 
mode you are using. 

When you start Picture Maker, Fix Palette is turned on. 

Full Screen 

Selecting Full Screen allows you to select an icon or 
Menu option, and then remove the Icon area, Menu area, 
and Color pattern area from the screen in order to draw 
on the entire screen. 

ｾ＠ To use Full Screen: 

1. Select Full Screen from the Tools menu. 
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The Icon area, Menu area, and the Color pattern area 
are removed from the screen and you can draw on' the 
full screen. 

2. To select a different icon, menu option, or color 
pattern, press the Space Bar key. 

3. Select an icon, menu option, or color pattern. 

4. To remove the three areas and start drawing again, 
press the Space Bar key. 

5. When you have completed drawing using the Full 
Screen option, select Full Screen again to exit. 

Note: If you are using the keyboard as your input device, 
press the specific key assigned to the area of the screen 
where you would like the pointer to be placed. For 
instance, if you want to select the Edit menu, press the 
number 2 key. The three areas will reappear with the 
pointer over the Edit menu. 

The Scroll and Microscope Icons and the Edit Pattern, 
Zoom, X, Y Coordinates, and the Font Editor options are 
not available when using the Full Screen option. When 
Full Screen mode is selected, you will not be able to use 
any of these icons or options. 

Graph 

To draw horizontal and vertical bar charts, pie charts, and 
continuous line charts, select Graph from the Tools menu. 

The Graph panel is divided into specific areas. These 
areas are: 

Data 

This is the area where the actual numbers in the graph ｾ＠

are entered. You can enter up to 36 data points. Graph 
data can be either positive or negative values, expressed 
as either whole or decimal numbers. 
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With pie charts, negative data values cause those seg­
ments of the pie to be exploded from the center. 

Graph Type 

This area is where you select the type of graph you want 
ｾ＠ to create. The specific graph types are: 

Graph Type Meaning 

HBAR 

VBAR 

PIE 

LINE 

Represents a horizontal bar graph. 

Represents a vertical bar graph. 

Represents a pie chart. 

Represents a line graph. 

Graph Parameters 

This is the area that controls the appearance of your 
graph. The different fields are: 

Graph Parameters 

Graph Value 

Scale Interval 

Low Mark 

High Mark 

Meaning 

Indicates the amount of space to 
leave between the columns of the 
HBAR and VBAR or the amount 
of offset for the negative pie seg­
ments of a PIE graph. 

Indicates the increments by 
which your graph will be divided. 

Indicates the lowest scale mark 
you want to use. 

Indicates the highest scale mark 
you want to use. 

Details on how these parameters relate to each graph type 
are shown in the charts below. 
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Graph Type - HBAR OR VBAR 

+ Standard -

Graph Percent of 100 = 100% Bars 
value column overlap 

filled by if 
bar. Bars <-100. 
overlap if 
>100. 

Scale Enter any Blank=no Enter 
interval value. Tics scale. (0 =scales any 
value on axis without tics.) value. 

only. Grid 
lines 
extend 
across 
graph. 

Low Enter any Blank= minimum Enter 
mark value(*). data value or any 
value zero, whichever value 

is less. (*). 

High Enter any Blank= maximum Enter 
mark value(*). data value or any 
value zero, whichever value 

is greater. (*). 

Note: (*) If you enter data values outside of the Low and 
High mark values, those data entries will default to low 
and high values when the graph displays. 
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Graph Type - PIE 

+ Standard -
Graph Distance 20 = 20% Any 
value that negative 

exploded value 
pieces are causes 
removed exploded 
from pieces 
center of not to 
pie. Dis- be 
tance is a shown. 
% of 
radius 
length. 

Note: Scale Interval, Low mark, and High mark are not 
applicable when using PIE. 
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Graph Type - LINE 

+ Standard -

Graph Enter any 1 =graph line is Enter 
value value 1 pixel wide. any 

between 1 (0 =no line.) value 
and 10 for between 
line width 1 and 
in pixels 10 for 
(dots). line 

width 
In 
pixels. 

Scale Enter any Blank= no scale. Enter 
interval value. (0 =vertical any 
value Tics on scale without value. 

vertical tics.) Tics 
axes. extend 

from 
the 
ver-
ti cal 
axes to 
form 
grid. 

Low Enter any Blank= minimum Enter 
mark value(*). data value or any 
value zero, whichever value 

is lower. (*). 

High Enter any Blank= maximum Enter 
mark value(*). data value or any 
value zero, whichever value 

is higher. (*). 

Note: (*) If you enter data values outside of the Low and 
High mark values, those data entries will default to low 
and high values when the graph displays. 

Chart Appearance 

These fields will define the colors and the amount of 
shadow that will be used when the graph is drawn. 
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Multiple color fill 

One color fill 

Draws your graph using a dif­
ferent color for each of the bars 
or pie segments. 

Draws your graph using the 
current pattern for all bars or 
pie segments. To change the 
pattern being used, select a new 
pattern. 

Note: If you would like to choose your own colors for the 
graph, select the One color fill option and use white as 
the active color pattern. Then, once the graph is set on 
the drawing area, use the Fill icon and the color pattern 
area to color the graph. 

Changing Graph Shadow Sizes 

To change the shadow settings: 

1. Position your pointer over the four shadow boxes in 
the lower left corner and press Button 1 to select and 
change the shadow color. 

70 

one color ff 11 

At the Shadow box panel, use the Color palette area to 
select a color for your shadow and press Button 1. The 
color selected is displayed in the shadow color box. 

2. Position the pointer on any of the four direction boxes 
surrounding the Shadow box panel and press Button 1 
to adjust the shadow settings. The more Button 1 is 
pressed, the more the shadow is adjusted. 
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3. To exit from the Set Shadow panel, return the pointer 
to the Graph panel and press Button 2. 

The shadow boxes display the amount of shadow on a 
graph. You can turn shadow off or on by placing your 
pointer in the lower left-hand corner where the four 
shadow boxes are located and pressing Button 2. ｾ＠

To use Graph: 

1. Select Graph from the Tools menu. 

2. Point to the first box under Data and press Button 1 
to enter data. 

3. Type the first graph number in row one and press the 
Enter key to move to the next row. 

Continue entering numbers in the same manner. If you 
enter 12 data points and need to enter more, press the 
PgDn key and the next 12 data points will be dis­
played. The maximum number of data points that can 
be entered is 36. You can see previously entered data ,r\ 
points by pressing the PgUp key. 

To stop entering data points, you can press Button 1 
to end data entry or press the Tab key to move to the 
Graph Parameters field. 

4. To enter a value in any of the Graph Parameters 
fields, point to the specific field and press Button 1. 
Type a number and press the Enter key to move to the 
next field. 

5. To stop entering values, press Button 1. 

6. Select a graph type by pointing to one of the four 
types and pressing Button 1. 

7. Before you select YES to draw the graph, you have the r-'\ 
option of selecting one of three solid line styles. To 
change your line style, move the pointer to the specific 
line style in which you would like your graph drawn 
and press Button 1. 
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8. To draw the graph on your screen, point to the YES 
box and press Button 1. To exit the Graph panel 
without drawing the graph, point to the NO box and 
press Button 1. 

To position your graph: 

1. The graph will be drawn in the upper left-hand corner 
of the drawing space and framed by the Select box 
unless the Select box is already active on the screen. 
In that case, the graph will be drawn wherever the 
Select box is located. 

2. You can move the graph to a different location on the 
screen by moving the pointer to a point within the 
Select box and pressing Button 1. Then move the 
pointer to the new location and press Button 1 again. 

3. You can scale the graph by pressing Button 2 and 
moving the pointer in the direction you would like the 
graph scaled. Once you have the desired size, press 
Button 2 again to scale the graph. 

4. To fix the graph to the screen, move the pointer 
outside of the Select box and press Button 1. The final 
appearance of the graph will vary, depending on which 
fill option you have selected. 

5. If you intend to use the entire drawing space (Full 
Screen or Regular drawing space) to scale your graph, 
press FlO to fix your graph on the screen and to 
remove the Select box. 

Use of the Graph option is affected by the Transparent 
and Opaque settings in the Modes menu. When Trans­
parent is turned on, the graph will be drawn in the 
drawing space without a white border. Use this method to 
overlay your graph on a section of another picture 
without "hiding" that section of the picture beneath it. 

When Opaque is turned on, the graph will be drawn in the 
drawing space with a white border, overlaying an area of 
the drawing space. 
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Labelling a graph: 

Here's an example of how to label your graph: 

l. Select the Text icon. 

2. Position the pointer where you want the first graph 
heading to appear and press Button 1. A blinking cursor (\ 
appears, indicating the first position of the text. 

Hint: To move your blinking cursor to the next line, press 
the Enter key. 

3. Type your heading and press Button 2 to set it to the 
screen. 

4. Reposition the pointer to continue labelling your graph. 

For more information on changing text in Picture Maker, read 
"Text Icon (PM)" in this section. 

Library 

Select the Library option in the Tools menu to help create 
pictures from predefined images. There are several libraries 
from which you can make selections. Here are the libraries 
supplied with Storyboard Plus: 

COMPUTER.LBR 
FRAMES.LBR 
MAPS.LBR 
MAPS2.LBR 
NOTATION.LBR 
PM.LBR 
SYMBOLS.LBR. 
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Change Library 

Select Change Library to change the library file used by 
Picture Maker. These files contain different images that 
can be used in your pictures. 

Note: If you are running Storyboard Plus from the 5.25 or 
3.50 inch diskettes, the libraries are located on Diskette 1. 
To view all of the Storyboard Plus libraries (except for the 
PM.LBR file which is on Diskette 2) you need to insert 
Diskette 1 in your default drive and select that drive in 
the Get Library File Services panel. 

To change your library: 

1. Select Library from the Tools menu. 

2. Select Change Library from the Library panel. 

All of the library files saved on the default drive and 
directory will be displayed. 

ｾ＠ 3. To change libraries, point to one of the library files, 
press Button 1, and select YES. If you need help using 
the File Services panel, see "File Services Panel" in 
this section. 

View Picture 

Use the View Picture option to display the library images 
before selecting them. 

1. Select a library image description. 

2. Select View Picture from the Library panel. 

3. To scroll through all of the images in the file, contin­
ually press Button 1 while an image is displayed on 
the screen. 

4. To return to the Library panel, press Button 2. 
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Multiple Color Fill 

Select Multiple Color Fill to draw your image using dif­
ferent colors. 

One Color Fill 

Select One Color Fill to draw your image using only one 
color. The image will be drawn using the Active color 
pattern. To change the pattern being used: 

1. Select the One Color Fill option. 

To change the color of the image: 

2. Position the pointer in the Color pattern area and 
select a color. Note the Color fill box area reflects the 
color you selected. 

3. To use a drawing color with the One Color Fill option, 
position the pointer in the Color palette area and 
select a color. Move the pointer to the Active pattern (\. 
box and press Button 1. Note the Color fill box area 
reflects the color you selected. 

4. You can also change the outline color used with the 
One color fill option by moving the pointer to the spe­
cific color in the Color palette area and pressing 
Button 1. The outline color of the Color fill box area 
reflects the color you selected. 

Note: If you would like to choose your own colors for the 
image, select the One color fill option and use white as 
the active color pattern. Then, once the image is set on 
the drawing area, use the Fill icon and the Color pattern 
area to color the image. 
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Library Images Shadow 

Use this option to change the library images active 
shadow settings and colors. 

To change the Library Images Shadow setting: 

1. Position your pointer over the four shadow boxes in 
the lower left-hand corner and press Button 1 to select 
and change the shadow color. 

At the Shadow box panel, use the Color palette area to 
select a color for your shadow and press Button 1. The 
color selected is displayed in the Shadow color box. 

2. Position the pointer on any of the four direction boxes 
surrounding the Shadow box panel and press Button 1 
to adjust the shadow settings. The more Button 1 is 
pressed, the more the shadow is adjusted. 

3. To exit the Set Shadow panel, return the pointer to the 
Library panel and press Button 2. 

The Shadow boxes display the amount of shadow on a 
image. You can turn shadow off or on by placing your 
pointer in the lower left-hand corner where the four 
shadow boxes are located and pressing Button 2. 
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Selecting Library Images 

To select an image: 

1. Move the pointer to a specific image name and press 
Button 1. 

To see more names, move the pointer to the j or i box and 
press Button 1. 

2. Select YES to remove the panel and draw the image. 

3. To exit the Library panel without drawing the image, 
point to the NO box and press Button 1. 

To position your image: 

1. The image will be drawn in the upper left-hand corner 
of the drawing space and framed by the Select box 
unless the Select box is already active on the screen. 
In that case the image will be drawn wherever the 
Select box is located. 

2. You can move the image to a different location on the 
screen by moving the pointer within the Select box 
and pressing Button 1. Then move the pointer to the 
new location and press Button 1 again. 

3. You can scale the image by pressing Button 2 and 
moving the pointer in the direction you would like the 
image scaled. Once you have the de.sired size, press 
Button 2 again to scale the image. 

4. To fix the image to the screen, move the pointer 
outside of the Select box and press Button 1. The final 
appearance of the image will vary, depending on which 
Fill option you have selected. 

5. If you intend to use the entire drawing space (Full 
Screen or Regular drawing space) to scale your image, 
press FlO to draw your image and to remove the Select 
box from the screen. 
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Digitize 

Use Digitize to create an image using a video camera. 
The Digitize option takes video signals and digitizes them 
for use with Storyboard Plus. Once digitized, the image to 
be edited or saved is displayed in Picture Maker. Special 
hardware is required to use this option. The hardware sup­
ported by this option is the CHORUS Data Systems, Inc. 
PC-EYE 1000, 1100, and 1200 Video Capture Systems. 
Before selecting this option, make sure you have your 
hardware installed correctly. For information on setting 
up the Chorus PC-Eye1 Video Capture board, refer to the 
Chorus Video Capture System User's Guide in the "Instal­
lation and Configuration" section. 

Depending on the type of camera you are using, you may 
need to change the position of Jumper 7 on the PC-Eye 
Video Capture board. 

If you are using an RGB camera, Jumper 7 should be 
in position B as shown: 

If you are using a B&W camera, Jumper 7 should be in 
position A as shown: 

A B 

1. If an indicator is located beside Fix Palette on the 
Tools menu, position the pointer on Fix Palette and 

PC-Eye is a trademark of Chorus Data Systems, Inc. 
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press Button 1 to remove the indicator (and turn off 
Fix Palette). 

2. Select Digitize. 

3. Position the pointer on the Brightness scale and press 
Button 1 to change the brightness of your digitized (\ 
image. 

4. Position the pointer on the Contrast scale and press 
Button 1 to change the contrast of your digitized 
image. 

Hint: The image will have to be digitized again to 
reflect any changes made to the Brightness or Contrast 
setting. 

You have three options for digitizing your picture: 

• Black & White 
• Shades 
• Color. 

The number of shades and colors available will vary, 
depending on the resolution mode you selected in 
F2=Setup. 

1. To digitize an image, move the pointer to the YES box 
and press Button 1. Whatever the video camera is 
pointing at will be digitized onto the screen. 

2. Once the image has been digitized, press the Enter key 
to digitize the image again. To return to the Digitize 
panel, press the Esc key. You can now make adjust­
ments in the brightness and contrast and digitize the 
image again, or move the pointer to the NO box and 
press Button 1 to exit the Digitize option. 

One Input 
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Select this option to use a video 
camera that has one input jack. The 
input line from the camera should be 
placed in the first channel of the 
Chorus PC-EYE card. 



Note: When the One Input option is selected, only the 
Black & White color option is available. The image 
will be displayed on the screen using a grey scale 
range. The amount of grey depends on the location of 
the indicators for the Contrast and Brightness scales. 

RGB Input Select this option to use a video 
camera that has RGB input capabili­
ties. The RGB input lines should be 
placed in the second, third, and 
fourth channels of the Chorus PC-Eye 
card. 

Note: When the RGB Input option is selected, all of 
the color options are available. 

Text Menu (PM) 

Rewrite Last Text 

Get Text 

Font Editor 

Select Rewrite Last Text to rewrite the last text you 
have entered. This text will be written in the upper left­
hand corner of the drawing space with a large crosshair 
cursor displaying the current position of the text on the 
screen. 

You are able to move this text to a different position on 
the screen by moving your input device. As you move your 
input device, a second large crosshair cursor displays on 
the screen. The second crosshair cursor displays the new 
position where your text will be located. Once you have 
the new position selected, press Button 1 and the text 
will move. Press Button 2 to fix the text in this location. 

If you want the text fixed in the upper left-hand corner of 
the screen, press Button 2. 
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Set Attributes 

Select Set Attributes to set the styles and sizes of text you 
type with the text icon. 

To set your text attributes: 

1. Select Set Attributes from the Text menu. If you are 
already in Text mode with a flashing cursor, press 
Button 1 or F2. 

I Fl 1e Edit Modes Tools Text (C) IBM 1987 

+ I Change Font Enter Text 
ｾ＠ .I!. [TIU cm= l_J Set Spacing 

--1-1 Change Position MODERN .FAC 
'tlj'"/ 

ｾｾ＠

[A] 
•B 
ｾｯ＠ , ,. 

Set 
C=:J Right Justified iAttribute 
C=:J Centered panel 
C=:J 

ｾ＠ Bold 

5 

-· Underline 
I D= Italic 

Size 1 

- Outline I Double Horlz -- Shadow I Double Vert! 

loo 

2. After you change your values by pointing to options 
and pressing Button 1, select YES to exit this panel, 
and return to text mode or select NO to exit this 
panel, and return to draw mode. 

Change Font 

Select Change Font to change the type of font being used 
by the program. You have a choice of the following type 
styles that are shipped with the product: 

LABEL 
MODERN 
ROMAN 
STANDARD 
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BOLD 10 (PC Storyboard 1.0 font) 
PM 10 (PC Storyboard 1.0 font) 
ROMAN 10 (PC Storyboard 1.0 font) 
THIN 10 (PC Storyboard 1.0 font). 

To change your font: 

1. Select Change Font from the Set Attributes panel. 

All of the font files saved on the default directory will 
be displayed. 

2. Position the pointer on the font you want to get and 
press Button 1. 

The font name is now highlighted. 

3. When you have highlighted the font you want to get, 
move the pointer to YES and press Button 1. If you 
need help using the File Services panel, see "File Ser­
vices Panel" in this section.) 

Any text that is entered but not set (by pressing 
Button 2) will change to the new font as you return to 
the drawing space to enter text. 

Change Font Size 

Each font has five different sizes available within the file 
(except LABEL which has only three sizes available). 

To change the size of the font, move the pointer to the box 
where the specific size is displayed and press Button 1. 
Continually press Button 1 to scroll through all of the 
available sizes. 

As you select a new size, the sample character displayed 
in the panel changes to reflect the current font size. 
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Double Horizontally 

Select Double Horiz. to double your font horizontally. 

To select this option, move the pointer to the Double 
Horiz. box and press Button 1. Press Button 1 again to 
turn this option off. 

As you select this option, the sample character displayed 
in the panel changes to reflect the current font size. 

The Double Horiz. option can be used with the Double 
V erti. option. 

Double Vertically 

Select Double Verti. to double your font vertically . 

. To select this option, move the pointer to the Double 
Verti. box and press Button 1. Press Button 1 again to 
turn this option off. 

As you select this option, the sample character displayed 
in the panel changes to reflect the current font size. 

The Double Verti. option can be used with the Double 
Horiz. option. 

Set Spacing 

Select the Set Spacing option to change the number of 
spaces that are placed between characters as you enter 
text. 

To set or change the spacing from the Set Spacing panel: 

Move the pointer to one of the four directional boxes and 
Ｇ ｾＮ＠press Button 1. 
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i Increases vertical spacing. 

t Decreases vertical spacing. 

ｾ＠ Increases horizontal 
spacing. 

ｾ＠ Decreases horizontal 
spacing. 

The limits of spacing between words are + 30 and -10. 

To exit the Set Spacing panel, press Button 2. 

Change Position 

Select Change Position to move the text you have entered 
(but not set) to a different position on the screen. 

To change the position of your text: 

1. Select Change Position from the Set Attributes panel. 

A large flashing crosshair cursor displays the current 
text position. 

2. As you move your pointer, a second crosshair cursor 
displays on the screen. This is used to show the new 
position of your text. 

3. Once you have the new spot, press Button 1 and the 
text moves. 

4. Press Button 2 to end Change Position. 

Spacing Text 

Fix Spacing 
Select Fix Spacing to have typed characters 
spaced at the setting entered for Set Spacing. 
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Proportional Spacing 
Select Proportional Spacing to space typed char­
acters proportionally across the screen. 

Justifying Text 

Use Button 1 to turn Left Justified, Right Justified, or 
Centered on or off. 

Left Justified 
Select Left Justified to have your text left justi­
fied as it is typed. 

Right Justified 
Select Right Justified to have your text right 
justified as it is typed. 

Centered 
Select Centered to have your text centered as it 
is typed. 

Type Styles 

Use Button 1 to turn on or off Bold, Underline, Italic and 
Outline. 

Bold 

Underline 

Italic 
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Select Bold after selecting the desired font. 
You can use Bold in combination with any 
size type style and wi.th Underline, Italic 
and Shadow. 

Select Underline after selecting the desired 
font. You can use Underline in combina­
tion with any size, type style and with 
Bold, Italic, Outline, and Shadow. 

Select Italic after selecting the desired 
font. You can use Italic in combination 
with any size, type style, and with Bold, 
Underline, Outline, and Shadow. 



Outline Select Outline after selecting the desired 
font. You can use Outline in combination 
with any size type style and with Under­
line, Italic, and Shadow. 

Note: Your text can be displayed either as bold or out­
Ｎｾ＠ lined. If both Bold and Outline are selected, Outline will 

override the Bold option. 

. ｾＮ＠

To change your outline color: 

1. At the Set Attributes panel, move the pointer to 
Outline and press Button 2. 

2. Point to a color in the Color palette area and press 
Button 1 to make that color the outline color. 

3. Press Button 2 to exit the Outline box. 

4. The color you selected is reflected in the text char­
acter in the box. 

Shadow Select Shadow after selecting the desired type 
style and size. You can use Shadow in combina­
tion with any size type style and with Bold, 
Italic, Underline, and Outline. 

To change the amount of shadow and color: 

1. Select Shadow from the Set Attributes panel and press 
Button 2 to change the amount of shadow and color. 

2. Point to a color in the Color Palette area and press 
Button 1 to make that color the shadow color. 

3. Move the pointer to one of the four direction boxes 
surrounding the shadow box and press Button 1 to 
adjust the shadow settings. The more Button 1 is 
pressed, the more the shadow is adjusted . 

To exit the Set Shadow panel, ensure the pointer is out of 
the Color palette area and press Button 2. 
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Note: The shadow doesn't show as text is typed. You can 
get a preview of how the text will appear with the shadow 
by pressing the FlO key, but the shadow is not fixed to the 
drawing space until you press Button 2. 

Changing the Text Color 

To change the color of your text: 

1. Select Set Attributes from the Text menu. 

2. Point to a color in the Color palette area and press 
Button 1. 

The color of the text will change to the color that was 
selected. 

Get Text 

Select Get Text to read in a text file into the drawing area 

f\ 

in the current font type and style. To read a text file: ｾ＠

1. Select Get Text. 

2. Select a file by pointing to a filename and pressing 
Button 1. If you need help using the File Services 
panel, see "File Services Panel" in this section.) 

3. When you have highlighted the file you want to get, 
move the pointer to YES and press Button 1. 

The text displays (starting in the upper left-hand corner of 
the drawing area) with a large crosshair cursor displaying 
the current position of the text on the screen. 

You are able to move this text to a different position in 
the drawing space by moving your pointer. As you move 
your pointer, a second crosshair cursor displays the new ｾＧ＠
position of the text in the drawing space. This is used to 
show where your text will be located. Once you have the 
new position selected, press Button 1 and the text will 
move. Press Button 2 to fix the text in this location. 
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If you want the text fixed in the upper left-hand corner of 
the drawing space, press Button 2. 

The amount of text displayed depends on the size of the 
active font. The amount of text displayed can be increased 
or decreased by selecting different types and sizes of fonts. 

Font Editor 

Select Font Editor to create new fonts or edit existing 
fonts used by Picture Maker. 

Your computer must have an additional 64Kb of memory 
to use Font Editor. 

Note: If you want to use both the Font Editor option and 
the Switch Page option during the same drawing session, 
add the additional memory required for the Switch Page 
option to the additional memory required for the Font 
Editor option to determine how much additional memory 
is needed for your system. If you are running in the 640 x 
480 - 16 color mode, you can use only one of the options at 
a time. 

Get Font 

Select Get Font to edit an existing font file. 

To get a font: 

1. Select Get Font. Select the size you would like to edit. 
Move the pointer to either Keep the original size or 
Scale to current size and press Button 1. 

2. When you have selected the options you want, move 
the pointer to the YES box and press Button 1. All of 
the font files on the default directory will display. 

Note: If you want to exit the Get Font panel without · 
getting a font, move the pointer to the NO box and 
press Button 1. 
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3. Select a file by pointing to a filename and pressing 
Button 1. If you need help using the File Services 
panel, see "File Services Panel" in this section. 

4. When you have highlighted the font you want to get, 
move the pointer to YES and press Button 1. 

The font file is read into Picture Maker and is ready for 
editing. 

Select Font Size 

To select a certain size font to edit, move the pointer to 
the specific size you want to edit and press Button 1. 

Keep the Original Size 

Keep the Original Size reads the font file into Picture 
Maker, keeping the original size of the font as defined 
when the file was created. This option changes the Font 
editing area to the size of the specific font file. 

Scale to Current Size 

Scale to Current Size reads the font file into Picture 
Maker and scales it to the current size of the Font editing 
area. 

Note: Depending on the current size of the Font editing 
area and the original size of the font file, scaling the file 
may degrade the overall appearance of the characters. 

Save Font 

Select Save Font to save any font you have created or 
modified. 

To save a font: 

1. Select Save Font from the Font Editor panel. 

2. Select the size you want to save by moving the pointer 
to a specific size and pressing Button 1. 
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3. Select YES from the Save Font panel. 

4. Move the pointer to the existing filename if you want 
to replace the previously saved font file with the font 
you have created or edited. If you want to create a new 
file, move the pointer to the New box. 

5. Press Button 1. If this is a new file, the New box is 
highlighted and the pointer disappears. Use the key­
board to type in the name you want to give your font. 
Press Enter when you have typed the filename. The 
pointer reappears on the screen. 

6. Move the pointer to YES and press Button 1. 

The font will be saved using the filename that you speci­
fied. 

Start New Font 

Select Start New Font to create your own font. 

To create your own font: 

1. Select Start New Font from the Font Editor panel. 

i 
! 

You have two choices when using this option. 

• You can create your font using the currently 
defined size for the Font editing area. To create 
your font using the current size, move the pointer 
to the YES box and press Button 1. 

• You can create your font using a font size that you 
defined by moving the pointer to one of the four 
directional boxes and pressing Button 1. 

Increases vertical size 

Decreases vertical size 
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Increases horizontal size 

Decreases horizontal size 

As you press Button 1, the new size of the Font 
editing area is shown on the right-hand side of the 
Font Editor panel. This size is shown in horizontal 
and vertical points. The minimum size you can 
create a font is 5 x 5 pixels and the maximum size 
is 48 x 50 pixels. Once you have defined the size of 
your font, move the pointer to the YES box and 
press Button 1. 

Exit Font Editor 

To exit the Font Editor panel, select Exit Font Editor. 

Pencil 

Select Pencil to help edit or create fonts with point preci­
sion. 

To use Pencil: 

1. Select Pencil from the Font Editor panel. 

2. Move the pointer into the editing area. Press Button 1 
and touch the end of the pointer against each point 
that you want to change. When you want to stop 
changing points, press Button 1 again. 

3. If you press Button 2 and then touch the pointer 
against points you have changed, they change back to 
their original setting. You can go directly from 
changing points to erasing the points you have just 
changed by pressing Button 2. 

Note: If you selected the keyboard as your input device, ｾ＠
press the Space Bar to switch between the Font editing 
area and the Pencil option. 
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Brush 

Select Brush to help edit or create fonts using a 2 X 2 
pixel brush shape. 

To use Brush: 

1. Select Brush from the Font Editor panel. 

2. Move the pointer into the Editing area. Press Button 
1 and touch the end of the pointer against the points 
that you want to change. When you want to stop 
changing the points, press Button 1 again. 

3. If you press Button 2 and then touch the pointer 
against points you have changed, they change back to 
their original setting. You can go directly from 
changing points to erasing the points you have just 
changed by pressing Button 2. 

Note: If you selected the keyboard as your input device, 
press the Space Bar to switch between the Font editing 
area and the Pencil option. 

Cut 

Select Cut to edit and create fonts by cutting a design 
from one character and copying that design to another 
character using the Paste option. Cut is similar to the Cut 
option used in the main drawing mode, except that you do 
not have to frame a portion of the editing area before 
selecting Cut. 

Select the Cut option, move the pointer into the editing 
area, and press Button 1. The character in the editing 
area is stored in a hidden buffer and is available for later 
use with Paste. 

ｾ＠ If you hear a beep after you select Cut, the Cut process 
was not completed successfully. 
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Paste 

Select Paste to recall the last image you stored in the 
hidden buffer while using Cut. 

1. Select Paste, move the pointer into the editing area, 
and press Button 1. The last image stored while using ｾ＠
the Cut option will be pasted into the Font editing 
area. 

2. Move the pointer to position the image and then press 
Button 1 to set the image in place. 

To copy the design of one character into a different char­
acter box: 

3. First select the character design by using Cut and 
then select the new character box and select Paste. 
The design will be pasted into the box. 

If you want take advantage of the editing options avail­
able in the main drawing mode, you can use Cut and 
Paste to copy the design of a character in the main 
drawing mode and transfer it back to the Font Editor. 
The character will always be pasted in the same position 
in the character box, unless that position has been 
changed in the main drawing mode. 

Define Baseline 

Select Define Baseline to set the baseline for the char­
acter you are creating or editing. The baseline is the dis­
tance in the vertical direction between the bottom of a 
character and the line on which it is written. 

To define the baseline: 

1. Select Define Baseline from the Font Editor panel. 

2. Point to the line where you want the baseline to be 
located and press Button 1. 
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Undo 

Selecting Undo enables you to undo everything you have 
done since you last selected an editing tool. 

Note: If you selected the keyboard as your input device, 
press the Space Bar to switch between the Font editing 
area and the Pencil option. 

Create or Edit a Font 

To create a new font: 

1. Select Font Editor from the Text menu. 

2. Select Start New Font from the Font Editor panel. 

You have two choices when using this option. You can 
create the new font using the current default size or 
you can change the default size. 

3. Once you have selected the size of your font, move the 
pointer to the YES box and press Button 1. 

To edit an existing font: 

1. Select Font Editor from the Text menu. 

2. Select Get Font from the Font Editor panel. 

You have two choices when using this option. You can 
get the font and use it in Picture Maker (keeping the 
size of the font as it was created) or get the font and 
scale it to the current font size selected in the Font 
Editor option. As you edit your different font sizes, 
you need to save them individually. Editing a char-

.· acter in one particular font size does not change that 
character in all of the different sizes. 

3. To keep the original size or scale to current size, point 
to the option and press Button 1. 

4. Select the size of the font you want to edit. 
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5. Select YES to view the Get Font File Services panel. 

All of the font files on the default directory will 
display. 

6. Position the pointer on the font file you want to get 
and press Button 1. If you need help using the File 
Services panel, see "File Services Panel" in this 
section.) 

7. When you have highlighted the font file you want to 
get, move the pointer to YES and press Button 1. 

The font file you specified is brought into the program 
and you can edit any of the characters that are in the 
file. The active character is shown in the box on the 
right side of the Font Editor panel. The size of the font 
and the numeric number assigned to the character are 
also shown. 

8. The three ways of selecting the characters you want to 
create or edit: 

• Point to the+-- ｯｲｾ＠ box and press Button 1 until 
the character you want to edit is displayed in the 
box. 

• Enter the specific ASCII decimal value by pressing 
the Alt key and then the number on the numeric 
keypad on the right-hand side of the keyboard. For 
example, press the Alt key and then 65 for the "A" 
character. 

• Enter the character by pressing the actual key. For 
example, if you want to edit the lower case "a," 
press the "a" key. 

9. Use the editing options (Pencil, Brush, Cut, Paste, 
Define Baseline, and Undo) to edit the characters con-
tained in the font file. ｾ＠

10. When you have finished editing the font file, select 
Save Font from the Font Editor panel. 
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11. Select the size you would like to save the font in. 

12. Select YES to display the Save Font File services 
panel. 

13. Move the pointer to an existing filename if you want 
Ｎｾ＠ to replace the previously saved file with the edited font 

file. If you want to create a new file, move the pointer 
to the New box and press Button 1. 

14. If this is a new file, type in the name you want to give 
your font and press Enter. 

15. Move the pointer to YES and press Button 1. 

The font will be saved using the filename that you 
specified. 

16. Select Exit Font Editor in the Font Editor panel to 
return to the drawing space. 
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Icon Area 

The Icon area uses the following items to help draw your 
pictures: 

Icons 

Active pattern box 

Color number 

Butt.on status 

The drawing and painting symbols 
called icons represent the tools 
available to use with Picture Maker. 
For a description of each icon, use 
the Help function. Position the 
pointer over the desired icon and 
press Fl. 

Color palette Displays the various drawing colors 
to draw your picture. Drawing 
colors affect the Text, Pencil, Line, 
Rectangle, Circle, and Microscope 
icons. If the drawing color is made 
the active color pattern, then it also 
affects the Brush, Fill, and Spray · 
icons. 

Line styles 

3-74 

Displays the different widths and 
styles of lines that can be used to 
draw your pictures. 



Active pattern box Displays the current color pattern or 
drawing color being used to paint. 
The Brush, Fill, and Spray icons and 
the Fill Shape mode are affected by 
the color pattern displayed in this 
box. 

Color number 

Button status 

Icons 

Scroll Icon 

... 

Displays the number that corre­
sponds to the drawing color that is 
currently selected. 

Displays which Button is active on 
your input device. 

The pictures you create can be larger than your present 
drawing space area. Use the Scroll icon to move the 
screen horizontally or vertically and view the whole page 
in memory. 

To scroll the drawing space: 

1. Select the Scroll icon. 

2. Position the pointer anywhere inside the your picture 
space. 
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3. Press Button 1 and move the input device in the direc­
tion of the area you want to view. 

If the screen does not scroll in a particular direction, you 
have reached the limits of the direction. 

4. When the picture is where you want it, press Button 2 (\. 
to set it to the screen. 

Select Icon 

r--, 
I I 
I I 
L __ ..J 

The Select icon lets you frame a portion of or the whole 
picture to use with any of the following options: 

• Move 
• Copy 
• Invert 
• Flip 
• Clear 
• Cut 
• Rotate 
• Alter color 
• Scale 
• Save. 

For example, to clear an area: 

1. Choose the Select icon. 

2. Move the pointer to a corner of the area you want 
framed. 

3. Press Button 1 and move the pointer to the opposite 
corner of the area you want to frame. 
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4. When the area is surrounded by the Select box, press 
Button 2. 

The Select box remains active until you either choose 
another icon or position the pointer outside the rectangle 
and press Button 1. 

When you move the pointer outside the drawing area, the 
Select box disappears, but it is still active. When the 
pointer returns to the drawing area, the Select box reap­
pears. 

To clear just that part of the screen you framed using the 
Select icon: 

5. Select Clear from the Edit menu. The part that was 
inside the framed area is removed from the screen. 

If the Select icon starts flashing, the area you have sur­
rounded is too large to move, copy, rotate, or scale (but 
not to invert, flip, or clear). If you want to perform one of 
these options, reduce the size of the area you surrounded 
until the Select icon stops flashing. The area you can sur­
round before the icon starts flashing varies, depending on 
the resolution mode you selected in F2 =Setup. 

If the Select box changes to a dash dot style (normally the 
box is made of dashes), the area you have surrounded is 
too large to cut. If you want to perform this option, reduce 
the size of the area you surrounded with the Select box 
until the box changes back to dashes. The area you can 
surround before the Select box changes to the dash dot 
style depends upon the resolution mode you selected in 
Setup. 

Use the Select icon when you want to move, copy, invert, 
flip, cut, rotate, alter color, scale, or save an area. 

To remove the Select box from the screen, position the 
pointer outside the framed area and press Button 1, or 
simply select a different icon. 
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Notes: 

1. If you use the Select icon to frame the entire drawing 
space, press FlO to remove the Select box. 

2. If the Select box moves without the image, the image 
will not be shadowed or have the ability to rotate 
through the Transparent colors. 

Erase Icon 

Use the Erase icon to remove mistakes that you make 
while drawing, painting, or filling an area or just to refine 
your picture. After selecting the icon, press Button 1 to ｾ＠

start and stop the erase option. To restore any area you 
have just erased, press Button 2. 

For example, you may want to erase a large section of a 
drawing and then restore a small section containing an 
object or design that you want back in the picture: 

1. Select the Erase icon. Note as you move the pointer 
into the drawing area that it changes to a solid block. 

2. Press Button 1 and erase a portion of your picture. 

3. Press Button 2 and move the pointer over the area 
you want to restore. 

Note: Restoring an erased area only works during the 
time the Erase icon is active. Once another icon is 
selected, whatever has been erased cannot be restored by 
pressing Button 2. 
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Spray Icon 

The Spray icon gives a spray-paint effect. You can spray 
with any of the patterns in the Color pattern area or 
Color palette area. Notice that as you continue to spray 
the same area, that area becomes more solid. For example, 
to spray an area using a color pattern: 

1. Move the pointer over to the Color pattern area and 
press Button 1 to select a pattern. 

2. Move the pointer over to the icon area and select the 
Spray icon. Note that as you move the pointer into 
the drawing area the pointer changes to a diamond­
shape. 

3. Move the pointer into the drawing area and press 
Button 1 to start spraying. To stop spraying, press 
Button 1 again. 

If you spray an area by mistake, press Button 2 and move 
the pointer over the area you want to erase. Press Button 
2 again to stop erasing. 

Here's an example of how to spray an area using a 
drawing color: 

1. Move the pointer over to the Color palette area and 
press Button 1 to select a color. 

ｾ＠ 2. Move the pointer down to the Active pattern box area 
and press Button 1 to make the drawing color the 
active pattern. 
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3. Move the pointer up to the icon area and select the 
Spray icon. 

4. Move the pointer into the drawing area. Note that as 
you move the pointer into the drawing area the pointer 
changes to a diamond shape. Press Button 1 to start 
spraying with the active color pattern. To stop (\ 
spraying, press Button 1 again. 

Brush Icon 

Use the Brush icon to paint areas of the screen with any 
of the available patterns in the Color pattern area or 
Color palette area. For example, to paint an area with the (\ 
Brush icon using a color pattern: 

1. Move the pointer over to the Color pattern area and 
press Button 1 to select a pattern. 

2. Move the pointer over to the Icon area and select the 
Brush icon. 

3. Move the pointer into the drawing area and press 
Button 1 to start painting. Note as you move the 
pointer into the drawing area the pointer changes to a 
diagonal line. You can change the shape of the brush 
by selecting Brush Shape in the Tools menu. To stop 
painting using the Brush icon, press Button 1 again. 

If you paint an area by mistake, press Button 2 and move 
the brush shape over the area you want to erase. Press Ｎｾ＠
Button 2 again to stop erasing. 

3-80 



Here's an example of how to paint an area with the Brush 
icon using a drawing color: 

1. Move the pointer over to the Color palette area and 
press Button 1 to select a color. 

ｾ＠ 2. Move the pointer down to the Active pattern box area 
and press Button 1 to make the drawing color the 
active pattern. 

3. Move the pointer up to the Icon area and select the 
Brush icon. Note that as you move the pointer into 
the drawing area the pointer changes to a diagonal 
line. 

4. Move the pointer into the drawing area and press 
Button 1 to start brush-painting with the active color 
pattern. To stop brush-painting, press Button 1 again. 

Fill Icon 

Use the Fill icon to fill geometric shapes or areas of the 
screen with any of the available patterns in the Color 
pattern area or Color palette area. For example, to fill an 
area using a color pattern: 

1. Move the pointer over to the Color pattern area and 
press Button 1 to select a pattern. 

2. Move the pointer over to the Icon area and select the 
Fill icon. 
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3. Position the tip of the pointer inside the geometric 
shape or area you want to fill and press Button 1. To 
stop filling, press Button 2. 

The area is filled with the color pattern you selected. It 
continues to fill an area until it meets another pattern or 
enclosed area. You can stop a fill by pressing Button 2. ("\. 

If the area you want to fill is not completely closed, sur­
rounding areas get filled as well. Before you fill an area, 
make sure the area has closed boundaries. 

Note: To fill over the last area filled with a different 
pattern, select a new pattern and move the pointer into 
the drawing area, and press Button 2. Once you select a 
menu option, icon, or help or fill another enclosed area, 
the pattern is locked in and you can remove it only by 
erasing. However, you can always replace a solid with 
another solid or pattern. 

Here's an example of how to fill an area using a drawing 
color: 

1. Move the pointer over to the Color palette area and 
press Button 1 to select a color. 

2. Move the pointer down to the Active pattern box area 
and press Button 1 to make the drawing color the 
active pattern. 

3. Move the pointer up to the Icon area and select the 
Fill icon. 

4. Position the tip of the pointer inside the geometric 
shape or area you want to fill and press Button 1. 
Press Button 1 to start filling with the active color 
pattern. To stop filling, press Button 2. 
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Text Icon 

T 
The Text icon lets you label your pictures with different 
styles and sizes of text. If you want to use type styles or 
sizes other than the current ones, select them from the Set 
Attributes panel in the Text menu before or while you're 
typing. For a description of all the various text options, 
see the Text menu. The following keys are used for editing 
purposes when the Text icon is selected: 

Enter Moves cursor to begin-
ning of next line. 

Backspace Erases characters. 

Cursor keys Moves the cursor in 
the four directions. 

Insert Inserts characters. 

Delete Deletes characters. 

Shift-Insert Inserts a blank line. 

Shift-Delete Deletes a line of text. 

Home Moves the cursor to 
the beginning of the 
block of text as set by 
pressing Button 1. 

Esc Exits and accepts the 
text. 

Shift-Esc Exits without 
accepting text. 

F2 Displays the Set Attri-
butes panel. 
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FlO Displays a preview of 
the final appearance of 
text when using 
shadow. 

To enter numbers in Picture Maker text entry mode, use (\ 
only the numbers at the top of the keyboard. The numbers 
1 through 9 on the numeric keypad are not active when 
the Text icon or Text menu is selected. 

Storyboard Plus accepts 25 lines of 80 characters per line 
during one text entry session. The style and size of the 
font you select will determine whether or not you can 
view all of the text in memory on the screen. For instance, 
if you selected the THINlO .F AC font, Size 2, Propor­
tional, and the Full Screen option in the Tools menu, you 
could type and view all 25 lines of 80 characters. If you 
increased the size to 4, all of the characters would still be 
in memory, but not all of the characters would be seen on 
the screen. After typing the first 25 lines of 80 characters, 
press Button 2 to accept the information. Press Button 1 
to type the next 25 lines of 80 characters per line. Use this 
technique when you have more then 25 lines of 80 charac- (\ 
ters to enter into your picture. 

Follow these steps to add text to your pictures or charts: 

1. Select the Text icon. 

2. Position the pointer where you want the text to begin. 

3. Press Button 1. 

4. Start typing your text using the keyboard as you 
would a typewriter. 

5. Press Enter when you've finished a line of text. This 
moves the cursor to the beginning of the next line. 

6. If you want to set a new left margin, press Button 2 to 
accept the text entered and cancel the current margin. 
Move the pointer to where you want the new margin 
to begin and press Button 1. 
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7. When you are ready to quit typing text, press Button 
2. 

Text can also be easily aligned by using the Grid option 
described in the Tools menu. 

Microscope Icon 

The Microscope icon magnifies a part of your picture so 
that you can do very detailed work in that area. The fol­
lowing icons are active when using Microscope: Pencil, 
Erase and six different brush shapes. 

ｾ＠ 1. Select the Microscope icon. 

2. Move the pointer to the desired area of the screen and 
press Button 1. 

That section of the screen is magnified and a small 
window appears in the upper left-hand corner. The 
window displays how your drawing is changing as you 
work. When you are at the far-left limit of your picture, 
vertical lines appear beneath the window, indicating that 
you cannot draw in this area. 
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If you position the pointer inside the small window and
press Button 2, you can scroll the drawing to locate a dif
ferent area in which to work. When you press Button 2
again, the new area you scrolled to is magnified on the

3. Select the Pencil icon and move the pointer into the
drawing area. Press Button 1 and touch the end of the
pointer against each point that you want to change.
When you want to stop changing the pixels, press
Button 1 again.

If you press Button 2 and touch the pointer against the
pixels (also referred to as points or dots) you have colored,
they change back to their original color. You can go
directly from coloring pixels to erasing the pixels you
have just colored (without having to press Button 1 to

stop coloring), by toggling between Button 1 and Button
2.

The pixel you touch becomes the same color as the active
drawing color. To change the color you are using, place
the pointer on a different drawing color and press Button
1.



While in Microscope, if you want to change your active 
drawing color to a specific color in the drawing space: 

1. Position your pointer on the pixel with the color you 
want as your active color and press the F2 key. The 
color you selected now becomes the active color. 

2. Press Button 1 to continue drawing, using the active 
color. 

• Use the Erase icon to erase mistakes that you make 
while using the Microscope icon. After selecting the 
Erase icon, press Button 1 to erase. 

You can also restore an area that you have erased by 
pressing Button 2 and moving the pointer over the 
area you want to restore. 

• Use the different Brush icons to paint areas of the 
screen with any color from the Color palette area or 
Color pattern area. Press Button 1 to paint. Press 
Button 1 again to stop painting. 

Press Button 2 to erase what you have painted. Press 
Button 2 again when you want to stop erasing. 

To exit Microscope: 

1. Position the pointer in the small window in the upper 
left-hand corner. 

2. Press Button 1. 

You've exited Microscope. 

Note: When the Microscope icon is active in keyboard 
mode, you need to hold the Shift key down as you press 
one of the arrow keys (the one that points in the direction 
in which you want to draw the line) to draw or brush a 
continuous line. 
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Pencil Icon 

The Pencil icon allows you to draw freehand with pixel 
(dot) precision. Press Button 1 to draw and press Button 
1 again, to stop drawing. 

You can erase what you have drawn by pressing Button 2 
and moving the pointer over the area you want erased. 
Press Button 2 again when you want to stop erasing. 

The Pencil icon uses only the thinnest solid line in the 
Line sty le area for drawing. 

Line Icon 

The Line icon allows you to draw lines in any direction, 
stretching from the initial position of your pointer. You 
can use any of the five different line styles for drawing 
lines. 

For example: 

1. Position the pointer where you want to begin your line 
and press Button 1. 
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2. Move the pointer to extend the length of the line in 
any direction. When the line is as long as you want 
and positioned correctly, press Button 2 to set it on 
the screen. 

3. If you continue moving the pointer and pressing 
Button 2, you can draw a continuous line. 

Notes: 

1. When using the Line icon to make parallel lines that 
have equal distances between them, select the Grid 
option in the Modes menu. 

2. To draw lines at multiples of 45 degree angles, select the 
Constrain option in the Modes menu. 

3. Use the Set Shadow option in the Tools menu to draw 
lines in the current shadow and color setting. You 
cannot place a shadow on the dashed line styles. 

Rectangle Icon 

D 
You can make rectangles starting from the position of the 
pointer and stretching in any direction. You can use any 
of the five line styles to draw rectangles. 

1. Position the pointer where you want the corner of the 
rectangle to begin. 

r---\ 2. Press Button 1 and expand the rectangle to the size 
and shape you want. 

3. Press Button 2 to set the rectangle to your screen or 
create more rectangles from the same corner. 
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4. Press Button 1 to stop drawing rectangles from the 
same corner. You can now select another icon or press 
Button 1 to start a new rectangle. 

Notes: 

1. When using the Rectangle icon to make perfect squares, ｾ＠
select the Constrain option in the Modes menu. 

2. When using the keyboard as the input device, use the 
diagonal cursor movement keys (Home, End, PgUp, and 
PgDn) to draw squares with Constrain on. 

3. Use the Set Shadow option in the Tools menu to draw 
rectangles in the current shadow and color setting. You 
cannot place a shadow on the dash line styles. 

4. To fill your rectangles with the active color pattern as 
the rectangles are created, select Fill Shape in the 
Modes menu. 

Circle Icon 

0 
Use the Circle icon to make circles and ellipses. You can 
use any of the five line styles to draw circles. 

1. Position the pointer where you want the center of the 
circle to begin. 

2. Press Button 1 and move your pointer outward to 
stretch your circle or ellipse. ('\., 

3. Press Button 2 to set the circle or ellipse on the 
screen or create more circles using the same center 
point. 
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4. Press Button 1 to stop drawing circles from the center 
point where you started. You can now select another 
icon or press Button 1 to start a new circle. 

Notes: 

ｾ＠ 1. When using the Circle icon to produce perfect circles, 
select Constrain from the Modes menu. 

2. When using the keyboard as the input device, use the 
diagonal cursor movement keys (Home, End, PgUp, and 
PgDn) to draw circles with Constrain on. 

3. Use the Set Shadow option on the Tools menu to draw 
circles in the current shadow and color setting. You 
cannot place a shadow on the dash line styles. 

4. To fill circles or ellipses with the active color pattern as 
the circles are created, select Fill Shape in the Modes 
menu. 

Selecting Drawing Colors 

The number of colors in which you can draw lines, circles, 
and rectangles depends upon the resolution mode you 
have selected in Setup (F2 =Setup). However, the method 
of selecting a drawing color is the same in every mode. To 
select a drawing color, position the pointer over the color 
in the color palette area you want to use and press 
Button 1. 
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Drawing color 
area for: 

320 x 200-4 color 

Drawing color 
area for: 

640 x 200-16 color 
640 x 350-16 color 
640 x 480-16 color 

320 x 200-256 color 

DODD 
DODD 
DODD 
DITJD 

The Color palette area affects the Text, Microscope, 
Pencil, Line, Rectangle, and Circle icons and the Shadow 
color, Background color, Transparent color and Outline 
color options. If you want to change the color pattern 
used with any of the "painting" icons (Spray, Brush or 
Fill): 

1. Select a color from the Color pattern area. 

Color 
patterns 

2. Select a painting icon. 
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3. Move the pointer into the drawing space and press 
Button 1 to start painting. 

OR 

4. Select a color from the Color palette area. 

OR 

5. Position the pointer on the Active pattern box and 
press Button 1. This makes the selected drawing color 
the active color pattern. 

6. Select a painting icon. 

7. Move the pointer into the drawing space and press 
ｾ＠ Button 1 to start painting. 

320 x 200 - 4 Color Mode 

When you first begin Picture Maker, your drawing space 
is white and your drawing color is black. You can alter­
nate between the white and yellow screen colors by 
placing the pointer over the first color in the palette and 
pressing Button 2. Each time you press Button 2, the 
Menu area, Color pattern area, !Con area, and Drawing 
area alternate between white and yellow. Note that only 
the border remains the same color and the other areas 
alternate between white and yellow. The drawing colors 
also change from cyan and magenta to green and red. 
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You can change the screen mask (the entire screen) color 
by placing the pointer over the second color in the palette 
and pressing Button 2. Each time you press Button 2, a 
different screen color appears. You have a choice of 15 dif­
ferent screen colors. 

320 x 200 - 256 Color Mode 

When you are drawing in this resolution mode, the first 
sixteen drawing colors are fixed and cannot be changed, 
but you have 240 additional drawing colors that you can 
use. You can change any of the 240 drawing colors by 
moving your pointer to Fix Palette in the Tools menu 
and pressing Button 1 to set Fix Palette off. 
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You can view or select any of the additional colors by 
placing the pointer over any of the colors in the color 
palette (except white) and pressing Button 2. 

ｾ＠tEffi 
0 0 0 

A panel displays showing the 240 colors that are avail­
able. To select one of these colors, point to a specific color 
and press Button 1. To exit this panel, press Button 2 . 

• 

1111 
I I I I I 
I I I I I 
I I I I I 

As you exit this panel, notice that the color you selected 
is displayed in the lower left-hand corner of the screen 
where the color number was earlier displayed. 
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Active drawing 
Color 

Now you can use this color with the draw icons (Pencil, 
Line, Rectangle, Circle, and Text). This color remains the 
active drawing color until a different color is selected. To 
make the active drawing color the active color pattern, 
move the pointer to the Active pattern box and press 
Button 1. r\. 

+T 

To change any of the 240 different colors displayed in the 
panel, first select one of the colors, then use the pointer to 
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select any of the numbered boxes on the right-hand side of 
the panel. These numbered boxes display the different 
combinations of red, green, and blue that are used to 
make up that color. By adjusting one or all three num­
bered boxes, you can change the color you have selected. 

•

1111 
I I I I I 
I I I I I 
I I I I I 

R ¥ B 
e e I 
d fi ｾ＠

Move the box up and down with your pointer. Note how 
as the numbers change the selected color also reflects this 
change. Once you have the color you want to use, press 
Button 1 to set the box. Press Button 2 to exit the panel. 

640 x 200-16, 640 x 350-16, and 640 x 480-16 
Color Modes 

When you first begin Picture Maker, your screen is white 
and the active drawing color is black. You can change 
screen colors by moving your pointer to Fix Palette in 
the Tools menu and pressing Button 1 to set Fix Palette 
off. This enables you to scroll through the available 
screen colors. 

1 e 

t- ON 

Blank - OFF 

w c age 
Brush Shape 
Edit Pattern 
Set Shadow 
X,Y coordinates 
Zoom 

tFf x Palette 
Full Screen 
Graph 
Library 
D1g1tfze 
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Move the pointer over the second drawing color in the 
palette and press Button 2. Each time you press Button 
2, a different screen color appears. You have a choice of 
different screen colors, depending on your resolution 
mode: 

16 colors in 640 x 200 
64 colors in 640 x 350 
64 colors in 640 x 480. 

-

When the screen is the color you want, return the pointer 
to the drawing space and begin drawing. 

When you are drawing in this resolution mode, you can 
change your available drawing color by placing the 
pointer over the drawing color you want to change 
(except drawing color one) and pressing Button 2. 

1 DODD 4 

DODD 
DODD 

13 DODD 16 
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Each time you press Button 2, a different drawing color 
appears. When the drawing color you want to use appears, 
move the pointer to the drawing spacing, press Button 1 
and begin drawing. If you want to make the drawing 
color the active color pattern, move the pointer to the 
Active pattern box and press Button 1. The color now 
becomes the active color pattern to use with the Brush, 
Fill, or Spray icons. 

+T 
[_J J!. 

Note: As you press Button 2, the color number in the 
lower left-hand corner of your drawing screen increases 
by one. This number corresponds to the color you have 
selected. Once you have started scrolling through the 
available colors by pressing .Button 2, you can reverse the 
direction of the scroll by pressing Button 1 once and then 
resume pressing Button 2. 

Changing Drawing Color in 
Microscope 

While in microscope, if you want to change your active 
drawing color to a specific color in the drawing space: 

1. Position your pointer on the pixel with the color you 
want as your active color and press the F2 key. The 
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color you selected in Microscope now becomes the 
active color. 

2. Press Button 1 to continue drawing, using the active 
color you selected. 

Note: You can exit Microscope and continue using the Ｎｾ＠
color you selected with the F2 key. The color remains 
active until you select another color from the color 
palette. 

Line Styles 

There are five line styles you can use to draw lines, rec­
tangles, and circles. The three solid line styles are avail­
able with the Graph option. The arrow marker indicates 
the active line style that will be used with the Line, Rec­
tangle, or Circle icon and the Graph option. 

To change line styles: 

1. Select one of the drawing icons (Line, Rectangle, or 
Circle or the Graph option). 

2. Select a line style. The line indicator moves to the 
selected line style. 
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Color Pattern Area 

The Color pattern area displays the colors and patterns 
available to fill areas. Some resolution modes have two 
sets of color patterns for your use. You can also create 
your own color patterns by selecting the Edit Pattern 
option in the Tools menu. The Spray, Brush, and Fill 
icons use patterns from the color pattern area. 

Before you begin painting with the Brush icon, select a 
color pattern. Decide which pattern you want from the set 
of patterns on the right side of your screen. 

Note: If you are drawing in resolution modes 640 x 200-16, 
640 x 350-16, or 640 x 480-16, there are 30 additional color 
patterns you can use. To display the 30 additional color 
patterns, move your pointer over any of the color patterns 
on the right-hand side of your screen and press Button 2. 

Color 
patterns 

1. When you decide which pattern you want to use, posi-
Ｎｾ＠ tiori the pointer over the pattern and press Button 1. 

Look at the color pattern box in the lower left-hand 
corner of the screen and you'll see your selection. The 
color pattern displayed in this box is the active 
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pattern. You can change the color pattern as often as 
you like. 

D= 
- Active pattern 

box 
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Picture Taker 

Picture Taker is the program you use to capture picture 
images of application screens while you are running other f\. 
application programs. User programs that program the 
Graphics Adapter directly, and bypass the Basic 
Input/Output System (BIOS) may prevent Picture Taker 
from capturing screens. 

Picture Taker works by attaching a small program of 
approximately 5K bytes to part of the DOS control 
program. This program can be turned on and off, and can 
capture both 40- and SO-column text mode as well as 
medium and high resolution graphic screen images. Also, 
it can put more than one picture in the designated file, 
and in this event will sequentially number these screens. 

Starting Picture Taker 

Type in PT to start the program from the DOS prompt or 
type SBMENU to start the IBM Storyboard Plus Quick 
Menu/Setup program. You can change the Setup options 
of your product and then select Picture Taker from the 
menu. 

After you enter PT or select Picture Taker from the 
Quick menu, a panel will display showing the options that 
specify how you want Picture Taker to work. You can 
choose to change one or more of these options. Move the 
cursor by pressing the Tab key to the option you would 
like to change and enter the information. 

The list of choices are: 

• Picture Taker Active 
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Select this option to turn Picture Taker on and off. 
When Picture Taker is active (on), the PrtSc (print 
screen) key works like the shutter button on a camera. 
While viewing any application screen, press the PrtSc 



key to take a picture of the screen and save it under a 
designated DOS file name in the current or designated 
directory. You can develop the picture later to meet 
your needs by using the functions in Picture Maker, 
Text Maker, or those in Story Editor. 

When Picture Taker is made inactive (off), picture 
taking will be cancelled, and the PrtSc key will return 
to its normal operation. However, Picture Taker 
remains attached to DOS. To remove this program 
from memory, you must restart DOS with the 
Ctrl-Alt-Del key sequence. 

• Use Active Display 

Select this option to have Picture Taker capture the 
the picture shown on the active display monitor, either 
color or monochrome, at the moment the PrtSc key is 
pressed. (The application program must have used DOS 
or BIOS to set the currently active display monitor.) 

When Use active display is turned off, Picture Taker 
ｾ＠ will only capture the pictures displayed on the color 

monitor. When this option is specified, the program 
assumes one thing: regardless of which of the two dis­
plays is currently active, the picture will be captured 
from the color display. 

• Filename 

Select this option to enter the drive, path, and file 
name in which you will put your captured pictures. 

If Picture Taker is active, you do not need to specify a 
DOS filename when changing the other options unless 
you want to change the filename. 

If you do not enter a drive and path specification, 
Picture Taker will put the captured pictures in the des­
ignated file in the current directory on the current 
drive when the Picture Taker program is started. 

If you do not specify a file extension, Picture Taker 
will add a . CAP file extension to the file name. 
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If you stop a Picture Taker session and later start a 
new session with the same path, directory and 
filename, the second session will add pictures to the 
end of the file created during the first session. 

Press the FlO key to exit the Picture Taker panel and ｾ＠

accept all changes made. Press the Esc key to exit the r ' 
Picture Taker panel without accepting the latest 
changes. 

Operating Considerations 

PrtSc Key 

The Picture Taker program (PT.COM) alters the function 
of the PrtSc key to capture pictures. Other programs, 
notably the DOS GRAPHICS program, may also attach 
themselves to DOS and alter the function of this key. The 
order in which you run the programs that affect this key 
is important. After you have started DOS (the Ctrl-Alt-Del 
key sequence), run any other programs that attach to DOS (\ 
and alter the PrtSc key before you run the PT program. If 
you find that you need to run such a program after 
starting Picture Taker, you must first restart DOS, then 
run that program (or programs), then run the PT program 
last. Operation of the PT program can be changed by 
again running PT and changing any of the options. Do 
not run or rerun any other programs that alter the func-
tion of the PrtSc key between entries of the PT option, 
even though Picture Taker has been made inactive to 
cancel picture taking. 

Programs That Do Not Use The BIOS 

If you are attempting to capture graphics screens but are 
getting incorrect results, the program you are using may 
have bypassed the BIOS. The basic input/output system, (\ 
or BIOS, resides in Read-Only Memory (ROM) on the 
system board and provides device-level control for the 
major input/output devices in the system. Although BIOS 
is intended to provide an operational interface to the 
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system and relieve the programmer of concern about the 
characteristics of hardware devices, some programs do not 
use the BIOS. Should this be the case, Picture Taker may 
not be able to determine the current display mode. 

ｾ＠ Changing Picture Taker Options 

If you wish to change the drive, the file, or any of the 
options used by Picture Taker, reenter the Picture Taker 
panel and change the options. 

Taking Pictures 

After turning on Picture Taker by entering a DOS 
filename, press the PrtSc key when you see a screen you 
want to capture. Picture Taker will respond in one of two 
ways: 

3 short beeps 
Picture has been taken. 

1 short beep 
DOS is currently running and the picture will be 
taken when the currently active DOS command 
has completed. DOS may be waiting for you to 
press one or more keys and then the three short 
beeps will follow. 

High-low sound 
A high-low sound will be heard if an error has 
occurred. Errors can result from problems such 
as a diskette or disk that is full, a write­
protected or improperly inserted diskette, a 
diskette door that is open, or a bad or unfor­
matted diskette. 

Note: PT does not capture pictures displayed in native 
3270 PC mode or host text or graphic screens. 
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Retrieving the Captured Pictures 

Each time an additional captured picture is put in the 
same file, the picture is added to the file following all pic­
tures already in the file. Because this is a single file, a 

D_OS ｄｉｒＺｅｃｨｔｏｦｾｬｹ＠ ｣ｔｯｨｭｭｾｮ､＠ will noht sh1dowk the nu1mbefr ohf ｾＮ＠
pictures in t e I e. ere1ore you s ou eep a og o t e 
pictures so that you can call them by number in Picture 
Maker, Story Editor, and Text Maker. 

Pictures captured in graphics mode can be viewed and 
edited in Picture Maker. Use Get Picture in Picture 
Maker to view captured pictures. When more than one 
picture is stored in a captured picture file, each is given a 
sequential number. Once a graphics picture from a cap­
tured file has been modified by Picture Maker, it cannot 
replace the original picture in the captured file. You 
should use Save Picture to save it as a single picture. 

Note: When you are retrieving pictures taken with the 
Picture Taker program, we recommend that Fix Palette 
be turned on in the Tools menu of Picture Maker. 

1 e 

t- ON 

Blank - OFF 

w1 c age 
Brush Shape 
Edit Pattern 
Set Shadow 
X,Y Coordinate 
Zoom 

tFix Palette 
Full Screen 
Graph 
Library 
D!gftfze 

Captured text files cannot be retrieved by Picture Maker, 
but they can be viewed and edited in Text Maker. Use the 
Get option in Text Maker to view captured pictures. 
When more than one picture is stored in a captured 
picture file, each is given a sequential number. For 
example, when using Text Maker, you would enter 
PICFILE.CAP 3 to get the third captured picture in 
PICFILE.CAP. Once a text picture from a captured file 
has been modified by Text Maker, it cannot replace the 
original picture in the captured file. You should use the 
Save option to save it as a single picture. 
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Story Editor 

Story Editor is the part of Storyboard Plus you use to 
assemble the picture files you have created into a com­
plete presentation. You can determine how the pictures 
are sequenced, how they are displayed, and how the tran­
sitions between them are executed. 

Starting Story Editor 

Type SE to start the program from the DOS prompt or 
type SBMENU to start the IBM Storyboard Plus Quick 
Menu/Setup program. At the IBM Storyboard Plus Quick 
Menu/Setup menu, you can change the Setup options of 
your product and then select Story Editor from the menu. 

te:XX/XX/XX IBM Storyboard Plus 
Quick Menu/Setup 

Programs Menu 

Picture Maker 
Picture Taker 

t_'_ _, ,.·."·. _, ____ Ｍ｜ｴｩ＾ｦＮｗｴｦﾥｴｾＬｧＲ［＠ﾷｾﾷ•ﾫ＾＠ ﾷﾷﾷﾷｾＭ

tory Iler 
Text Maker 

To start a program use t ｯｲｾ＠ keys to 
higbllgbt the jircsram, then press +-' . 

VersianLOO 
Copyright IBM Corporatian lllB8, l98'7 

F1=Help ｾ＠ F3=Mecu MaiDteaance Esc=Eldt 
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Using the Keyboard with SE 

The instructions for this chapter assume that you are 
using a mouse as an input device. If you are using the 
keyboard as your input device, the following information 
will assist you in using Story Editor. If you are using a 
joystick or graphic tablet, the information in Chapter 1 
will assist you if you have questions about moving the 
pointer and selecting options. 

Selecting Menu Options with a 
Keyboard 

The keyboard has two keys that you can use to select 
menu options. Use the numeric key pad Plus (+)key as 
Button 1 and the Minus(-) key as Button 2. 

To help you change menu options, there are certain keys 
assigned to specific areas of the screen. The screen areas 
and their assigned keys are: 

File menu 1 

Edit menu 2 

Modes menu 3 

Run menu 4 

Pressing one of these keys will move the pointer from the 
current position to the selected screen menu and display 
the menu options. To choose a menu option, highlight 
your choice and press Button 1 ( + key). The pointer 
returns to the Story Table with the new selection ready to 
use. 

Note: If you make a selection by mistake, press the Esc 
key to exit the selection. 
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To move the pointer on the Story Table, here is a list of 
the keys and their assigned pointer movement: 

-+and+-- Moves the pointer 
one column in the 
direction of the 
arrow. 

j and! Scrolls the story 
one line in the 
direction of the 
arrow. 

y Confirms selection. 

N Exits panel without 
executing selection. 

Pg Up Displays previous 
panel selections 
lines. 

PgDn Displays additional 
panel selections 
lines. 

Tab Moves pointer one 
column to the 
right. 

Shift-Tab Moves pointer one 
column to the left. 

Shift-+- Moves the pointer 
to the beginning of 
the Story Editing 
Line. 

Shift--+ Moves the pointer 
to the end of the 
Story Editing Line. 
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Creating and Editing a Story 

You describe how your story works by filling in informa­
tion in the columns of the table displayed when you select 
Edit Story from the Story Editor Main Menu. Each line in 
the story table represents one step in the resulting story. ｾ＠

1 rl 1e Edit Modes Run I (c) IBM 11187 

Nl LABEL COMMAND PARAMETERS TIME WATT 

!lllE 

I /•Story Last L !ne a c 

EDIT LINE 

ｾｉｖ･ｮＭ｣ｲＭ｜､＠ Used OZ 

Story 
>Table 
area 

If you are creating a new story, you will see an empty 
story table displaying a highlighted line. The highlighted 
line is where information can be entered into your story. 
This line is referred to as the Story Editing Line. 

When you enter information on the last line of a story, 
another line is automatically added to the Story Table. 
There will always be one blank line between the Story 
Editing Line and the Story Last Line. 

If you are editing an existing story to make a new one, 
you will see many lines in the story table describing the 
steps in the existing story. Any of this information can be 
changed to create your new story. 

The number of lines you can have in your story will vary, 
depending on the number of labels, comments, and direc- ｾ＠
tory locations of the files used· by your story. On average, 
a story can contain 450 story lines. 
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The Story Table Screen is divided into three areas. They 
are: 

• Menus 
• Story Table 
• Story Monitor. 

Each of these areas and their options and functions will 
be described in detail in this chapter. 

In addition, in the lower left-hand corner, there is a 
button status indicator to let you know if a button is 
active, a memory indicator to let you know how much 
memory your story has used, a mode indicator to let you 
know which edit mode is active, and a drive path indi­
cator to let you know the path used to access any file in 
the PARAMETERS column when it is on the Story 
Editing Line. 

File Services Panel 

When either Get, Save, Merge, or Remove a file is 
selected, the File Services panel is opened. 

I ｾ＠ l le Edit Modes Run I (c) ISM 1987 

111r LABE' ,..,.._, ""''""' t"\At"\llUl"'"Tr-r.r "T"., ..... 
ｾ＠

B:\ 
\ 

-- ｾ＠2 

I 1 PIC files I GET Picture file I = I ' All files I IYES"J c:::::]LJ 

\File I \ 

Servit: es 
Drive Directory Filename 

A < None ' < None ' .... .... .... 
B 
ｾ＠ - -

c ... ... ... 
EDIT 

-;;dMemory Used oz II 

The top line of the panel shows you the current drive and 
directory being accessed. 
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The middle of the panel gives you the option of viewing a 
specific type of file or all files. The specific type of file 
will be determined by the function you choose. It also has 
an area for you to confirm that you do want to select a 
file by responding with a YES or NO. 

The bottom of the panel lets you select the drive, direc- Ｎｾ＠

tory, and file that you want. If you have saved any files 
on the disk, a list of those files appears in the Filename 
column in the lower right corner of the screen . If no files 
are on this disk, the entry None displays. If you are 
saving a file, the entry New displays as an option. 

Using the File Services Panel 

To select a file from the File Services panel: 

1. Select either the highlighted file type or All files. 

2. If you wish to see all file types, move the pointer to 
All Files and press Button 1. 

3. Place the pointer on the drive letter for the correct 
drive and press Button 1. If the drive displayed at the 
top of the panel is correct, this step is not required. 

If you have more drives than display, move the pointer to 
the i box on the right of the drive column and press 
Button 1 to see the other installed drives. Continue 
pressing Button 1 until you find the correct drive. You 
can see previous drives by moving the pointer to the j box 
and pressing Button 1. 

4. Place the pointer on the correct directory and press 
Button 1. If the directory displayed at the top of the 
panel is correct, this step is not required. 

If you have more directories than display, move the 
pointer to the i box on the right of the Directory column .r-'\ 
and press Button 1 to see the other directories. Continue 
pressing Button 1 until you find the correct directory. 
You can see previous directories by moving the pointer to 
the j box and pressing Button 1. 
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5. Place the pointer on the file you want to get and press 
Button 1. 

That file is now highlighted. If you have more files than 
display, move the pointer to the L box on the right of the 
Filename column and press Button 1 to see the other 
files. Continue pressing Button 1 until you find the 
correct file. You can see previous files by moving the 
pointer to the j box and pressing Button 1. 

Storyboard Plus arranges the files in alphabetical order 
by file extension and then by filename so you can easily 
locate your file. 

6. When you have highlighted the file you want to get, 
move the pointer to YES and press Button 1. 

The File Services panel closes. 

7. If you decide you don't want to get a file after all, 
place the pointer on NO and press Button 1. 

Story Editor Menus 

Opening a Menu 

To open a menu, move the pointer to the menu you want 
and press Button 1. To select a function, move the 
pointer to the item you want and press Button 1 again. 
This selects the function and closes the menu. 

Exiting a Menu 

To return to the Story Table Screen without selecting any 
options, position the pointer outside the Menu area and 
press Button 1. 
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File Menu (SE) 

Get Story 

Use Get Story to retrieve story files that you have previ­
ously saved on a disk. After you get a story on the screen, 
you can edit, print, or run it. 

To get a story file: 

1. Select Get Story on the File menu. 

The File Services panel will appear. 

2. Select the file you want to get. (If you need help using 
the File Services panel, see "File Services Panel" in 
this chapter.) 

Notice that the name of the story appears in the upper left 
corner of the screen. Whenever you get an existing story, 
the story name appears here. 

Save Story 

After you create a story, you can save it on a disk by 
selecting Save Story. 

Note: Unless you save a story, you will lose it when you 
clear the screen or turn off the power. Also, when you ｾ＠
make any changes to a story that has been previously 
saved, you must save the story again in order to keep 
those changes. 
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To save a story: 

1. Select Save Story on the File menu. 

The File Services panel will appear. 

ｾＧ＠ 2. Select an existing story name if you want to replace a 
previously saved story or New if you want to create a 
new story. (If you need help using the File Services 
panel, see "File Services Panel" in this chapter.) 

3. If you selected New, use the keyboard to type in the 
name you want to give your story and press Enter. 

4. Move the pointer to YES and press Button 1 . 

The story is saved and the name appears at the upper left­
hand corner of the screen. Although the story is saved on 
disk, a copy remains in memory for you to continue 
editing. 

Merge Story 

This option allows you to merge an existing story with 
your currently displayed or active story. 

To merge a story: 

1. Select Merge Story on the File menu. 

The File Services panel will appear. 

2. Select the story that you wish to merge with your 
active story. (If you need help using the File Services 
panel, see "File Services Panel" in this chapter.) 

The program is placed in Merge Story mode. This is indi­
cated at the lower left-hand corner of the Story Table 

Ｎｾ＠ screen. 

3. Place the line you want to follow the merged story on 
the Story Editing Line by scrolling the Story Table up 
or down. 
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4. Move the pointer to the Story Editing Line and press 
Button 2. 

The story you chose will be added to your active story. 
Using this option changes only the active story, not the 
story that was merged. 

5. If you want to merge the story additional times, press 
Button 2 again. 

6. To exit Merge Story mode, (with or without merging a 
story), move the pointer to the Story Editing Line 
and press Button 1. 

Remove Story 

Use the Remove Story option to erase stories from your 
disk. You may want to delete old stories or need to make 
room on your disk for new stories. 

To remove a story: 

1. Select Remove Story on the File menu. 

The File Services panel will appear. 

2. Select the story you want to remove. (If you need help 
using the File Services panel, see "File Services Panel" 
in this chapter.) 

The story will be removed from your disk. 

Record Voice 

This option allows you to record a voice and create a file 
that can be played back with your story. You must have 
either the IBM Voice Communications Option or the IBM 
Personal System/2 Speech Adapter installed along with a Ｎｾ＠

microphone and speaker in order to use this option. 

If you are using the IBM Voice Communications Option, 
you must run VOICE.BAT before starting Story Editor. 
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Also, the following files must either be in the directory 
with Story Editor or be accessed using the DOS PATH or 
APPEND commands: 

VCAPIDRV.COM VlOTSP.AIC 
APIDIR.AIC V2INSP.AIC 
BASEPC.AIC V20TSP.AIC 
BASESP.AIC V3INSP.AIC 
BATCMD.AIC V30TSP.AIC 
VOINPC.AIC V 4INSP.AIC 
VOOTPC.AIC V40TSP.AIC 
VlINSP.AIC 

To record a voice or review a previously recorded file: 

1. Select Record Voice on the File menu. 

The Record Voice Panel will appear. 

Record Voice Panel 
(IBM Personal System/2 Speech Adapter) 

Get Voi'ce Flle 
Save Voice File 
Recording 
Playback 
Exit 

2. Select either: 

HELLO .SPK 

Memory used: 0% 

Slow Sampling 
Medium Sampling 
Fast Sampling 

• Get Voice File 
• Save Voice File 
• Recording 
• Playback 
• Exit. 
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Get Voice File 

Select Get Voice File to retrieve voice files that were pre­
viously saved on a disk. After you get a voice file, you can 
play it back or record over it. 

To get a voice file: 

1. Select Get Voice File from the Record Voice panel. 

The File Services panel will appear. 

2. Select the file you want to get. (If you need help using 
the File Services panel, see "File Services Panel" in 
this chapter.) 

Save Voice File 

Select Save Voice File to save your current voice 
recording. 

To save a voice file: 

1. Select Save Voice File from the Record Voice panel. 

The File Services panel will appear. 

2. Select an existing voice file if you want to replace a 
previously saved file or New if you want to create a 
new file. (If you need help using the File Services 
panel, see "File Services Panel" in this chapter.) 

3. If you selected New, use the keyboard to type in the 
name you want to give your file and press Enter. 

4. Move the pointer to YES and press Button 1. 

The file is saved. Although the file is saved on disk, a ('\ 
copy remains in memory for you to play back or record 
over. 
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Recording 

Select Recording to record a voice file that can be used in 
your story. 

To record a voice file: 

1. Select a sampling rate from the Record Voice panel. 

The slower sampling rates have poorer quality but use less 
memory. Some experimentation may help you decide 
which rate to use. 

2. Select Recording from the Record Voice panel. 

3. If you are using the Voice Communications Option, 
press the Enter key to start r-ecording and the Esc key 
to end. 

4. If you are using the IBM Personal System/2 Speech 
Adapter, a panel will display, allowing you to choose 
the length of your recording. The length options vary, 
depending on the sampling rate selected. Select a time 
from this panel and recording will begin. 

When the recording is complete, the Record Voice panel 
will reappear. 

Playback 

Use Playback to playback the file currently in memory. 
To playback the active voice file, select Playback from 
the Record Voice panel. 

If you are using the IBM Voice Communications Option, 
press F7 to increase volume and F8 to decrease it. 

To stop playback, press Esc. 

5-17 



Exit 

Use Exit to exit the Record Voice Panel and return to the 
Story Editing Screen. If you want to save an active voice 
file, do so before you exit. To exit, select Exit from the 
Record Voice Panel. 

Print Story 

Print Story prints the lines of the Story Table. The pic­
tures in you story will not be printed with this function. 

If you wish to print the story you are working on: 

1. Select Print Story on the File menu. 

2. Press Enter to begin printing. 

3. Press Esc to return to the file menu without printing 
your story. 

4. To cancel a print job once you have started it, press ｾ＠
the Esc key. 

If you have marked a block of lines, only the marked lines 
within the block will print. 

Main Menu 

To go to the Story Editor Main.Menu, select Main Menu 
from the File Menu. 

To return to the Story Table Screen, select Edit Story 
from the Story Editor Main Menu. 
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Edit Menu (SE) 

0 0 

Insert Line 

Insert Line is used to add additional story lines to the 
story table. 

To insert additional lines in your story: 

1. Select Insert Line from the Edit menu. 

The program is placed in Insert Line mode. This is indi­
cated at the lower left-hand corner of the Story Table 

ｾ＠ screen. 

2. Place the story line you want to follow the inserted 
line on the Story Editing Line by scrolling the Story 
Table up or down. 

3. Move the pointer to the Story Editing line and press 
Button 2. 

You may press Button 2 again to add additional lines. 

4. When you have inserted as many lines as you wish, 
move the pointer to the Story Editing Line and press 
Button 1 to exit Insert Line mode. 
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Delete Line 

Delete Line is used to delete lines from the Story Table. 
To delete lines from the Story Table: 

1. Select Delete Line from the Edit menu. 

The program is placed in Delete Line mode. This is indi­
cated at the lower left-hand corner of the Story Table 
screen. 

2. Place the line you want to delete on the Story' Editing 
Line by scrolling the Story Table up or down. 

3. Move the pointer to the Story Editing Line and press 
Button 2. 

You may press Button 2 again to delete additional lines. 

4. When you have deleted as many lines as you wish, 
move the pointer to the Story Editing Line and press 
Button 1 to exit Delete Line mode. 

Mark Block 

Mark Block is used to mark a section of your story so 
that it may be copied, printed, or deleted. 

To mark a block of your story: 

1. Select Mark Block from the Edit menu. 

The program is placed in Mark Block mode. This is indi­
cated at the lower left-hand corner of the Story Table 
screen. 

2. Place the first line of the section to be marked on the 
Story Editing Line by scrolling the Story Table up or 
down. ｾ＠

3. Move the pointer to the Story Editing Line and press 
Button 2 to mark the first line of the block. 
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The line number will be highlighted. 

4. Place the last line of the section to be marked on the 
Story Editing Line by scrolling the Story Table up or 
down. 

5. Move the pointer to the Story Editing Line and press 
Button 2 to mark a block. 

The line numbers within the marked block will be high­
lighted. 

6. When you have marked a block, move the pointer to 
the Story Editing Line and press Button 1 to exit 
Mark Block mode. 

Copy Block 

Copy Block is used to copy a marked block of lines to a 
different section of your story. 

To copy a marked block of story lines: 

1. Select Copy Block from the Edit menu. 

The program is placed in Copy Block mode. This is indi­
cated at the lower left-hand corner of the Story Table 
Screen. 

2. Place the story line you want to follow the copied 
block on the Story Editing Line by scrolling the Story 
Table up or down. 

3. Move the pointer to the Story Editing Line and press 
Button 2. 

4. If you wish to copy the block more than once, press 
Button 2 until you have copied the block as many 

ｾ＠ times as you wish. 

5. When you have copied a block as many times as you 
wish, move the pointer to the Story Editing Line and 
press Button 1 to exit Copy Block mode. 
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Delete Block 

Delete Block is used to remove a marked block of lines 
from your story. 

To delete a marked block of story lines: 

1. Select Delete Block from the Edit menu. 

A panel appears asking you to confirm your selection. 

2. Select YES to delete a marked block of lines. 

3. Select NO to exit the panel without deleting lines. 

Remember, once lines are deleted, they cannot be 
retrieved unless you have previously saved your story. 

Unmark Block 

To unmark a block of story lines, select Unmark Block 
from the Edit menu. 

Start New Story 

You can create a new story using this option. When you 
select Start New Story, the story table is cleared. Be sure 
to save any changes made to an existing story before 
starting a new story. 

To begin a new story: 

1. Select Start New Story from the Edit menu. 

A panel appears asking you to confirm your selection. 

2. Select YES to start a new story. 

3. Select NO to exit the panel without starting a story. 
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Modes Menu (SE) 

I ｾ＠ 1 1e Edi Run I (C) IBM 19B7 

NC LABEL COMI 
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IAMETER TIME WAIT 
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I 
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Picture Maker 

Select this function use the Picture Maker module of 
Storyboard Plus without exiting Story Editor. 

To use Picture Maker without exiting Story Editor: 

1. Select Picture Maker from the Modes menu. 

ｾ＠ The program will then switch to the Picture Maker 
drawing screen. When using Picture Maker in this 
manner, you will not have access to the Picture Maker 
Main Menu. Also, Picture Maker will use the same input 
device and printer as selected in Story Editor. 

2. To return to Story Editor, move the pointer to the File 
menu on the Picture Maker screen and press 
Button 1. 

3. Move the pointer to Story Editor and press Button 1. 

You will return to the Story Editor Screen. 

Note: Switch Page and Font Editor may not be available 
to you when Picture Maker is accessed in this manner. 

ｾ＠ The amount of memory in your machine and the resol­
ution mode you are in will determine if these functions 
are available. 
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Monitor 

When running or stepping through your story, use this 
mode to display your pictures in the area at the bottom 
right of the screen below the story table. The pictures that 
appear in the monitor will not be of the same quality as r-'\ 
those that appear using the full screen. However, you can 
see the line of the story being executed as the story is dis-
played. 

Text screens cannot be displayed in this mode, but a rep­
resentation of these files will be shown. 

To view your story in Monitor mode: 

1. Select Monitor on the Modes menu. 

2. Select either Run Story or Step Story from the Run 
menu. 

Full Screen 

Full Screen allows you to use the entire screen to display 
your pictures when running or stepping through your 
story. The Story Table is not displayed in this mode while 
the story is being run. 

To view your story in Full Screen mode: 

1. Select Full Screen on the Modes menu. 

2. Select either Run Story or Step Story from the Run 
menu. 
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Run Menu (SE) 

The Run menu provides options you can select to run your 
story. The pictures in your story will be shown in the 
sequence you have placed them, using the display methods 
you have chosen. Using Run Story or Step Story to run 
your story lets you determine if the display techniques 
you have selected provide the effect you desire. 

I t-1 le Edit Modes ｾ＠ (C) IBM 1987 

NC LABEL COMMAND 
ｾ･ｰ＠ Story 

n Story IME WAIT 
Run & Print Story 

,, ,, 
ｾ＠ '"' 

Clear Monitor 

2 i/•Story Last Line 0 ( 

- 11 

- -------

Action Keys 

After you have begun displaying your story using either 
the Run Story or the Step Story option, you can use the 
action keys to affect the flow of the story. 

Esc Stops the story and 
returns to the editing 
screen at the end of the 
current action. 

Shift-Esc Stops the story and 
returns to the editing 
screen immediately. 

Enter Executes the next line 
of the story when in 
Step Story mode. 

F5 When running in Run 
Story mode, switches to 
Step Story mode. 
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F6 When running in Step 
Story mode, switches to 
Run Story mode. 

FlO Freezes story playback; 
any key resumes. 

Space bar Skips current Wait 
period. 

Minus(-) Backs up the story to 
the nearest full (and not 
transparent) screen or 
the previous line with a 
period in the label field. 

Plus ( +) Resumes from where the 
story was backed up. 

Step Story 

This option allows you to view your story by stepping 
through part or all of it one story line at a time. The story 
begins with the command listed on the Story Editing Line. 
To step through your story: r\ 
1. Place the first story line you want to execute on the 

Story Editing Line by scrolling the Story Table up or 
down. 

2. Select Step Story from the Run menu. 

The story line executes. 

3. Press Enter to execute the next story line. 

4. Continue to press Enter to step through the pictures 
in the story. 
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Run Story 

This option allows you to view your story without any 
stops. The story begins with the command listed on the 
Story Editing Line and continues to the end. 

To use Run Story: 

1. Place the first story line you want to execute on the 
Story Editing Line by scrolling the Story Table up or 
down. 

2. Select Run Story from the Run menu. 

The story line executes and the story continues to the end. 

Run and Print Story 

This option allows you to view your story and print out 
the screen image any time a /PRINT command has been 
entered on a following story line. Wait periods are ignored 
when Story Editor is running in this mode. 

To use Run and Print Story: 

1. Place the first story line you want to execute on the 
Story Editing Line by scrolling the Story Table up or 
down. 

2. Select Run and Print Story from the Run menu. 

The story line executes and the story continues to the end, 
printing out the screen image whenever /PRINT com­
mands are encountered. 

If there is a marked block of lines, only the /PRINT com-
Ｑｾ＠ mands within the block will be executed. 
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Clear Monitor 

Selecting this option from the Run menu clears the 
current picture displayed on the Monitor. To use Clear 
Monitor, select Clear Monitor from the Run menu. 

Story Table 

The Story Table is the part of the screen where you 
choose which of the files created with Storyboard Plus 
will be used in your story and how they will be altered 
and presented. In the Story Table area there is one line 
which is highlighted. This line is referred to as the Story 
Editing Line. 

1 r 1 le Edit Modes Run I (C) IBH 1987 

NQ LABEL COMMAND 

Ｑｬｩ•ｊｲｫｾｾ［Ｎﾣｾｾｴｴ＾ｩ＼ＯＢＬ＠
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There are five main columns in the Story Table in which 
you can enter information. The information that can be 
entered in a column is displayed in menus similar to those 
in the Menu area of the Story Table screen. 

If you select the 320 x 200 or 640 x 200 mode, five story 
lines can be displayed in the Story Table. If you select the 
640 x 350 or 640 x 480 mode, eleven story lines can be dis­
played in the Story Table. 

When you select the /CLEAR, /COLOR, /DISPLAY, (\ 
/SHOW, or /MOVE SPRITE command, additional story 
table columns appear in the lower left-hand corner of the 
screen. The columns contain additional information that 
is used with these commands. 
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Scrolling Story Table Lines 

To modify a line in the Story Table, you must move it to 
the Story Editing Line. 

ｾ＠ To move a following story line to the Story Editing Line: 

1. Move the pointer to the lower part of the Story Table 
and press Button 1. 

The Story Table scrolls downward one line. 

2. Continue to press Button 1 as many times as neces­
sary to scroll to the story line you wish to modify. 

3. If you wish to scroll to the last line of a story, press 
Button 2. You can stop the story lines from scrolling 
at any time by pressing Button 2 again. 

To move a previous story line to the Story Editing Line: 

1. Move the pointer to the upper part of the Story Table 
and press Button 1. 

The Story Table scrolls upward one line. 

2. Continue to press Button 1 as many times as neces­
sary to scroll to the story line you wish to modify. 

3. If you wish to scroll to the first line of a story, press 
Button 2. You can stop the story lines from scrolling 
at any time by pressing Button 2 again. 

The following keys can be used to scroll the Story Table, 
regardless of the input device selected. 

PgUp Scrolls the previous five 
lines or the previous eleven 
lines of your story, 
depending on the resolution 
mode. 
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PgDn Scrolls the next five lines or 
the next eleven lines of 
your story, depending on 
the resolution mode. 

Home Goes to the first line of the 
story. 

End Goes to the last line of the 
story. 

Entering Information on a Story 
Line 

To enter information on a story line: 

1. Scroll the story until the story line you wish to modify 
is on the Story Editing Line. 

2. Move the pointer to the column of the Story Editing 
Line you want to enter information in, and then press 
Button 1. 

This opens the menu. 

3. To select an option, move the pointer to the item you 
want and press Button 1 again. 

This selects the option and closes the menu. 

4. To close the menu without selecting an option, move 
the pointer outside the menu and press Button 1. 
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LABEL Column 

The LABEL column allows you to identify each story line 
and control the flow of your story. Labels allow your 

ｾ＠ story to go to a specified line in the Story Table. 

When the /GOTO and /GOSUB commands are used to go 
to a story line, a label must identify that line. Refer to the 
/GOTO and /GOSUB commands for more information on 
the use of labels. 

I Fl le Edlt Modes Run I (C) ISM 1987 

ｾ｣＠ LABEL COMMAND PARAMETER TIME WAIT 

,, 
ｾ＠

2 ｾｾｴ＠ Label 1st Line 0 0 
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ｾ＠ Goto Label 
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ｾ＠ Input Label 

This option allows you to type a label of your choice in 
the LABEL column on the Story Editing Line. The label 
may consist of up to five characters and must not be a 
duplicate of any other label used in the story. To input a 
label: 

1. Place the line you wish to label on the Story Editing 
Line by scrolling the Story Table up or down. 

2. Select Input Label from the Label menu. 

3. At the blinking asterisk, type your label. 

Pressing any character key or the spacebar blanks out the 
current entry. If you want to edit the current entry, first 
use the -+key; then, use the +-, Insert, Delete, Spacebar, 
Backspace, or any character keys. 

4. Press Enter. 
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The label will appear in the LABEL column on the Story 
Editing Line. 

5. If you want to exit input mode without making a 
change, press Esc. 

No Label 

This option allows you to remove a label from the LABEL 
column on the Story Editing Line. To remove a label: 

1. Place the line you wish to remove a label from on the 
Story Editing Line by scrolling the Story Table up or 
down. 

2. Select No Label from the Label menu. 

The label will be removed. 

Goto Label 

This option allows you to immediately go to any labeled 
line in your story. 

To go to a labeled line: 

1. Select Goto Label from the Label menu. 

The Goto Label panel will appear. 

l Fl le Edit Modes Run I (c) IBM 1987 
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2. Move the pointer to the label for the line you want to 
go to and press Button 1. 

To scroll the Goto Label panel, move the pointer to the j 
and ! and press Button 1 . 

3. The story table will go to the line you chose. 

4. If you want to exit the Goto Label panel without 
making a selection, press Button 2. 

COMMAND Column 

The COMMAND column allows you to control the presen­
tation of your story. You determine the methods of 
display, colors, transition, timing, sound, and interaction. 
The commands you choose tell Story Editor what actions 
to perform on the story lines. 

Each command has it own parameters. To view a specific 
command's parameters, select the command, move the 
pointer to the PARAMETERS column, and press 
Button 1. Parameters will be discussed later in this 
chapter. 

I Fl le Edit Modes Run I (C) IBM 1!87 
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/IFNOT /SHOW 
/GOTO /MOVE SPRITE 
/GOSUB /SPEAK 
/RETURN /SOUND EFFECTS 
/INT /MUSIC ON 
/EXEC /MUSIC OFF 
/LOCK ON /PRINT 
/LOCK OFF /PALETTE 
/TELL 
/END 'Menu 1) 

(Menu 2) 
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The COMMAND column has two menus. To go back and 
forth from one menu to the other: 

1. Move the pointer to the COMMAND column of the 
Story Editing Line and press Button 1. 

2. Move the pointer into the Command menu and press 
Button 2. 

3. To return to the first Command menu, press Button 2 
again. 

4. To select a command from either menu, move the 
pointer to that command and press Button 1. 

Input Comment 

This command allows you to enter a comment into your 
story. This identifies what is occurring in your story on 
that particular line. If a command is entered on a story 
line, the comment will be entered next to the command. 

To input a comment: 

1. Place the line on which you want to insert a comment 
on the Story Editing Line by scrolling the Story Table 
up or down. 

2. Select Input Comment from the Command menu. 

3. At the blinking asterisk, type your comment. 

Pressing any character key or the spacebar blanks out the 
current entry. If you want to edit the current entry, first 
use the --+ key; then, use the ｾＮ＠ Insert, Delete, Spacebar, 
Backspace, or any character keys. 

4. Press Enter. 

The comment you entered will appear on the Story 
Editing Line in the COMMAND column next to the*. 
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5. If you want to exit input mode without making a 
change, press Esc. 

/* 
ｾ＠ This command allows you to remove the command cur­

rently on a story line but leave any comments that may be 
entered. This deactivates the story line. 

To deactivate a story line: 

1. Place the line on which you wish to insert the /* on 
the Story Editing Line by scrolling the Story Table up 
or down. 

2. Select /* from the Command Menu. 

A/* will be inserted at the beginning of the COMMAND 
column on the Story Editing Line. 

ｾ＠ /CLEAR 

Use this command to clear all or part of the picture dis­
played on the screen. In 320 x 200 - 4 Color Mode, one of 
four colors may be used. In all other modes, one of sixteen 
colors may be used to clear the picture. If no color is spec­
ified, black is used. You determine which color will be 
used when you enter the parameter information. 

/CLEAR can be used with display method NONE in order 
to alter one or more partial picture areas before any 
action is seen on the screen. The altered screen can be dis­
played by using the /DISPLAY command on a following 
line in the table. 

When you select /CLEAR, a panel of additional columns 
is displayed in the lower left-hand corner of the Story 
Table screen. The functions you choose in these columns 
determine how the /CLEAR command will be executed. 
Refer to "Additional Story Table Columns" in this chapter 
for detailed information. 
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To use the /CLEAR command: 

1. Place the line on which you wish to enter the /CLEAR 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /CLEAR from the Command menu. 

3. Enter the necessary information in the P ARAME­
TERS, TIME, and WAIT columns. 

4. Enter the necessary information in the Additional 
Story Table columns. 

The only parameter for this command is Get Color. 

/COLOR 

This command changes the color of all or part of the 
picture displayed on the screen. The picture on the screen 
is not removed, but a specified color is changed to another 
color. You may also change two colors with one /COLOR .r-'\ 
command by selecting Get 2 Colors in the PARAMETERS 
column. 

You determine which colors will be changed with the 
information you enter in the PARAMETERS column. In 
320 x 200 - 4 color mode, one of four colors may be used to 
color the picture. In all other modes, one of sixteen colors 
may be used to color the picture. If you wish to change 
additional colors in a picture, you may put /COLOR com­
mands on subsequent story lines. 

/COLOR can be used with display method NONE in order 
to alter one or more partial picture areas before any 
action is seen on the screen. The altered screen can be dis­
played by using the /DISPLAY command on a following 
line in the table. 

If incomplete parameter information is entered, the 
/COLOR command will be ignored. 
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When you select /COLOR, a panel of additional columns 
is displayed in the lower left-hand corner of the Story 
Table screen. The functions you choose in these columns 
determine how the /COLOR command will be executed. 
Refer to "Additional Story Table Columns" in this chapter 
for detailed information. 

To use the /COLOR command: 

1. Place the line on which you wish to enter the /COLOR 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /COLOR from the Command menu. 

3. Enter the necessary information into the PARAME­
TERS, TIME, and WAIT columns. 

4. Enter the necessary information into the Additional 
Story Table columns. 

Parameters for this command are: 

• Get 1 Color 
• Get 2 Colors. 

/DISPLAY 

This command is used to choose a Picture Maker, Picture 
Taker, or Text Maker file and display it. You can display 
all or part of the file. The file name is entered in the 
PARAMETERS column. 

Once a picture is displayed on the screen using the 
/DISPLAY command, it will remain on the screen until 
another command removes it. You can alter the picture by 
using /CLEAR ,/COLOR, /SHOW, and /DISPLAY com-

ｾ＠ mands on subsequent story lines. 

If you select /DISPLAY and no filename is entered in the 
PARAMETERS column, the program will display the 
image in the preview area. 
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When you select /DISPLAY, a panel of additional columns 
displays in the lower left-hand corner of the Story Table 
screen. The functions you choose in these columns deter­
mine how the /DISPLAY command will be executed. 
Refer to "Additional Story Table Columns" in this chapter 
for detailed information. 

To use the /DISPLAY command: 

1. Place the line on which you wish to enter the 
/DISPLAY command on the Story Editing Line by 
scrolling the Story Table up or down. 

2. Select /DISPLAY from the Command menu. 

3. Enter the necessary information in the P ARAME­
TERS, TIME, and WAIT columns. 

4. Enter the necessary information in the Additional 
Story Table columns. 

Parameters for this command are: 

• Get Existing Name 
• Input Name 
• View Picture. 

/SHOW 

This command is used to choose a Picture Maker, Picture 
Taker, or Text Maker file and display it. You can display 
all or part of the file. The file name is entered in the 
PARAMETERS column. However, unlike the /DISPLAY 
command, once your story goes to the next story line, the 
picture is removed from the screen. 

If you select /SHOW and no filename is entered in the 
PARAMETERS column, the program will display the 
image in the preview area. 

When you select /SHOW, a panel of additional columns 
displays in the lower left-hand corner of the Story Table 
Screen. The functions you choose in these columns deter-
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mine how the /SHOW command will be executed. Refer to 
"Additional Story Table Columns" in this chapter for 
detailed information. 

/SHOW is also used to create animation sequences. To 
create animation sequences, refer to "Creating Animation 

ｾ＠ Sequences" in this chapter. 

The only valid display method for /SHOW is FADE. 

To use the /SHOW command: 

1. Place the line on which you wish to enter the /SHOW 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /SHOW from the Command menu. 

3. Enter the necessary information in the P ARAME­
TERS, TIME, and WAIT columns. 

4. Enter the necessary information in the Additional 
Story Table columns. 

Parameters for this command are: 

• Get Existing Name 
• Input Name 
• View Picture. 

/MOVE SPRITE 

Use this command to move a sprite from one area of the 
screen to another or to move a sprite onto the screen from 
off the screen. Several sprite files are supplied with 
Storyboard Plus. They are: 

GLOBE.SPR. 
MAN.SPR 
WOMAN.SPR 

You choose the sprite you want to use and enter that file 
name in the PARAMETERS column. 
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Parameters for /MOVE SPRITE are: 

• Get Existing Name (This will be the name of the sprite 
file you want to use.) 

• Input Name. 

To use the /MOVE SPRITE command: 

1. Place the line on which you wish to enter the /MOVE 
SPRITE command on the Story Editing Line by 
scrolling the Story Table up or down. 

2. Select /MOVE SPRITE from the Command menu. 

3. Enter the necessary information in the PARAME­
TERS, TIME, and WAIT columns. 

4. Enter the necessary information in the additional 
$tory table columns. (A description of these columns 
immediately follows this command's instructions.) 

When you select /MOVE SPRITE, a panel of additional 
story table columns used only with this command displays. r-.,, 
These columns are used to enter additional information to 
control the movement of the sprite. Under the column 
headings is a highlighted line. This can be considered an 
extension of the Story Editing Line. 

SPRITE ACTION 
Pointing Right 

COLOR DIR POSITION 
YES RIGHT 45- 63 

Current Story Drive\Path 

The additional columns are: 

• SPRITE ACTION 
• COLOR (No options can be selected.) 

5-40 



• DIR 
• POSITION. 

To select an option from these columns: 

1. Move the pointer to the column from which you wish 
ｾ＠ to select an option. 

2. Press Button 1. 

The menu will open. 

3. To select an option, move the pointer to that option 
and press Button 1. 

Note: If you selected the keyboard as your input device, 
press the Tab key to move the pointer to these columns. 

SPRITE ACTION 

This column provides options that determine the sprite's 
action when movement across the screen ends. The 
options in this column will vary depending on the sprite 
being used. 

To choose a sprite action, select an option from the 
SPRITE ACTION menu. 

DIR 

This column provides options that specify from which 
edge of the screen the sprite will appear as it begins move­
ment to the location you chose. The direction options are : 

• Right 
• Left 
• Top 

r-"\ • Bottom. 

To choose a direction, select an option from the DIR 
menu. 
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POSITION 

This column provides options that set the final position of 
the sprite on the screen. Four methods are available for 
entering the sprite's position: 

• Set on Monitor 

• Set on Full Screen 

• Input Position 

• Go to Background . 

Using Set on Monitor and Set on Full 
Screen 

This option allows you to use a select box to determine 
the location where you want a sprite displayed. 

To set the sprite's position on the screen using this option: 

1. Select Set on Monitor or Set on Full Screen from 
the Position menu. 

A select box will appear in the Monitor area of the Story 
Table screen with the last picture listed in the PARAME­
TERS column as background. If a /CLEAR command was 
used to clear the last picture, the background will be 
black. 

2. Move the pointer inside the select box and press 
Button 1. · 

Note: If you selected the keyboard as your input 
device, you move the pointer in the monitor or full 
screen areas using the cursor movement keys. The 
pointer will move in 4 pixel increments in the 320 x 200 
resolution modes and 8 pixel increments in all other 
resolution modes. To move the pointer in 1 pixel incre­
ments, press Shift and the cursor movement keys. 

You can now move the select box to the location on the 
screen where you want the sprite displayed when move­
ment ends. 
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3. When you have the select box in the position you 
want, press Button 2. 

The coordinates in the POSITION column of the Story 
Table change to reflect the sprite's position. 

Using Input Position 

This option can be used to type actual coordinates for the 
location of a sprite. 

In the Position column of the table, Story Editor accepts 
coordinates in 4 pixel increments on the X-axis in the 320 
x 200 modes. Story Editor accepts coordinates in 8 pixel 
increments on the X-axis, in all other resolution modes. If 
values not matching the 4 or 8 pixel increments are 
entered, Story Editor will round them up or down as 
shown in the following table. 

Resolution Position 
Mode X Value 

320 x 200 Rounds to 
next lowest 
odd pixel 
(i.e. 1, 5, 9, 
... 317). 

640 x 200, Rounds to 
640 x 350, next lowest 
640 x 480 odd pixel 

(i.e. 1, 9, 17, 
... 653). 

Story Editor accepts coordinates in 1 pixel increments on 
the Y-axis. 

To type in the sprite coordinates: 

ｾ＠ 1. Select Input Position from the Position menu. 

2. At the blinking asterisk, type the coordinates of the 
location where the sprite should be displayed. 

5-43 



The Tab and Shift-Tab keys will move the blinking 
asterisk between the input coordinates. Pressing any 
number key will only blank out the area where the 
blinking asterisk is located. 

3. Press Enter to set the coordinates. 

The coordinates will be entered in the the POSITION 
columns. 

4. If you want to exit input mode without making a 
change, press Esc. 

Using Go To Background 

Selecting this option will change the sprite to the back­
ground color of the next picture displayed. This is how 
the sprite is removed from the screen. To remove the 
sprite from the screen, select Go To Background from 
the Position menu. 

/SPEAK 

This command is used to play back the files created when 
you select Record Voice from the File menu. The picture 
currently displayed on the screen will remain while the 
file you choose in the PARAMETERS column plays back. 
Once the voice file is executed, the story proceeds to the 
next line. 

You must have either the IBM Voice Communications 
Option or the IBM Personal System/2 Speech Adapter 
installed along with a microphone and speaker in order to 
use this option. 

If you are using the IBM Voice Communications Option, 
you must run VOICE.BAT before starting Story Editor. 
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Also, the following files must either be in the directory 
with Story Editor or be accessed using the DOS PATH or 
APPEND commands: 

VCAPIDRV.COM VOOTPC.AIC 
APIDIR.AIC VllNSP.AIC 
BASEPC.AIC VlOTSP.AIC 
BASESP.AIC V20TSP.AIC 
BATCMD.AIC V30TPC.AIC 
VOINSP.AIC V 40TSP.AIC 

To use the /SPEAK command: 

1. Place the line on which you wish to enter the /SPEAK 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /SPEAK from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• Get Existing Name 
• Input Name. 

/SOUND EFFECTS 

This command is used to play back sound effects files. 
The picture currently displayed on the screen will remain 
while the file you choose in the PARAMETERS column 
begins to play. The story then proceeds to the following 
lines while the sound effect is played. Once the sound 
effects file is executed, it will not repeat. 

You must have the IBM Music Feature installed along 
with a speaker in order to use this option. You also must 
run the KAPl.EXE file before you start Story Editor. You 
cannot create sound effects files with this command, only 
play them back. 
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Several sound effects files are supplied with Storyboard 
Plus. These are: 

ALARM.ESQ 
BIG BEN.ESQ 
DRUMS.ESQ 
PHONE.ESQ 
WATER.ESQ 

BEACH.ESQ 
CHOPPER.ESQ 
KNOCK.ESQ 
RACING.ESQ 
WHISTLE.ESQ 

To use the /SOUND EFFECTS command: 

1. Place the line on which you wish to enter the /SOUND 
EFFECTS command on the Story Editing Line by 
scrolling the Story Table up or down. 

2. Select /SOUND EFFECTS from the Command menu. 

3. Enter the necessary information into the P ARAME­
TERS column. 

Parameters for this command are: 

• Get Existing Name 
• Input Name. 

/MUSIC ON 

This command is used to play back music files. The 
picture currently displayed on the screen will remain 
while the file you choose in the PARAMETERS column 
begins to play. The story then proceeds to the following 
lines while the music plays. Should the music file com­
plete before the story is ended, the music file repeats. To 
turn the music off before the end of the story, the /MUSIC 
OFF command must be entered on a story line. 

You must have the IBM Music Feature installed along 
with a speaker in order to use this option. You also must 
run the KAPI.EXE file before you start Story Editor. You 
cannot create music files with this command, only play 
them back. 
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Several music files are supplied with Storyboard Plus. 
These are: 

BLUES.ESQ 
ROCK.ESQ. 
POP.ESQ 

!""., JAZZ.ESQ 

To use the /MUSIC ON command: 

1. Place the line on which you wish to enter the /MUSIC 
ON command on the Story Editing Line by scrolling 
the Story Table up or down. 

2. Select /MUSIC ON from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• Get Existing Name 
• Input Name. 

/MUSIC OFF 

This command is used to end execution of a music file 
started with a /MUSIC ON command. 

To use the /MUSIC OFF command: 

1. Place the line on which you wish to enter the /MUSIC 
OFF command on the Story Editing Line by scrolling 
the Story Table up or down. 

2. Select /MUSIC OFF from the Command menu. 

There are no parameters for this command. 
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/PRINT 

This command is used with the Run & Print Story function 
from the Run menu. Anytime you want to print a screen, enter 
/PRINT on the story line that follows the display of that 
screen. 

When you select Run and Print Story, screens you select will 
be printed as the story is run. Any information in the TIME 
and WAIT columns will be ignored, and the story will proceed 
as rapidly as possible, stopping only to print the pictures you 
specify. A form feed will occur after each picture is printed. 
The /PRINT command will be ignored when Step Story and 
Run Story are selected. /PRINT is always ignored in Story 
Teller. 

To use the /PRINT command: 

1. Place the line on which you wish to enter the /PRINT 
command on the Story Editing Line by scrolling the Story 
Table up or down. 

2. Select /PRINT from the Command menu. 

3. Enter the necessary information in the PARAMETERS ｾ＠
column. 

Hint: If the quality of the printed picture is unsatisfactory 
when using a black and white printer, try printing the picture 
in the Picture Maker module using the Patterns option. 

Parameters for this command are: 

• Normal 
• Turn Page. 

/PALETTE 

This command is valid when you are using 320 x 200 - 4 color 
resolution mode. It will appear on the Command menu when 
this mode is used. This command should be on the line before ｾ＠
a file is displayed. 

This command allows you to change the color palette that is 
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used when the picture is displayed. The palette colors set with 
this command will remain in effect until another /PALETTE 
command is entered. 

To use the /PALETTE command: 

1. Place the line on which you wish to enter the /PALETTE 
command on the Story Editing Line by scrolling the Story 
Table up or down. 

2. Select /PALETTE from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• Get Palette Colors 
• Get Background Color 
• Use PM Palette. 

/INPUT 

ｾ＠ This command allows your story to read input from the 
keyboard. The number of keystrokes needed before the story 
continues is specified in the PARAMETERS column. 

If parameter information is not entered, one keystroke is 
assumed. If 0 (no wait) is chosen, the /INPUT command does 
not wait for a keystroke; however, if a keystroke is entered, it 
is read as input. If the Enter key is pressed before any other 
keys have been pressed, the story will continue. 

The /INPUT command is used to designate how many 
keystrokes are required before the story continues. The /IF and 
/IFNOT commands can be used on following story lines to 
determine how the story should proceed if a designated key is 
pressed. 
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To use the /INPUT command: 

1. Place the line on which you wish to enter the /INPUT 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /INPUT from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• 0 (no wait) 
• 1 keystroke 
• Input Number. 

/IF 

After an /INPUT command, an /IF command can be 
entered on a following story line to determine how the 
story should proceed if a specific key is pressed. r-'\ 

If the characters input while the story is being run match 
the characters specified in the /IF command, the story will 
branch to the line or subroutine with the label entered in 
the PARAMETERS column or end if the END parameter 
is specified. 

To use the /IF command: 

1. Place the line on which you wish to enter the /IF 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /IF from the Command inenu. 

A blinking asterisk will appear in the COMMAND column 
next to the /IF command. ｾＧ＠

3. Enter the key(s) you want the story viewer to press or 
the$ key to accept any keystroke and press Enter. 
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The maximum number of keystrokes that can be entered is 
15. 

4. Enter the necessary information in the PARAMETERS 
column. 

Ｑｾ＠ Parameters for this command are: 

• GOTO Label 
• GOSUB Label 
• END. 

/IFNOT 

After an /INPUT command, the /IFNOT command can be 
entered on a following story line to determine how the 
story should proceed if a specific key is not pressed. 

If the characters input while the story is being run do not 
match the characters specified in the /IFNOT command, 
the story can branch to the line or subroutine entered in 
the PARAMETERS column or end if the END parameter 
is specified. 

To use the /IFNOT command: 

1. Place the line on which you wish to enter the /IFNOT 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /IFNOT from the Command menu. 

A blinking asterick will appear in the COMMAND 
column next to the /IFNOT command. 

3. Type any key(s) you want to prevent the /IFNOT story 
line from being executed, and press Enter. 

ｾ＠ The maximum number of keystrokes that can be enter.ed is 
15. 

If you specify the$ key, the story can continue running 
until any key is pressed. 

5-51 



4. Enter the necessary information into the P ARAME­
TERS column. 

Parameters for this command are: 

• GOTO Label 
• GOSUB Label 
• END. 

/GOTO 

This command is used to go to a specified story line. 
/GOTO is commonly used to go back to the beginning of a 
story so that the story will run continuously or to go back 
to a story menu screen. 

To use the /GOTO command: 

1. Place the line on which you wish to enter the /GOTO 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /GOTO from the Command menu. 

3. Enter the necessary information into the P ARAME­
TERS column. 

Parameters for this command are: 

• Get Existing Label 
• Input Label. 

/GOSUB 

This command is used to start a subroutine beginning 
with the line you choose in the PARAMETERS column. 
The subroutine will continue until a /RETURN command 
is found. The /RETURN command will cause the story to ｾＮ＠

return to the story line that follows the /GOSUB 
command. 
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To use the /GOSUB command: 

1. Place the line on which you wish to enter the /GOSUB 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

ｾＮ＠ 2. Select /GOSUB from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• Get Existing Label 
• Input Label. 

/RETURN 

This command causes the story to return to the line that 
follows the last /GOSUB command executed. 

To use the /RETURN command: 

1. Place the line on which you wish to enter the 
/RETURN command on the Story Editing Line by 
scrolling the Story Table up or down. 

2. Select /RETURN from the Command menu. 

There are no parameters for this command. 

/INT 

This command is used to access a DOS-resident .COM 
program through a specified software interupt. It must be 
loaded before Story Editor or Story Teller is started. The 
.COM program must return to the interrupted.program;· 

ｾ＠ DOS reserves interrupts 60 through 67 for user software. 
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To use the /INT command: 

1. Place the line on which you wish to enter the /INT 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /INT from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

The only parameter for this command is Input Parameters. 

/EXEC 

This command is used to exit your story, connect to DOS, 
call another DOS program, execute it, and return to the 
story line following the /EXEC command. The name of the 
.EXE or .COM file you want to execute is entered in the 
PARAMETERS column. 

DOS resident programs cannot be executed with the 
/EXEC command. 

To use the /EXEC command: 

1. Place the line on which you wish to enter the /EXEC 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /EXEC from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• Get Existing Name 
• Input Name. 
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/LOCK ON 

This command disables all keys on the keyboard (except 
/INPUT values). It is useful when your story is run unat­
tended, because it prevents someone from interrupting the 

r"""""\ story. 

To use the /LOCK ON command: 

1. Place the line on which you wish to enter the /LOCK 
ON command on the Story Editing Line by scrolling 
the Story Table up or down. 

2. Select /LOCK ON from the Command menu. 

There are no parameters for this command. 

/LOCK OFF 

This command enables all keys following a /LOCK ON 
command. 

To use the /LOCK OFF command: 

1. Place the line on which you wish to enter the /LOCK 
OFF command on the Story Editing Line by scrolling 
the Story Table up or down. 

2. Select /LOCK OFF from the Command menu. 

There are no parameters for this command. 

/TELL 

This command is used to branch the current story to 
another story, using any specified drive and path, and 
start the new story. The specified drive and path also set 
the drive and path for all the files in the new story. 

This command is entered in Story Editor, but only oper­
ates with Story Teller. This command is normally used to 
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chain together two or more stories for a large presenta­
tion. It can also be used to combine stories that were 
created in different resolution modes. 

The number of lines you can have in your story will vary, 
depending on the number of labels, comments, and direc-
tory locations of the files used by your story. On average, ('\ 
a story can contain 450 story lines. 

To use the /TELL command: 

1. Place the line on which you wish to enter the /TELL 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /TELL from the Command menu. 

3. Enter the necessary information in the PARAMETERS 
column. 

Parameters for this command are: 

• Get Existing Name 
• Input Name. 

/END 

Use this command to stop the story immediately. This 
command is commonly used with story menus where one 
of the choices is to end the story. It is also used as the last 
line in a story to separate the story from any subroutines 
that may follow. To use the /END command: 

1. Place the line on which you wish to enter the /END 
command on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select /END from the Command menu. 

There are no parameters for this command. 
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PARAMETERS Column 

The PARAMETERS column allows you to enter addi­
tional command information. Once you have entered a 
command on a story line, you can select the parameter 
information from the Parameter menu. 

Pressing F3 will enter the filename from the column above 
if the same command is used and the Parameter menu is 
not opened. Pressing Shift-F3 will blank out the PARAM­
ETERS column. 

Get Color 

Get Color is a parameter for the /CLEAR command. It is 
used to select the color with which you clear all or part of 
the screen. 

I F1 le Edit Modes Run I (C) IBM 1987 

Na LABEL COMMAND PARAMETERS TIME WAIT 

I 
I I Ａ Ｑ ｩ Ｑ ｩＱｬｾｩｴｩｩｩｬ＠

21 /•Story Last Line Get Color 0 0 

-

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Get Color from the Parameter menu. 

The Get Color Panel will display. 
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I ｾ＠ l 1e Edit Modes Run I (c) JBM 1987 

\Ir LABEL Get Color PARAMETERS TIME WAIT 
1 
2 

"'""' 1m11m1111tmmu1 i!!l!HI 3 llllllil .!Ulllliil1 " I 
.:.d! ... 

' im11iE llTml' 

2 I• 4 0 ( 

-...... - 5 -- - -./ - 6 
7 
8 
g 

10 
11 
12 
13 
14 
15 
16 

3. Move the pointer to the color you want and press 
Button 1. 

The color reference number will be entered in the 
PARAMETERS column. 

Note: You will get a choice of only sixteen colors in the 
resolution modes that support sixteen or more colors. In 
320 x 200 - 4 color resolution mode, you will get a choice 
of only four colors. 

Get 1 Color 

Get 1 Color is a parameter for the /COLOR command. It 
allows you to choose a color on the screen to replace with 
another color of your choice. You can replace a color on 
all or part of the screen. 

I Fl le Edit Modes Run I ( C) IBM 1987 ' 
ｾﾷ＠ LABEL COMMAND PARAMETERS TIME WAIT 

""" mnmmj ＡＡＡｾｬｾｬｪｈ＠ ·! 1 i' I ii11J11 ,mmm1i1.m . ﾷｾ＠
2 /•Story Last Line Get 1 Color 0 0 

Get 2 Colors 

-
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To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

ｾ＠ 2. Select Get 1 Color from the Parameter menu. 

The From Color Panel will display. 

I t- e Edit Modes Run I (C) IBM 1987 

ｾ＠ To c From Color PARAMETERS TIME WATT 
ｾ＠ 1 

1,._ 
2 

II' 2,._ 
3 !, '. 'il!ttf!ib li!IJI ＧｩｩＡｩＡｩＡＧＮＱｾＱＱ＠

2 3_ 4 0 ( 
4 - 5 ....... 
5 ｾ＠ ...___/ - 6 -
6_ 

7 
7_ 

8 a,__ 
9 

9,__ 10 
10,._ 

11 
11,._ 12 
12,._ 

13 
13,._ 

14 
14 

15 15-
16- 16 

Menu 2 
Menu 1 

3. Move the pointer to the color you want to replace and 
press Button 1. 

The color reference number will be entered in the 
PARAMETERS column and the To Color Panel will 
display. 

4. Move the pointer to the new color you want and press 
Button 1. 

The color reference number will be entered in the 
PARAMETERS column. 

Note: You will get a choice of only sixteen colors in the 
resolution modes that support sixteen or more colors. In 
320 x 200 - 4 color resolution mode, you will get a choice 
of only four colors. 
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Get 2 Colors 

The Get 2 Colors parameter performs the same function as 
Get 1 Color, but you can change two colors and use only 
one story line. You select one set of colors from the color 
panels, then you select the other. The From Color and To (\ 
Color panels will appear twice. 

To use this parameter, select Get 2 Colors from the 
Parameter menu. Refer to "Get 1 Color'' for help in 
selecting colors from the From Color and To Color panels. 

Get Existing Name 

Get Existing Name is used to select the Storyboard Plus 
files you want to use with a command. This parameter 
allows you to retrieve a Storyboard Plus file previously 
saved on a disk. 

Flle Edit Modes Run I (C) IBM 1987 

Nl LABEL COMMAND PARAMETERS TIME IWAIT 

Ii 'hMnl 111!ili1ii1illffil ,, 
11 1 '·! I I 

2 '/•Story Last Line Get Existing Name 0 ( 
Input Name 
View Picture 

ｾ＠-

Get Existing Name is a parameter for the following 
commands: 

• DISPLAY 

• SHOW 

• MOVE SPRITE 

• SPEAK 

• SOUNP EFFECTS 

• MUSIC ON 

• EXEC 

• TELL . 
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To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

ｾ＠ 2. Select Get Existing Name from the Parameter menu. 

The File Services menu will appear. 

3. Select the file you want to use. (If you need help using 
the File Services panel, see "File Services Panel" in 
this chapter.) 

The File Services panel closes and the file name is entered 
in the PARAMETERS column. 

If you select a file that has more than one image saved 
under the filename and the /DISPLAY or /SHOW 
command has been selected, the Get Capture File panel 
will display. 

Get Capture File Panel 

If you select a file name that has more than one image 
saved under the filename (usually with a .CAP or .LIB 
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extension), the Get Capture File Panel will display. You 
can then select a specific image in the file to get. 

1 e Edit Modes Run 

A 

c 

EDIT 

cc Memory Used OS 

There are three options on the Get Capture File Panel: 

• Get Picture 
• View Picture 
• Exit. 

Using Get Picture 

Select Get Picture to get an image. 

To get an image: 

1. Place the pointer on the image you want to get and 
press Button 1. 

That image is now highlighted. If you have more images 
than display, move the pointer to the! box on the right of 
the filename column and press Button 1 to see the other 
images. Continue pressing Button 1 until you find the Ｎｾ＠

correct image. You can see previous images by moving the 
pointer to the j box and pressing Button 1. 
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2. When you have highlighted the image you want to get, 
move the pointer to Get Picture and press Button 1. 

The Get Capture File panel closes and your filename and 
image number appear in the PARAMETERS column. 

Using View Picture 

Select View Picture to preview images. 

To view an image: 

1. Position the pointer on the image you want to view 
and press Button 1. 

2. Move the pointer to View Picture and press 
Button 1. 

Note: Text files can display only on a full screen. If 
Monitor mode is selected, the text image will still 
display on the full screen. 

To view all of the images in a file: 

3. After the first image is displayed, press Button 1 to 
display the second. Continue this procedure until each 
image in the captured file has been displayed. 

4. Press Button 2 to return to the Get Capture File 
panel. 

Exiting the Get Capture File Panel 

To exit the Get Capture File Panel without making a 
selection, move the pointer to Exit and press Button 1. 
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Input Name 

Using the Input Name parameter is another way to select 
the Storyboard Plus file you want to use with a command. 
This parameter allows you to type a filename directly into 
the Parameter column without having to use the File Ser- ｾ＠
vices menu. 

Input Name is a parameter for the following commands: 

• DISPLAY 
• SHOW 
• MOVE SPRITE 
• SPEAK 
• SOUND EFFECTS 
• MUSIC ON 
• EXEC 
• TELL. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Input Name from the Parameter menu. 

3. At the blinking asterisk, type the filename. 

Pressing any character key or the spacebar blanks out the 
current entry.If you want to edit the current entry, first 
use the --+key; then, use the ｾＮ＠ Insert, Delete, Spacebar, 
Backspace, or any character keys. To enter a file exten­
sion, type a . , and then the extension. To enter the refer­
ence number for a captured file, type a - , and then the 
reference number. 

4. Press Enter. 

The picture name is entered in the PARAMETERS 
column. 
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5. If you want to exit input mode without making a 
change, press Esc. 

View Picture 

Ｎｾ＠ This parameter allows you to view a file in the monitor 
area or on the full screen, depending on the option 
selected. Once you have entered a filename in the 
PARAMETERS column, you can select this option to see 
the image contained in the file. This is helpful when you 
are not certain that you have selected the correct file. 

Viewing a file in this manner does not alter the informa­
tion on the Story Editing Line. 

View Picture is a parameter for the following commands: 

• Display 
• Show. 

To use this parameter: 

1. Place the line you wish to view on the Story Editing 
Line by scrolling the Story Table up or down. 

2. Select View Picture from the Parameter menu. 

The picture will be displayed in the Monitor area or on 
the full screen, depending on which option is selected. 

3. If you are viewing the picture on the full screen, press 
Button 1 to exit View Picture mode. 
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Normal 

Normal is a parameter for the /PRINT command. It is 
used to select the direction the screen image will print on 
the paper. This parameter will cause the image to be 
printed vertically. 
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To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select NORMAL from the Parameter menu. 

NORMAL will be entered in the PARAMETERS column. 

Turn Page 

Turn Page is a parameter for the /PRINT command. It is 
used to select the direction the screen image will print on 
the paper. This parameter will cause the image to be 
rotated 90 degrees and printed horizontally. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select TURN PAGE from the Parameter menu. 

TURN PAGE will be entered in the PARAMETERS 
column. 
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Get Palette Colors 

Get Palette Colors is a parameter for the /PALETTE 
command. It is used to select a color palette when using 
the 320 x 200 - 4 color resolution mode. 

Palette 1 contains white, cyan, and magenta. Palette 2 
contains yellow, green, and red. 

You must enter both a palette and a background color. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Get Palette Colors from the Parameter menu. 

The Get Palette panel will appear. 
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ｾ＠ 3. Select either Palette 1 or Palette 2 and press 
Button 1. 

1 or 2 will be entered in the PARAMETERS column. 
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Get Background Color 

Get Background Color is a parameter for the /PALETTE 
command. It is used to select a background color for the 
files you display when using the 320 x 200 - 4 color resol­
ution mode. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Get Background Color from the Parameter 
menu. 

The Background Color panel will appear. 
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3. Select a background color and press Button 1. 

The background color name will be entered in the 
PARAMETERS column along with the palette number. 
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Use PM Palette 

Use PM Palette is a parameter for the /PALETTE 
command. It tells Story Editor to use the color palette 
that was used when the picture file was created in Picture 
Maker. This parameter is valid only in the 320 x 200 - 4 
color resolution mode. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling text 
up or down. 

2. Select Use PM Palette from the Parameter menu. 

PM PALETTE will be entered in the PARAMETERS 
column. 

0 (No Wait) 

ｾＮ＠ 0 (no wait) is a parameter for the /INPUT command. It 
allows input from the keyboard to be read without stop­
ping the story. 
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To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select 0 (no wait) from the Parameter menu. 

0 will be entered in the PARAMETERS column. 
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1 Keystroke 

1 keystroke is a parameter for the /INPUT command and 
also the default value if parameter information is not 
entered. This parameter tells the story to halt until one 
keystroke is input from the keyboard. To use this 
parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select 1 keystroke from the Parameter menu. 

1 will be entered in the PARAMETERS column. 

Input Number 

Input Number is a parameter for the /INPUT command. 
This parameter tells the story to halt until the number of 
keystrokes you choose is input from the keyboard. 15 is (\. 
the maximum number of keystrokes that can be entered. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Input Number from the Parameter menu. 

A blinking asterisk will appear in the PARAMETERS 
column. 

Pressing any character key or the spacebar blanks out the 
current entry.If you want to edit the current entry, first 
use the--+ key; then, use ｴｨ･ｾＮ＠ Insert, Delete, Spacebar, (\ 
Backspace, or any character keys. 

3. Type the number of keystrokes you want the viewer to 
enter before the story continues. 
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4. Press Enter. 

The number will appear in the PARAMETERS column. 

5. If you want to exit input mode without making a 
change, press Esc. 

Note: Pressing Enter will cause the story to continue, 
regardless of the number entered. 

GOTO Label 

GOTO Label is used to tell the story to go to a story line 
with the label you select. This will occur if the input from 
the keyboard matches the input required by the command. 
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GOTO Label is a parameter for the following commands: 

• IF 
• IFNOT. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select GOTO Label from the Parameter menu. 

A blinking asterisk will appear in the PARAMETER 
column next to GOTO. 

5-71 



3. If you wish to type in a line label, continue with the 
next step. If you wish to select a label from the Get 
Label panel, go to Step 6. 

4. Type the label for the line you want to go to. 

5. Press Enter. 

The label will appear in the PARAMETERS column. 

6. To select a label from the Get Label panel, press F2. 

7. Move the pointer to the label for the line you want to 
go to and press Button 1. 

8. To scroll through the Get La:bel panel, move the 
pointer to the j and ! and press Button 1. 

The label will appear in the PARAMETERS column. 

9. If you want to exit the Get Label Panel without 
making a selection, press Button 2. 

GOSUB Label 

GOSUB Label is used to tell the story to go to a story sub­
routine beginning on the line with the label you select. 
This will occur if the input from the keyboard matches the 
input required by the command. After the subroutine is 
ended with a /RETURN command, the story will continue 
with the line that follows the GOSUB Label parameter. 

GOSUB Label is a parameter for the following commands: 

• IF 
• IFNOT. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on to the Story Editing Line by scrolling 
the Story Table up or down. 
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2. Select GOSUB Label from the Parameter menu. 

A blinking asterisk will appear in the PARAMETER 
column. 

3. If you wish to type in a subroutine label, continue 
ｾ＠ with the next step. If you wish to select a label from 

the Get Label Panel, go to Step 6. 

4. Type the label for the subroutine you want to go to. 

5. Press Enter. 

The label will appear in the PARAMETERS column. 

6. To select a label from the Get Label panel, press F2. 

7. Move the pointer to the label for the line you want to 
go to and press Button 1. 

8. To scroll through the Get Label panel, move the 
pointer to the j and Ls and press Button 1. 

The label will appear in the PARAMETERS column. 

9. If you want to exit the Get Label panel without 
making a selection, press Button 2. 

END 

END is used to tell the story to end if the input from the 
keyboard matches the input required by the command. 

END is a parameter for the following commands: 

• IF 
• IFNOT . 

. ｾ＠ To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 
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2. Select END from the Parameter menu. 

END will appear in the PARAMETERS column. 

Get Existing Label 

Get Existing Label is used to tell the story to branch to a 
story line with the label you select. You select the label 
from a panel containing all the line labels used in your 
story. If there are more labels than can be shown on one 
panel, the panel can be scrolled. 
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Get Existing Label is a parameter for the following 
commands: 

• GOTO 
• GOSUB. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Get Existing Label from the Parameter menu. 

The Get Label Panel will appear, containing the story line 
labels. 
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3. Move the pointer to the label you want and press 
Button 1. 

4. To scroll through the Get Label panel, move the 
pointer to the j and i and press Button 1. 

The label will appear in the PARAMETERS column. 

5. If you want to exit the Get Label Panel without 
making a selection, press Button 2. 

Input Label 

Input Label is used to tell the story to branch to a story 
line with the label you select. You enter the line label by 
typing it directly into the PARAMETERS column. 

Input Label is a parameter for the following commands: 

• GOTO 
• GOSUB. 

To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 

ｾ＠ Story Table up or down. 

2. Select Input Label from the Parameter menu. 
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A blinking asterisk will appear in the PARAMETERS 
column. 

Pressing any character key or the spacebar blanks out the 
current entry.If you want to edit the current entry, first 
use the --+ key; then, use the ｾＬ＠ Insert, Delete, Spacebar, 
Backspace, or any character keys. ｾ＠

3. Press Enter. 

The label will appear in the PARAMETERS column. 

4. If you want to exit input mode without making a 
change, press Esc. 

Input Parameters 

Input Parameters is a parameter for the /INT command. 
The /INT command optionally loads registers AX, BX, ex, 
and DX with values and issues a branch to the interrupt 
specified. Registers AX, BX, ex, DX, SI, DI, DS, ES, and 
the Flags register are saved and need not be restored. The 
interrupt processing program must leave the stack pointer 
(SP) and stack segment (SS) registers in the same state 
they were before leaving Story Editor or Story Teller. 

The correct format to enter the parameter information is 
nnn,ax,bx,cx,dx. You enter only register values for the 
registers you need. If you do not enter a value for a spe­
cific register, you must still enter a comma. The interrupt 
and register values can be expressed decimally (000 to 255) 
or hexadecimally (OOh to FFh). 

When using this parameter: 

• nnn = specified interrupt 
• ax = register value 
• bx = register value 
• ex = register value 
• dx = register value. 
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To use this parameter: 

1. Place the line on which you wish to enter parameter 
information on the Story Editing Line by scrolling the 
Story Table up or down. 

ｾ＠ 2. Select Input Parameters from the Parameter menu. 

ｾＧ＠

A blinking asterisk will appear in the PARAMETERS 
column. 

3. Type the interrupt and register values. 

Pressing any character key or the spacebar blanks out the 
current entry. If you want to edit the current entry, first 
use the -+ key; then, use the ｾＬｉｮｳ･ｲｴＬ＠ Delete, Spacebar, 
Backspace, or any character keys. 

4. Press Enter. 

The interrupt parameters will appear in the P ARAME­
TERS column. 

5. If you want to exit input mode without making a 
change, press Esc. 

TIME 

Use the TIME column to enter the amount of transition 
time needed to go from one screen image to the next. 
Select the Input Action Time option to enter an actual 
value in seconds or tenths of seconds. The FAST, MED, 
and SLOW transition times are relative. The time is 
approximately the same among IBM PC models and is 
faster for partial displays. 

Moving the pointer to the TIME column and pressing F3 
will enter the time from the column above. 
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Input Action Time 

1. Place the line on which you wish to enter time infor­
mation on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Input Action Time from the Time column. 

3. At the blinking asterisk, type the desired transition 
time in seconds or tenths of seconds. 

The number must be between .1 and 999. 

Pressing any number key blanks out the current entry. (\, 

4. Press Enter. 

The time you have entered will appear in the TIME 
column. 

5. If you want to exit this input mode without making a 
change, press Esc. 

FAST, MED, and SLOW 

1. Place the line on which you wish to enter time infor­
mation on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select either FAST, MED, or SLOW from the Time ｾ＠
menu. 
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The option you have selected will appear in the TIME 
column. 

WAIT Column 

This column allows you to select the amount of time your 
picture will be displayed before the next dissolve begins. 
By selecting the Input Wait Delay option, you can enter a 
picture display time in seconds or tenths of seconds. 

Move the pointer to the WAIT column and press F3 to 
enter the time from the column above. 
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Input Wait Delay 

1. Place the line on which you wish to enter wait infor­
mation on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select Input Wait Delay from the Wait column. 

3. At the blinking asterisk, type the desired display time 
in seconds or tenths of seconds. 

The number must be between .1 and 999. 

Pressing any number key blanks out the current entry. 

4. Press Enter. 
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The time you have entered will appear in the WAIT 
column. 

5. If you want to exit this input mode without making a 
change, press Esc. 

0 

If you select 0, the story will proceed immediately. 

To select 0: 

1. Place the line on which you wish to enter wait infor­
mation on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select 0 from the Wait menu. 

0 will appear in the WAIT column. 

KEY 

If you select KEY, the story will wait for you to press a 
key. 

To select KEY: 

1. Place the line on which you wish to enter wait infor­
mation on the Story Editing Line by scrolling the 
Story Table up or down. 

2. Select KEY from the Wait menu. 

KEY will appear in the WAIT column. 
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Additional Story Table Columns 

When you select the /CLEAR, /COLOR, DISPLAY, or 
/SHOW command, a panel of additional story table 
columns is displayed. The information entered in these 
columns gives Story Editor additional information that is 
needed with these commands. Under the column headings 
is a highlighted line. This can be considered an extension 
of the Story Editing Line. 

-IMETHOD I DIR I LINE I AREA I 
IFADE I NONE I NONE I PART I 

I FROM PI CT URE I TO SCREENI 
ｾＰＭＲＰ＠ I 100-115 I 531-174 I 

I Current Story Drf ve\Path I 

EDIT LINE 

r;;;;irvemory Used oz 

The additional columns are: 

• METHOD 
• DIR 
• LINE 
• AREA 
• FROM PICTURE 
• TO SCREEN. 

To select an option from these columns: 

1. Move the pointer to the column you want to select an 
option from on the Extended Story Editing Line. 

2. Press Button 1. 

The menu will open. 

3. To select an option, move the pointer to that option 
and press Button 1. 
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The menu will close and your selection will appear in that 
column. 

4. To close the menu without selecting an option, move 
the pointer ouutside the menu and press Button 1. 

METHOD and DIR 

The METHOD column is used to choose from a variety of 
dissolve methods that may be used to present screen 
images. The DIR column is used to determine the direc­
tion the dissolve will proceed in. The direction options are 
determined by the dissolve method you choose. 

Once a method has been selected, you may view and select 
a direction from the DIR menu. Only the direction options 
valid with the dissolve method you have chosen will be 
displayed in the DIR menu. Some methods do not have 
valid direction options, and NONE will be displayed in 
the DIR column when these methods are selected. 

The METHOD column has two menus. To go back and 
forth from one menu to the other: 

1. Move the pointer to the METHOD column of the Story 
Editing Line and press Button 1. 

2. Move the pointer into the METHOD menu and press 
Button 2. 
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3. To return to the first Method menu, press Button 2 
agam. 

4. To select a method from either menu, move the pointer 
to that command and press Button 1. 

ｾ＠ Because direction options are determined by the dissolve 
method you choose, they will be described with the dis­
solve options. 

--METHOD DIR I LINE I AREA I 
CRUSH NONE I NONE I PART I 

FROM PI 
IN-H 

TO SCREEN! 

ｾ＠
OUT-H 

531-174 I 
IN-V 
OUT-V I Curren :>•Ory ur 1ve\Path I 

EDIT LINE 
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ｾ＠ NONE 

The new picture is loaded into memory but not displayed. 
The value in the WAIT column is applied. This allows you 
to use Story Editor commands to modify a picture on fol­
lowing story table lines before the picture is displayed. 
There are no direction options for this method. 

CRUSH 

The new picture overlays the old picture in two directions 
simultaneously. Direction options for this method are : 

OUT-V Overlays old picture from center to top and 
bottom. 

ｾ＠ IN-V Overlays old picture from top and bottom to 
center. 
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OUT-H Overlays old picture from center to right and 
left. 

IN-H Overlays old picture from right and left to 
center. 

EXPLODE 

The new picture overlays the old picture simultaneously 
in four directions. Direction options for this method are : 

OUT-V and OUT-H 
Start new picture in center. 

IN-V and IN-H 
Start new picture at edges. 

FADE 

The old picture fades in random groups of one, two, or 
four pixels as the new picture is revealed. There are no 
direction options for this method. 

PUSH 

The new picture pushes out the old picture in one of four 
directions. Direction options for this method are: 

UP 
DOWN 
LEFT 
RIGHT. 

5-84 

r\ 



REPLACE 

The new picture overlays the old picture in one of four 
directions. Direction options for this method are: 

UP 
ｾ＠ DOWN 

LEFT 
RIGHT. 

SPLIT 

The new picture is revealed as the old picture is split and 
pushed off the screen. Direction options for this method 
are: 

OUT-V Old picture is pushed from center to top and 
bottom. 

IN-V Old picture is pushed from top and bottom to the 
center. 

OUT-H Old picture is pushed from center to right and 
left. 

IN-H Old picture is pushed from right and left to 
center. 

STRIPES 

The new picture overlays the old picture as stripes in 
selected direction. Direction options for this method are: 

UP and DOWN 
Horizontal stripes overlay old picture moving up 
or down. 

ｾ＠ LEFT and RIGHT 
Vertical stripes overlay old picture moving left 
or right. 
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WEAVE 

The old picture is horizontally pushed out in two 
directions simultaneously, and replaced by the new 
picture. There are no direction options for this method. 

DIAGONAL 

The new picture diagonally overlays the old picture. 

UP New picture overlays the old from lower right to 
upper left. 

DOWN New picture overlays the old from upper left to 
lower right. 

RIGHT New picture overlays the old from upper right to 
lower left. 

LEFT New picture overlays the old from lower left to 
upper right. 

CHECKER 

The new picture replaces the old by using upward 
expanding boxes. There are no direction options for this 
method. 

LINE 

Some dissolves have a straight line displayed between the 
old picture image and the new picture image while the 
transition between pictures is taking place. This column 
allows you to select the color of that line. You may also 
choose not to use a line. 
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METHOD DIR LINE AREA 
CRUSH NONE NONE PART 

FROM p I CTURE Get L ne Col or 
0-20 100-11 No Line 

I Current Story Drive\Path I 

EDIT LINE 
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You will not be allowed to chose a line option if this 
information is not used by the dissolve method you have 
chosen. If no line color is selected, black is the default. 
This option is valid for the following dissolve methods: 

• Diagonal 

• Explode 

• Crush 

• Split 

• Push 

• Replace . 

Get Line Color 

To select a line color: 

1. Select Get Line Color from the LINE menu. 

The Line Color panel will be displayed. 

2. Move the pointer to the line color you want and press 
Button 1. 

No Line 

ｾ＠ To use no line color with a dissolve method for which this 
option is valid, select No Line from the Line menu. 
NONE will be entered in the LINE column. 
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AREA 

This column allows you to specify whether a full screen 
display or a partial screen display should be used for your 
pictures. The FULL and TRANSPARENT FULL options 
are used for full screen displays. The PART and TRANS­
p ARENT PART options are used for partial displays. 

0-20 100-115 

Current Story Drive\Path 

EDIT LINE 

0 Memory Used 2:1: 

When FULL or PART is used, the original background of 
the picture is maintained. The TRANSPARENT.FULL 
and TRANSPARENT PART options allow one color to be (\, 
designated as transparent. The transparent color used by 
Story Editor is the same one that was selected as the 
transparent color in Picture Maker. TRANSPARENT 
FULL or TRANSPARENT PART allows a portion of the 
previous picture to "show through" the present picture. 

FROM PICTURE TO SCREEN 

These columns are used when either PART or TRANS­
PARENT PART are selected in the AREA column. The 
coordinates entered here determine the partial area that 
will be altered or displayed on the screen. 

For graphics screens, the values are in pixels measured 
from the upper left corner of the screen. The values for 
the supported resolution modes are as follows: 
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Resolution X-axis Y-axis 
Mode Values Values 

320 x 200 1 - 320 1- 200 

640 x 200 1- 640 1- 200 

640 x 350 1 - 640 1- 350 

640 x 480 1- 640 1 - 480 

For 80-column and 40-column text screens, X refers to the 
character column (1 to 80 or 1 to 40) and Y refers to the 
line (1 to 25). 

You can enter these coordinates using either Set on 
Monitor, Set on Full Screen, or the Input Coordinates 
option. 

ｾ＠ --... 

I METHOD I DIR I LINE I AREA I 
!FADE I NONE I NONE I PART I 

FROM PICTURE I TO SCREEN 

0-20 I loo-us I i.31-174 
set on Mon 1 tor ,·\-
Set on Full screen 
Innut r--rd1nates 

EDIT LINE 

Mernoru Used 2:1: 

The first value displayed in the first column is the dis­
tance on the horizontal (X) axis from the left side of the 
screen to the left side of the partial picture area. The 
second value is the distance on the vertical (Y) axis from 
the top of the screen to the top of the partial picture area. 

The first value in the second column is the distance on 
the horizontal (X) axis from the left side of the screen to 
the right side of the partial picture area. The second value 
is the distance on the vertical (Y) axis from the top of the 
screen to the bottom of the partial picture. 

The values in the TO SCREEN column indicate the 
location where the upper left-hand corner of a partial 
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picture will be displayed. These values are valid only with 
the /DISPLAY and /SHOW commands. No entry in this 
column will cause the partial picture to be displayed in 
the same location as the previously run line with an entry 
in this column. 

Set on Monitor and Set on Full Screen 

These options allow you to use a select box to enter coor­
dinates for the area of the partial picture you want to 
display or alter. Set on Monitor lets you set the coordi­
nates in the monitor area of the Story Table Screen. Full 
Screen allows you to set the coordinates on the full 
screen. 

Note: If you selected the keyboard as your input device, 
you move the pointer in the monitor or full screen areas 
using the cursor movement keys. The pointer will move in 
4 pixel increments in the 320 x 200 resolution modes and 8 
pixel increments in all other resolution modes. To move 
the pointer in 1 pixel increments, press Shift and the 
cursor movement keys. 

Using a Select Box with /CLEAR and 
/COLOR 

1. Select either Set on Monitor or Set on Full Screen 
from the FROM PICTURE TO SCREEN menu. 

2. The previous picture in the PARAMETERS column is 
displayed with a select box. 

LINE 

Mem:Jry Used 2 2: 
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If you wish to use the area in the select box, continue 
with the next step. If you wish to change the area, go to 
Step 3. 

3. Move the pointer inside the select box and press 
Button 1. 

The coordinates will be entered in the FROM PICTURE 
column. 

4. To change the coordinates of the select box, move the 
pointer inside the screen area but outside the select 
box and press Button 1. 

A crosshair pointer will appear on the screen. 

5. Move the pointer to the upper left-hand corner of the 
area you want to alter and press Button 1. 

6. Move the select box until it encloses the area you 
want to alter and press Button 2. 

7. Move the pointer inside the select box and press 
Button 1. 

The coordinates will be entered in the FROM PICTURE 
column. 

Note: The TO SCREEN column is updated when Button 1 
is pressed, but the information is not used with the 
/CLEAR and /COLOR commands. 

Using a Select Box with /DISPLAY and 
/SHOW. 

1. Select either Set on Monitor or Set on Full Screen 
from the FROM PICTURE TO SCREEN menu. 

The picture you have listed in the PARAMETERS column 
will be displayed with a select box. If you wish to use the 
area in the select box, continue with the next step. If you 
wish to change the area, go to Step 4. 
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2. Move the pointer inside the select box and press 
Button 1. 

The previous picture in the PARAMETERS column will 
appear as background with the area framed by the select 
box over it. If a /CLEAR command was used to clear the 
previous picture, the background will be black. 

3. Go to Step 8. 

4. To change the area framed by the select box, move the 
pointer inside the screen area but outside the select 
box, and press Button 1. 

A crosshair pointer will appear on the screen. 

5. Move the pointer to the upper left-hand corner of the 
area you want to display and press Button 1. 

6. Move the select box until it encloses the area you 
want to display and press Button 2. 

Note: To change only the FROM SCREEN coordi­
nates, press Button 2 again. 

7. Move the pointer inside the select box and press 
Button 1. 

The previous picture in the PARAMETERS column will 
appear as background with the area framed by the select 
box over it. If a /CLEAR command was used to clear the 
previous picture, the background will be black. 

8. To leave the picture in the same screen location, move 
the pointer outside the select box but inside the screen 
area and press Button 2. 

9. If you want to select another area for the partial 
picture to be displayed, move the pointer inside the 
select box and press Button 1. 

10. Move the select box to the new location. 
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11. If you want to view the partial screen image in the 
new position, press F4. 

12. Press Button 2. 

The select box will be moved to the new position. 

The coordinates will be entered in the the FROM 
PICTURE TO SCREEN columns. 

Using Input Coordinates 

This option can be used to type actual coordinates for the 
partial area that will be altered or displayed on the 
screen. 

In the FROM PICTURE TO SCREEN columns of the 
table, Story Editor accepts coordinates in 4 pixel incre­
ments on the X-axis in the 320 x 200 modes. Story Editor 
accepts coordinates in 8 pixel increments on the X-axis, in 
all other resolution modes. If values not matching the 4 or 
8 pixel increments are entered, Story Editor will round 
them up or down as shown in the following table. 

Resolution From Screen From Screen 
Mode 1st X & To 2nd X Value 

Screen Values 

320 x 200 Rounds to Rounds to 
next lowest next highest 
odd pixel (i.e. even pixel 
1, 5, 9, ... 317). (i.e. 4, 8, 12, 

... 320). 

640 x 200, Rounds to Rounds to 
640 x 350, next lowest next highest 
640 x 480 odd pixel (i.e. even pixel 

1, 9, 17, (i.e. 8, , 12, 
... 653). ... 640) . 

Story Editor accepts coordinates in 1 pixel increments on 
the Y-axis. 
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FROM PICTURE TO SCREEN 
0-20 100-115 531-174 

To input coordinates in the FROM PICTURE TO 
SCREEN columns: 

1. Select Input Coordinates from the FROM PICTURE 
TO SCREEN columns. 

2. At the blinking asterisk, type the coordinates of the 
location of the area that will be altered or displayed 
on the screen. 

The columns are divided into six areas. The Tab and 
Shift-Tab keys will move the blinking asterisk between 
these areas. Pressing any number key will blank out the 
area where the blinking asterisk is located. Leaving the 
TO SCREEN blank will indicate that the partial screen 
should be placed in the same location. 

3. Press Enter to set the coordinates. 

The coordinates will be entered in the the FROM 
PICTURE TO SCREEN columns. 

4. If you want to exit input mode without making a 
change, press Esc. 

Creating Animation Sequences 

Story Editor can be used to create animation sequences 
which are actually a series of pictures being displayed one 
after another to give a sense of movement or motion 
across the screen. Story Editor will automatically insert ｾ＠

the story lines needed for the animation sequence as you 
use the /SHOW command and a select box to enter coordi-
nates into the FROM PICTURE TO SCREEN columns. 
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If the select box outline changes to a dash dot style 
(normally the box is made of dashes), the area you have 
surrounded is too large to use in an animation sequence. 
To use this option, reduce the size of the area you sur­
rounded with the Select box until the box outline changes 
back to dashes. The area you can surround before the 
select box outline changes to the dash dot style is deter­
mined by the color and resolution mode you select during 
Setup. 

If you surround an area that is too large, the program will 
default to a standard /SHOW command which takes 
longer to execute. 

There are three types of animation that you can create 
with Story Editor. These are: 

• Movement across the screen using one image (i.e. one 
image of a car that moves across the screen). 

• Movement across the screen using a series of images 
(i.e. a series of images of a bird flying across the 

ｾ＠ screen with wings moving). 

• Stationary movement (i.e. flag waving in the wind). 

Movement Across the Screen Using 
One Image 

To create an animation sequence that has one image 
moving across the screen: 

1. Select /SHOW from the Commands menu. 

2. Enter the picture filename into the PARAMETERS 
column. 

ｾ＠ 3. Enter 0 in the TIME column. 

4. Enter 0 in the WAIT column. 
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5. Select either PART or TRANSPARENT PART from 
the Area menu. 

6. Select either Set on Monitor or Set on Full Screen 
from the From Picture To Screen menu. 

A select box will appear on the screen with the picture 
you selected in the PARAMETERS column. 

7. If the select box is outlining the partial area you want 
to use in your animation sequence, go to Step 11. If 
you want to select a partial area to use in your ani­
mation sequence, continue with the next step. 

8. Move the pointer outside the select box but within the 
screen area and press Button 1. 

A crosshair pointer will appear on the screen. 

9. Move the pointer to the upper left-hand corner of the 
area you want to display and press Button 1. 

10. Move the select box until it encloses the area you {\ 
want to display and press Button 2. 

11. Move the pointer inside the select box and press 
Button 1. 

The last picture in the PARAMETERS column is dis­
played as background with the select box over it. If a 
/CLEAR command was used to clear the last picture, the 
background will be black. 

12. To begin your animation sequence, move the pointer 
inside the select box and press Button 1. 

13. Move the select box and press Button 2 every time 
you would like the image displayed in your animation 
sequence. 

Each time you press Button 2, a new line is added to your 
story. 

14. To end an animation sequence, press Button 1. 
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Movement Across the Screen Using a 
Series of Images 

All of the images you want to use in your animation 
sequence must be in the same file. 

To create an animation sequence that has a series of 
images moving across the screen: 

1. Perform the steps in "Movement Across the Screen 
Using One Image." 

2. Place the story line where you would like to change 
the image being displayed on the Story Editing Line by 
scrolling the Story Table up or down. 

3. Select either Set on Monitor or Set on Full Screen 
from the From Picture To Screen menu. 

A select box will appear on the screen with the picture 
you selected in the PARAMETERS column. 

4. Move the pointer outside the select box but within the 
screen area and press Button 1. 

A crosshair pointer will appear on the screen. 

5. Move the pointer to the upper left-hand corner of the 
area you want to display and press Button 1. 

6. Move the select box until it encloses the area you 
want to display and press Button 2. 

7. Move the pointer outside the select box and press 
Button 2. 

This will update the FROM SCREEN column without 
changing the TO SCREEN coordinates. 

8. Continue following these steps until you have made all 
of the necessary changes to the animation sequence. 
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Stationary Movement 

To create an animation sequence that has stationary 
movement, follow each of the steps in the two other ani­
mation procedures with the exception of keeping the 
select box stationary while pressing Button 2 to insert ｾＮ＠

story lines. 

Note: If you are creating stationary animation and you 
are using the PART option from the Area Menu, it is 
recommended that you use the /DISPLAY command and 
the REPLACE method with Time defined as 0 for better 
performance. 
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Text Maker 

Text Maker is the program you use to create the text 
screens for your story. While in the Text Maker mode, 
each character position has a foreground and background 
color, a foreground character, and a foreground character 
blink setting. Text Maker has a set of editing functions 
that allow you to alter these settings on an existing 
screen captured by Picture Taker or in creating a new 
text screen. 

You can begin with either a blank screen or with any text 
screen previously stored in a text screen file. You then 
use Text Maker commands to build a new text screen or 
edit an existing one. 

When you have finished, store your text screen in either a 
new text screen file or use it to update an existing one. 
Later, using Story Editor, you can assemble these text 
screens, along with pictures created by Picture Maker, 

ｾ＠ into your story. 

Starting Text Maker 

Type TM to start the program from the DOS prompt or 
type SBMENU to start the IBM Storyboard Plus Quick 
Menu/Setup program. You can change the Setup options 
of your product and then select Text Maker from the 
menu. 
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Date:XX/XX/XX Text Maker 

Main Menu 

I 1. Create or Edit I 
2.Get 
3.Save 
4.Remove 
5. Displays 
6. Select Library Name 

To select, use t or ｾ＠ and press ._i . 

Veraklnl.00 

Copyrisbt IBM Corporatian 1986, !967 

Fl=Help Esc=Exit 

Text Maker Main Menu 

Using Create or Edit 

Use this option to display the screen on which you can 
create a new text screen or edit an existing one. 

To create a new text screen: 

1. Select Create or Edit. If the screen is blank, you can 
begin using Text Maker functions. 

2. If the screen is not blank, make sure you have saved 
the displayed screen using the Save option. See the 
"Using Save" section for more information. 

3. Return to the Create or Edit screen and press Alt U to 
clear the screen. 

To edit an existing text screen: 

1. First, retrieve the screen with the Get option. See the 
"Using Get" section for more information. 
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2. Select Create or Edit and the screen you retrieved is 
displayed for you to begin editing. 

Using Get 

ｾ＠ This option retrieves and displays any 40-column or 
SO-column text screen stored on a fixed disk or diskette. 
You can select Get either by pressing the number associ­
ated with the option or by moving the cursor to the line 
containing Get and pressing Enter. 

1. Select Get from the Text Maker Main Menu. The Get 
File panel appears, displaying the default drive and 
directory path. 

2. To get a screen from the default directory, type the 
filename. If you do not specify an extension, Text 
Maker adds .TXM as the file extension when 
retrieving the file. To retrieve a text screen with 
another extension name, type the filename and its 
extension. 

Example: C:\SCRNDIR\MYSCRN.ANY 

OR 

To retrieve a file with no extension, type the filename and 
a period. 

Example: C:\SCRNDIR\MYSCRN. 

You can change the default drive and directory path by 
typing over the defaults. (You don't have to type the 
colon; simply press the ｾｫ･ｹ＠ to move over it.) 

You can also get a filename using the File Services panel. 
See the "Using File Services Panel to List Files" section 
for more information. 

3. To get a text screen captured by Picture Taker, type 
the drive, path, filename, and file extension followed 
by a space and the number representing the sequence 
number of the text screen. This is necessary, because 
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pictures saved using Picture Taker are numbered as 
they are being saved and added to the end of the file. 

For example, to retrieve the third screen in a file created 
with Picture Taker, you would enter: 

C:\SCRNDIR\SCRNFILE.CAP 3 

This method is also used to get pictures from other types 
of files which contain more than one screen. For example, 
to retrieve the fifth screen in a library you've created, 
type: 

C:\SCRNDIR\MYLIB.LIB 5 

Press Enter to retrieve your screen. 

4. Press Enter again to clear the confirming message. 

Using Save 

The Save option stores a copy of your current screen on a 
fixed disk or diskette using the Text Maker file format. 
Any changes you make to your text screen are not perma­
nent unless you use this Save option. 

1. Select Save from the Text Maker Main Menu. The 
Save File panel appears, displaying the default drive 
and directory path. 

2. To save a screen, use the standard DOS format to type 
the filename. You can change the current drive and 
directory path by typing over the defaults. If you do 
not specify an extension, Text Maker will automat­
ically add the . TXM extension to the file you are 
saving. 

Example: C:\SCRNDIR\MYSCRN (saves your text screen 
as MYSCRN.TXM) ｾ＠

To save your file with another file extension, type a 
period and the file extension after the filename. 
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Example: C:\SCRNDIR\MYSCRN.ANY 

Note: Since Picture Maker uses .PIC file extensions, you 
should not use .PIC as a file extension in Text Maker. 

To save your file with no extension, type the filename fol­
lowed by a period. 

Example: C:\SCRNDIR\MYSCRN. 

You can also get a filename using the File Services panel. 
See the "Using File Services Panel to List Files" section 
for more information. 

Files made by Picture Taker may contain more than one 
screen. To add a screen to a file made by Picture Taker, or 
build a new .CAP file, type the path, filename, and .CAP 
as the the file extension. When you save a screen using a 
.CAP or .LIB file extension, the screen is added to the 
other screens at the end of the file. 

Example: C:\SCRNDIR\SCRNFILE.CAP 

To add a text screen to a library, or build a new library, 
type the path, filename and .LIB as the file extension. 

Example: C:\SCRNDIR\MYLIB.LIB 

Once a screen from this kind of file has been modified by 
Text Maker, it is regarded as a new screen and thus 
cannot be returned to its original position in the file. You 
should save it as a single screen. 

Note: A maximum of 30 screens should be kept in a .CAP 
or .LIB file for ease of handling and access time. 

a. Press Enter to save your screen. 

4. Press Enter again to clear the confirming message. 
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Using Remove 

The Remove function permanently erases a text screen file 
from a disk. After you remove the file, it cannot be recov­
ered. Make sure you want to remove the file permanently 
from the disk before using this function. 

1. Select Remove at the Main Menu. The Remove File 
panel appears with the default drive and directory 
path displayed. 

2. Type the name of the file you want to remove and 
press Enter. Text Maker warns you that it is going to 
remove your file. 

3. Type Y to complete the remove operation. 

Text Maker permanently removes the document from 
the disk and displays a message to inform you of it. 

4. Press Enter to remove the message and return to the 
Main Menu. 

Using the File Services Panel to List 
Files 

te:XX/XX/XX Text Maker 

Main Menu 

Get Fi le 

C:\ 

File Services 

:;·::, 1r .. 1 < ﾷｾｾﾷｾ［＠

To select, use the Tab ke'--y-an-d ..,...,-or..,..+ 

Then , press ｾ＠

Fl=Help 
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Often you do not remember the exact spelling of the file 
you want to get or remove, or you want to be sure to save 
your screen with a name that fits the naming scheme you 
have been using. The Get, Save, and Remove options 
allow you to list all the files on a disk. 

ﾷｾ＠ For example, when the Get File panel appears, the default 
data path is already filled in. You can change the drive 
and directory by typing over the defaults. (You don't have 
to type the colon; simply press the -t key to move over it.) 

If you press Enter without typing a filename, the File Ser­
vices panel appears, listing all the files on the disk or 
directory you specified. 

The Drive column lists all of the drives connected to your 
system. The Directory column lists any DOS subdirecto­
ries below the selected directory. If the selected directory 
is itself a subdirectory, the column includes an entry 
named "PREVIOUS." If the drive contains no subdirecto­
ries, the Directory column contains the entry "NONE." 
The Filename column lists all the files in the specified 
drive and directory, unless a subset of files is specified. If 
the directory contains no files, the filename column con­
tains the entry "NONE." 

To move from one column to another, press the Tab key. 
Within a column, highlight an entry using the j or L key 
and press Enter to select. When you select a different 
drive or directory, the Filename column is updated to 
display the files at the specified location. 

To view additional files that are not now visible, use the L 
or PgDn key. 

You can list a subset of a directory by using the global 
filename characters* or?. For example, *.TXM lists all 
the files ending with the extension .TXM and 
MYSCRNS?.* lists all files that have MYSCRNS as the 
first seven characters of the name. For more information 
on using global filename characters, refer to your DOS 
book. 
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When you find the file you want, select it by highlighting 
the filename and pressing Enter. Text Maker performs. the 
specified function. 

From the File Services panel, to return to the Get, Save, 
or Remove panel to type a new filename, simply press Esc. 

Using Displays 

The Displays option allows you to display your screens 
using either 40-column or 80-column width. The default is 
80-column width. 

To change to 40-column format: 

1. Select the Displays option at the Main Menu. 

2. A message informs you of the change. Press Enter to 
continue. 

3. Select Displays again to return to 80-column format. 

If you switch from an 80-column format to a 40-column 
format while editing a text screen, Text Maker will pre­
serve the right half of the screen (columns 41 through 80) 
even though it is not visible in 40-column format. If you 
switch back to 80-column format during the same session, 
this half of the screen will be restored. 

If you switch from an 80-column format to a 40-column 
format, save the screen, and then read the screen in again, 
the right half of the screen (columns 41 through 80) will 
be lost. Text Maker will not save this information when 
you use the Save option. 
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Using Select Library Name 

You may want to quickly add designs to your screen 
without taking the time to draw your own. Text Maker 
provides a library of screens called TM.LIB that contains 
designs to help you do this. The library contains screens 
with various designs or parts of designs. You can use Text 
Maker commands and function keys on these screens to 
alter them or to build your own library screens. The 
TM.LIB screens are not permanently changed by Text 
Maker commands and will be in their original form the 
next time you display them. Any altered screens may be 
saved as individual screens or in a new library file. 

You can add your own screens to a library, or you can use 
one of your own files as a library. Only files saved with a 
.CAP or a .LIB extension can have more than one screen 
image in them. These files can be used to rotate through a 
series of screens. 

To use another file as your library: 

ｾ＠ 1. Choose Select Library Name from the Text Maker 
Main Menu. Enter the alternate library's path, 
filename, and extension or use the File Services panel 
to select a filename. 

2. Select Create or Edit and press F2 to display the first 
screen in the file you have designated as your library. 
Continue pressing F2 to rotate through the screens in 
the library. 

3. To change libraries, return to the Text Maker Main 
Menu and choose Select Library Name again. 

For more information on screen libraries, see "Screen 
Libraries" later in this chapter. 
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Create or Edit Functions 

Using the Cursor 

The cursor shows your present position on the text screen. (\ 
It is displayed in a foreground color. For example, when 
you start Text Maker, the cursor is displayed in bright 
white. If you change the foreground color to yellow, the 
cursor is displayed in yellow in the Draw, Box Draw, and 
Erase commands. If you make your foreground and back-
ground color the same,. Text Maker will choose a different 
foreground color for the cursor so that you can see it. As 
the cursor moves across a series of text or drawings, it 
changes to the foreground color that existed when the text 
was created. If you move the cursor over a solid block of 
foreground color, the cursor will disappear because it is 
the same color as the block. 

Not all the cursor movement keys work in every 
command. For example, you can't move the cursor 
diagonally in the Text, or Draw command. 

Using this key Moves the cursor 

--+, +--, j, ! In the direction of the 
arrow. 

Ctrl + +-- or -+ To the first or last column 
of the current line. 

Shift + +-- or -+ Four columns to the left 
or right. 

Shift + j or i Up or down two lines. 

Home One space diagonally 
towards the upper left. 

End One space diagonally 
towards the lower left. 

Pg Up One space diagonally 
towards the upper right. 
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Using this key Moves the cursor 

PgDn One space diagonally 
towards the lower right. 

Ctrl and a diag- To a corner. 
onal movement 
key 

Tab To the right in eight 
column increments (from 
the left margin) on the 
current line. 

When an elastic box is 
displayed, alternates the 
cursor between two oppo-
site corners of the box. 

Shift + Tab To the left in eight 
column increments (from 
the right margin) on the 
current line. 

Ctrl + Enter To the first column on the 
next line. 

Using Hint Text 

Hint text, which gives you information about the current 
settings and mode or command you are using, appears on 
the bottom line of the Text Maker editing screen. If you 
want to enter information .on that line, you can use the 
Alt X command to suppress hint text. 

An example of hint text is shown below. 

Fl=Help I- - -F-B MAIN COMMAND MODE 
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In the example above, the I displays only when Immediate 
Palette is active. The first blank space indicates the blink 
setting. The second blank space indicates the text char­
acter selected, and the F and B display the foreground 
and background colors selected. Finally, the current mode 
or active command (Erase, Text, Draw Cut, Alter Color or 
Box) is displayed. ('>, 

Using the Elastic Box 

The Alter Color (A), Cut (C), and Erase (E) commands all 
begin the elastic box. The elastic box is a variable-sized 
area whose size you determine with a Text Maker 
command. It can be used to define the area within which a 
command will be performed. For example, you can use an 
elastic box to define an area you want to be erased. 

An elastic box has an anchor point and a stretch point. 
The anchor point is the point where you started drawing 
the box. The stretch point is the point from which the box 
grows and expands. 

To expand an elastic box: 

1. Position the cursor at one corner of the area in which 
the command will be used. 

2. Press the key (A, C, or E) to start the command. 

3. Use the cursor movement keys to expand the elastic 
box on the screen from the anchor point until you 
enclose the desired area. 

To move the location of the box without changing its size: 

1. Press the Tab key to move the cursor to the anchor 
point. 

2. Use the cursor movement keys to relocate the box. r-"'\. 

You can return to changing the size of the elastic box by 
again pressing the Tab key, which returns the cursor to 
the stretch point. 
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The elastic box is removed when you press Enter to end a 
command. 

Using the Color/Character Table 

none blank ｾ＠ lloJf.11»MiL'll§4t+ 
+<-e!f !"#$x& t () •+,-./0!23456'189:;<=> ?¥ 

ABCDEFGHIJWHll'!ll!Sl1J'MYZ [\] ' _ 'abcdef 

ghijklmnapqrstuvwxyz{i} • o ｾｭ｡＠ ｾｬｬＡａｩｬ＠

ｾｉｖ｜ｴｬｬｬｾｾ｡ＮＬＭ｡｣ｓｴｬｄｎｊＮｲｾｯ＠ Bl 1nk1ng curso 
ｊｾＧ＠ ＢＱｕＮｬＭｴｬｬｦ｡ｦｦｲｩｮｾｵ＠

ｲＧｬｲｬＡｾｰＧｬＧﾧｾＮＮｋｪＧｊＷｴ＼＠ ••. J"'• 

r 

fbresround: I 
"£"" I I I I I I I I I I I I I I I I " BLINIC mme an off 

ｾＭＭＭＭＭＭＭＭＭＭＭＭＭＭＭ

beclrgnnmd 

Fl=Help 

ｾ＠ The Color/Character Table appears at the bottom of the 
screen when you use function keys F5 through FlO or Alt 
J. You can select colors to use in the Box, Draw, Erase, 
and Text commands; characters to use in the Box, Draw 
and Erase commands; or a blink setting at almost any 
time. Use a function or cursor movement key to make a 
selection. Complete your selection by pressing Enter. 

Selecting a Text Character 

The F5 and F6 keys tell Text Maker that you want to 
select a text character or "nohe" or "blank" to use ｾｮ＠ the 
Box, Draw, and Erase commands. The cursor indicates the 
current character setting. The following keys may be used 
in addition to the normal cursor movement keys to move 
the cursor to another setting: 

F5 backward 
F6 forward 

6-15 



Ctrl F5 
Ctrl F6 

up 1 line 
down 1 line 

Selecting a Character 

You can choose from text characters and symbols. Ｎｾ＠
Common symbols are shown in lines one and two. Letters 
and symbols from foreign alphabets are shown in lines 
four, five, and the last line. The third symbol in the last 
line displays a solid block of foreground color. Symbols 
four through seven in that line display blocks with one 
half the foreground color and the other half the back-
ground color. You can create halftones (dotted patterns) 
with the last three symbols in the third line from the 
bottom. 

mmel I I 
" 

background 

I I I I I I I I I 
ｾＭＭＭＭＭＭＭＭＭＭＭＭＭＭＭ

" BLINK DOile an alf 

ESO=Quit 

Steps to Display a More Readable 
Character Table 

Sometimes you may want to enlarge the screen image of 
the character table to display greater detail. The proce­
dure to do this is as follows: 

1. Save your current screen as a precaution. 
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2. Select Displays at the Main Menu to change to 
40-column format. 

3. Select Create or Edit to return to the editing screen. 

4. Press F5 or F6 to display the Color/Character Table. 

5. Move the cursor to the desired character. 

6. Return to the Main Menu and select the Displays 
option again to return to 80-column format. 

Selecting None 

If you select none, commands which would normally write 
the current text character onto the screen will leave the 
existing foreground characters unchanged on the screen. 
For example, suppose you have the word "Chicago" in 
green letters (foreground) with a blue background: 

• If you select the current text character as X, the 
current foreground and background colors as blue, and 
erase a block, the block will be erased with blue Xs on 
a blue background. You will have a solid blue block. 

• If you select the current text character as X, the 
current foreground color as red, and the background 
color as white, and erase a block, the block will be 
erased with red Xs on a white background. 

• If you select the current text character as none, the 
current foreground color as red, and the background 
color as white, the Erase command will simply change 
the foreground and background colors of the area 
erased. You will have the the word "Chicago" in red 
letters on a white background. 
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Selecting Blank 

Select blank as the text character when you want to use 
the Draw command to erase part of a drawn figure by 
drawing over it in the background color. If you select 
none instead, you may see parts of the previous drawing 
when you redraw over the area, because Text Maker 
remembers what was previously drawn. 

You also select blank when you want to use the Erase 
command to draw a box filled with a solid background 
color. 

Selecting a Foreground Color 

The foreground color is the color used for letters and 
symbols and for drawing. The F7 and FS keys tell Text 
Maker that you want to select a foreground color. The 
indicator points to the current foreground color setting. 
You can choose from "none" or 16 available foreground 
colors to use in the Box, Draw, Erase, and Text com­
mands. 

foregnnmd: 

" llf"" ｾｾ｟Ｎ｟ＬＬＬ＼ＢＢＢＢＢＧＭＭ｟Ｌ｟｟ｾｾ＠ ............ ｾ｟Ｌ｟｟｟Ｌｾ＠ BLINK ncne an aft 

Fl=Help Esc=Exit 

If you select none as your foreground color, commands 
which would normally write the current foreground color 
onto the screen will leave the existing foreground color 
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unchanged on the screen. For example, suppose you have 
text in green letters (foreground) with a blue background: 

• If you select the current foreground color as blue, the 
current background color as black, and the current 
text character as X, and erase a block, the block will 
be erased with blue Xs on a black background. 

• If you select the foreground color as none, the back­
ground color as black, and the current text character 
as X, and erase a block, the block will be erased with 
green Xs on a black background. 

You may get unexpected results with commands other 
than Erase when you set the foreground color to none. 
For example: 

• When you start Text Maker, the foreground color is 
bright white. If you set the foreground color to none 
and draw a box, Text Maker draws the box in bright 
white because the selection none tells it to leave the 
existing foreground color (bright white) unchanged. 

• If you select your foreground color as none and draw 
or write text on an area that has existing foreground 
colors, your text or drawing will be in those fore­
ground colors. 

You also may get unexpected results if you set your fore­
ground and background colors to the same color in the 
Box, Draw, and Text commands. For example, if the 
screen is black and you make your foreground and back­
ground colors green, Text Maker will use green for text 
and drawing. If the screen is black and you make your 
foreground and background colors black, Text Maker will 
use black for text and drawing. 
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Selecting a Background Color 

The background color is the color behind the foreground 
color. The F9 and FlO keys tell Text Maker that you 
want to select a background color. The indicator points to 
the current background color setting. You can ｣ｨｯｯｳ･ＮｾＮ＠ . . 
from "none" or 8 available background colors to use in 1 ' 

the Box, Draw, Erase, and Text commands. 

" BUNK nmie an off I I I I I I I rl 
+---------------

Fl=Help Esc=Exit 

If you select none as your background color, commands 
which would normally write the current background color 
onto the screen will leave the existing background color 
unchanged on the screen. For example, suppose you have 
text in green letters (foreground) with a blue background: 

• If you select the current background color as black, 
the current foreground color as blue, and the current 
text character as X, and erase a block, the block will 
be erased with blue Xs on a black background. 

• If you select the current background color as none, 
the current foreground color as red, and the current 
text character as X, the block will be erased with red ｾ＠
Xs. The blue background will not change. 
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Selecting a Blink Setting 

Alt J tells Text Maker that you want to select a blink 
setting. The word pointed to by the indicator shows the 
current blink setting. You can choose from "none," "on," 
or "off' to use in the Box, Draw, Erase, and Text com-

ｾ＠ mands. 

If you select none as your blink setting, commands which 
write to the screen will leave the existing blink condition 
unchanged on the screen. For example, suppose you have 
the sentence "Chicago is #1" on the screen with the word 
"Chicago" blinking. The text is in green letters (fore­
ground) with a blue background. 

• If you select the current text character as none, the 
current foreground color as red, the current back­
ground color as white, and the current blink setting as 
none, the Erase command will change the colors and 
the word "Chicago" will continue to blink. 

• If you select the current text character as none, the 
current foreground color as none, the current back­
ground color as none, and the current blink setting as 
off, and erase a block, the colors will remain the same 
but the word "Chicago" will no longer blink. 

• If you select the current text character as none, the 
current foreground color as none, the current back­
ground color as none, and the current blink setting as 
on, and erase a block, the entire sentence "Chicago is 
#1" will blink. 

• If you select the current text character as X, the 
current foreground color as none, the current back­
ground color as none, and the current blink setting as 
none, and erase a block, the block will be erased with 
Xs and the word "Chicago" will be replaced with 
blinking Xs. 
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Changing Selections in the 
Color/Character Table 

You can change selections by using the appropriate func­
tion key (F5/F6 for characters, F7 /F8 for foreground color, 
F9/F10 for background color) and by moving the cursor 
when the Color/Character Table appears. You can also 0 
use the Alt K command or the Alt S command to make 
changes without seeing the Color/Character Table. See 
"Immediate Palette (Alt K)" and "Set Palette (Alt S)" later 
in this chapter. 

Changing the Border Color 

At almost any time, you can rotate forward and backward 
through the 16 border colors by pressing the Shift key 
and either the F3 or F4 key. However, the border color 
you select during Text Maker is not saved with your 
screen. 

Note: You may not be able to rotate through the border 
colors when using the Enhanced Graphics Adapter (EGA), (\ 
depending on your EGA switch settings. 

Changing Colors in Text and 
Drawings 

You can change the foreground and background colors of 
written text and completed drawings without having to 
reenter the text or redraw the figures. Several alternatives 
exist: 

• You can use the Erase command with one or more of 
the techniques described in the preceding section, 
"Using the Color/Character Table." 

• You can use the A command to alter colors within an (\ 
elastic box. See the "Alter Color" command later in 
this chapter. 
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• You can use the Alt A command to alter colors on the 
entire screen. See the "Alter Color" command later in 
this chapter. 

You can also change the foreground and background 
colors of boxes while you are drawing them with the Box 

ｾ＠ or Erase command. You can use either the function keys 
F7 through FlO to go directly to the Color/Character 
Table or you can use the Alt K command to change colors 
without displaying the table. See "Immediate Palette (Alt 
K)" later in this chapter. 

You can change foreground and background colors while 
you are using the Draw or Text command, but the change 
is effective only for the next segment of the drawing or 
the letter of text the cursor is under. 

Creating Filled Boxes 

Unlike Picture Maker, Text Maker does not have a sepa­
rate fill command. However, there are several ways to 
create filled boxes. You can use the following commands: 

• Erase with the character choice "blank" to create 
boxes filled with a solid background color. 

• Erase with a text character to create boxes filled with 
a pattern. 

• Erase with the special text character that fills the 
area to create boxes filled with a solid foreground 
color. 

• Draw with the same foreground and background color. 

• Alter Color to create solid, filled boxes or to fill 
within an existing box. 

ｾ＠ • Text to fill with a background color by moving the 
spacebar. 
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Erasing Part or All of the Screen 

Several alternatives exist for erasing part or all of the 
screen. You can use the following commands: 

• Text to erase with the space bar. 
• Draw to redraw a figure in the background color. ('-., 
• Alter Color to change foreground and background 

colors. 
• Undo to remove the last change to the screen. 
• Erase to erase a part of the screen or Alt Erase to 

erase the entire screen to the current foreground color, 
background color, and special character. 

• Alt Undo to erase the entire screen to black. 

For more information, see the descriptions of each of 
these commands later in this chapter. 

Using Composite Video 

If you are preparing screens for composite video, select 
Displays from the Main Menu to change to 40-column 
format. 

Text Maker Commands 

Alter Color (A, Alt A) 

The A command changes every specified foreground or 
background color to another specified color within the 
elastic box area. The Alt A command changes every speci­
fied foreground or background color to another specified 
color on the entire screen. There are 16 foreground colors 
available, and 8 background colors. Each foreground color 
has been assigned a letter, from A (black) to P (bright ｾＮ＠
white). Each background color has been assigned a letter 
from A (black) to H (white). These assignments are shown 
to you after you start the A or Alt A command. 
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Using A and Alt A Commands 

1. Press A or Alt A. 

2. For the A command, extend and/or move the elastic 
box. 

3. For the A command, press Enter to display the color 
designations. 

4. Type your color change selections, and press Enter. 
When specifying foreground (f) or background (b) 
changes, you must enclose the color change selections 
in parentheses. 

For example: 

ha Change foreground and background from blue (b) 
to black (a). 

(fba) Change foreground (f) from blue (b) to black (a). 

ｾ＠ (bba) Change background (first b) from blue (second b) 
to black (a). 

(fbacd) Change foreground (f) from blue (b) to black (a) 
and from green (c) to cyan (d). 

You can also enter multiple changes with one statement. 
For example, (bbacd)(fkmln)ef tells Text Maker to 
change: 

• Background colors from "b" to "a" and from "c" to "d" 
• Foreground colors from "k" to "m" and "l" to "n" 
• Both foreground and background colors from "e" to 

"f." 
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Notes: 

1. Normal rules apply for the Esc key, the U command, 
and mouing the elastic box. (The normal rules are 
covered under each command's respective heading). 

2. You can use the A command to draw a solid filled box 
or to fill within an existing box. 

3. If the command ab ha is entered for a rectangular area 
containing half blue and half black, it will NOT result 
in a rectangular area containing all black. That is, Text 
Maker will not (1) Change all black to blue and then (2) 
Change all blue, including the blue that resulted from 
(1), to black. 

Box Draw (B) 

This command draws a rectangular shape in the current 
foreground and background color settings and in the 
current box frame. You can choose from a variety of 
special frames. When you press the - key while in the (\ 
Box command, Text Maker displays the next special box 
in its sequence. If you want to see the rest of Text 
Maker's special boxes, press the - key to rotate through 
all of the choices. 

Using B Command 

1. Press B. 

2. Extend and/or move the elastic box. 

3. To check or change text characters, or foreground and 
background colors, use function keys F5 through FlO. 

4. To change box frames, press the - key. 

5. Press Enter to draw the box and end the command, or 
press B to draw the box and maintain an elastic box. · 
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Notes: 

1. Normal rules apply for the Esc key, the U command, 
and moving the elastic box. 

2. You can produce symbols from the frame types by 
ｾ＠ drawing very small boxes. 

ｾ＠

I I I I 
l_L_J__J 

Fl=Help 

n :·, n r1 n .·· .. · ...... _:- I 

n n l't 

n rt n n n 
.... • I 

I I II 

I I II 

-F-B MAIN COMMAND MODE 

3. You can produce a rule from a frame type by drawing 
only one side of a box. 

I II I I I I I I II I I I I I I I I I I 111111111111111111111111111111 

Fl=Help - -F-B BOX 

ｾ＠ 4. For examples of ways to change the foreground and 
background colors of completed boxes without redrawing 
the box, see "Using the Color/Character Table" in the 
beginning of this chapter. 

5. For examples of ways to make boxes and their contents 
blink, see "Using the Color/Character Table" in the 
beginning of this chapter. 

6. To cause immediate changes in the foreground and 
background colors of the box you are drawing, use the 
Alt K command. (See "Immediate Palette" later in this 
chapter.) 

Box Frame Display (Alt B) 

This command displays all of Text Maker's special box 
frames. The frame that the Box command will use the 
next time it is started will be displayed in green. All other 
frames will be white. 
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Using the Alt B Command 

1. Press Alt B to display the box frames. 

2. Press +--, -+,or Alt Bone or more times to select the 
frame to be used the next time you use the Box 
command. ｾ＠

3. Press Enter to end. 

Note: Pressing the letter that corresponds to a Text 
Maker command will exit the Box Frames Display and 
begin the selected command. 

Constructing Frames Using Special 
Text Characters 

1. Press function key F5 or F6 to view the 
Color/Character Table. 

2. Move the cursor to select the character and press 
Enter ｾＬ＠

3. Use the Alt B command to display the box frames. 

4. Move the cursor to select the box frame constructed 
from special text characters. It's in the first position. 

5. Press Enter to end. 

Cut/Copy/Move (C) 

This command copies any area of a displayed screen image 
and holds it for later use by other commands. If you use 
the Cut (C) command with the Paste (P) command, you 
can "cut and paste" with portions of screens, which lets 
you either duplicate or move any area of a displayed 
screen to another area on the same or different screen. ｾ＠
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Using the C Command 

1. Position the cursor at the desired starting point. 

2. Press C. 

ｾ＠ 3. Extend and/or move the elastic box. 

4. Press Enter to copy the area inside the elastic box 
into a specially reserved area for later use with other 
commands. 

Steps to Copy an Area 

1. Position the cursor at the desired starting point. 
2. Press C. 
3. Extend or move the elastic box. 
4. Press Enter to copy the area inside the elastic box. 
5. Move the cursor to the area to receive the copy. 
6. Press P to display the copy. 
7. Use the cursor movement keys to position the copy 

exactly where you want it. 
8. Press Enter again to paste the copied area. 

Steps to Move an Area 

1. Check the Color/Character Table to make certain the 
settings for text character, foreground color, and back­
ground color are the settings you want to erase to. 

2. Position the cursor at the desired starting point. 
3. Press C. 
4. Extend or move the elastic box. 
5. Press C again. The area inside the elastic box is 

copied. 
6. Press E to erase the area inside the elastic box to the 

current settings. 
7. Press Enter to end Erase. 

ｾ＠ 8. Move the cursor to the area to receive the copy. 
9. Press P to display the copy. 
10. Use the cursor movement keys to position the copy 

exactly where you want it. 
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11. Press Enter again to paste the copy. 

Steps to Copy From Screen B to Screen A 

1. Use the Save option to save Screen A. 
2. Use the Get option to go from Screen A to Screen B. 
3. Position the cursor at the desired starting point. 
4. Press C. 
5. Extend or move the elastic box to enclose the area to 

be transferred to Screen A. 
6. Press Enter. The area inside the elastic box is copied. 
7. Use the Get option, then select Create or Edit to 

return to Screen A. 
8. On Screen A, move the cursor to the area to receive 

the copy. 
9. Press P to display the copy. 
10. Use the cursor movement keys to position the copy 

exactly where you want it. 
11. Press Enter again to paste the copied area. 

Steps to Copy From a Screen Library to Screen A ｾ＠

1. Press F2 one or more times to go to the desired screen 
in a Screen library. 

2. Position the cursor at the desired starting point. 
3. Press C. 
4. Extend or move the elastic box to enclose the area to 

be transferred to Screen A. 
5. Press Enter. The area inside the elastic box is copied. 
6. Use the U command to return to Screen A. 
7. On Screen A, move the cursor to the area to receive 

the copy. 
8. Press P to display the copy. 
9. Use the cursor movement keys to position the copy 

exactly where you want it. 
10. Press Enter again to paste the copy. 

6-30 



Notes: 

1. Normal rules apply for the Esc key, the U command, 
and moving the elastic box. 

2. You can paste the cut area multiple times. Text Maker 
retains it until you use another Cut command. 

Delete Lines (Alt D) 

This command lets you remove a line from a screen. 

Using the Alt D Command 

1. Move the cursor to the line you want to remove. 

2. Press Alt D. 

Notes: 

ｾ＠ 1. Normal rules apply for the U command. 

2. The last line on the screen moves up when you delete a 
line. For example, if you delete the first line of the 
screen, lines 2 through 24 appear as lines 1 through 23, 
and line 24 is new. 

Draw, Continuous Sketching (D) 

This command lets you draw a continuous line with the 
cursor movement keys. 

Using the D Command 

1. Position the cursor at the desired starting point. 

2. Press D. 

3. If desired, press the - key (either one), at any point 
on the continuous line to select a drawing option. 
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There are four special drawing options: single line, 
double line, dotted line, and special text character. 

4. Use the cursor movement keys to draw a continuous 
line straight up, straight down, straight to the left, and 
straight to the right. 

5. To check or change foreground and background colors 
or text characters at any point on the continuous line, 
use function keys F5 through FlO. 

6. Press Enter to redraw the line and end the command. 

or 

7. Press Esc to end the command without drawing the 
line on the screen. 

Steps to Draw a Corner 

When you are drawing a vertical line across a series of 
horizontal lines, the lines will meet in right-angle corners. Ｌｾ＠

However, sometimes when you try to make a horizontal 
line and a vertical line meet to form a corner, you can 
draw a line that's slightly short or slightly long, but they 
won't join to form a corner. Here's how to draw that right 
angle: 

1. Use an arrow key to draw the line you are trying to 
connect slightly over the base line. 

2. Press a different arrow key to go in another direction. 

a. If you are drawing the line with the -+ key, press 
the j, L or ｾ＠ key to complete the right angle. 

b. If you are drawing the line with the L key, press 
the ｾＮ＠ -+, or j key to complete the right angle. 

3. Press Enter to end the Draw command. 
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Steps to Erase Part of a Drawing 

1. Make blank the setting for the special text character 
in the Color/Character Table. 

2. Make the foreground/background colors the same 
ｾ＠ color as the background of the drawing. 

3. Position the cursor at the desired starting point. 

4. Press D. 

5. Move the cursor over the part you want to erase. 

6. Press Enter to end. 

Steps to Use Special Characters 

1. Press F5 or F6 to view the Color/Character Table. 

2. Move the cursor to the desired character in the 
f""'I Color/Character Table. 

3. Use the Draw Option Set command (-key) to select 
the character as the current drawing option. 

4. Use the Draw command to place the symbol on the 
screen. 

Notes: 

1. Normal rules apply for the Esc key and the U command. 
Because the U command will undo all drawing back to 
the last time the D command was used, you may want to 
press the D key intermittently to update the point to 
which you will undo your drawing. 

2. For examples of ways to change the draw color (the fore­
ground color) and the background color of entire figures 
without redrawing them, see "Using the Color/ Character 
Table" at the beginning of this chapter. 
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3. For examples of ways to make drawings blink, see 
"Using the Color/ Character Table" in the beginning of 
this chapter. 

4. To cause immediate changes in the foreground and 
background colors of the figure you are drawing, use the 
Alt K command. (See "Immediate Palette" later in this (\, 
chapter.) 

5. You cannot move the cursor diagonally in the Draw 
command. 

Draw Option Set(-) 

This command rotates the line type you can use in the 
Draw command and the frame type you can use in the Box 
Draw command. 

In the Draw command, you can choose from the following 
line types: 

• Single line 
• Double line 
• Dotted line 
• Special text character. 

In the Box Draw command, you can choose from 16 dif­
ferent frames. 

Using the - Command 

Press the - key (either one) one or more times to select 
the desired line type (in the Draw command) and frame 
type (in the Box Draw command). 
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Steps to Include a Special Character in the 
Choices 

1. Press F5 or F6 to view the Color/Character Table. 

2. Move the cursor to the desired character in the 
ｾ＠ Color/Character Table. 

3. Use the Draw Option Set command(-) to select the 
character as the current drawing choice. 

Notes: 

1. The draw option setting is good for the current session 
only. 

2. If you have not selected a special text character for the 
current session, you will rotate through a blank choice. 

3. If you are in the Draw command, the current setting is 
shown at the bottom of the screen as you press the -
key. 

4. The Draw Option Set command can be used at the 
beginning of the Draw command to set the line type or 
in the middle of the Draw command to change the line 
type for the next segment of the continuous line. 

5. The Draw Option Set command can be used at any time 
during the Box Draw command to select or change the 
frame type. 

Erase (E, Alt E) 

These commands erase the area within the elastic box or 
the entire screen to the current foreground color, back­
ground color, or special character. 
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Using the E Command 

1. Position the cursor at the desired starting point. 

2. Press E. 

3. Extend and/or move the elastic box. 

4. Press Enter. 

Using the Alt E Command 

Press Alt E. The entire screen is erased. 

Notes: 

1. For examples of different erasing techniques, see "Using 
the Color/Character Table" in the beginning of this 
chapter. 

2. To cause immediate changes in the special text character 
and in the foreground and background colors of the 
area you are erasing, use the Alt K command. (See 
"Immediate Palette" later in this chapter.) 

3. You can use the Erase command to draw solid or 
pattern-filled boxes by selecting foreground and back­
ground colors and special text characters from the 
Color/Character Table. 

Immediate Palette (Alt K) 

This command lets you change a portion of the 
Color/Character Table without displaying the palette, 
while you are using the Box, Draw, Erase, or Text 
command. Depending on which function key you press, 
the foreground, background, or special text character 
changes immediately. In Text, the color change affects the Ｌｾ＠

next character typed. In Draw, the color or character 
above the cursor and those that follow change. In Box and 
Erase, the part that was currently drawn or erased 
changes. 
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Using the Alt K Command 

1. Press Alt K. The letter I appears at the beginning of 
the hint text to indicate that the Alt K command is in 
operation. 

ｾＮ＠ 2. Press the proper function key to immediately change 
the special text character, foreground color, or back­
ground color selection in the Color/Character Table. 

F5 or F6 

F7 or FS 

F9 or FlO 

To select a text character to use in the 
Box, Draw, and Erase commands. 

To select a foreground color to use in 
the Box, Draw, Erase, and Text com­
mands. 

To select a background color to use in 
the Box, Draw, Erase, and Text com­
mands. 

3. Press Alt K to resume use of the Color/Character 
ｾ＠ Table. 

The Color/Character Table appears. 

Note: If you forget to end the Alt K command, you won't 
be able to use the function keys or Alt J to display the 
color/character table. 

Insert Lines (Alt I) 

This command lets you insert a blank line immediately 
above the line the cursor is on. 
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Using the Alt I Command 

1. Move the cursor to the line immediately below where 
you want a blank line inserted. 

2. Press Alt I. 

Notes: 

1. Normal rules apply for the U command. 

2. The last line on the screen is removed in order to make 
room for the new line. For example, if you insert a blank 
line as the first line on the screen, lines 1 through 23 
appear as lines 2 through 24, and the original line 24 
disappears. 

Paste (P) 

This command writes (pastes) the area previously defined 
by the Cut (C) command, letting you repeat an image at 
one or more locations on your screen. (\ 

Using the P Command 

1. After using the C command, press P to display the cut 
area. 

2. Use the cursor movement keys to position the cut area 
exactly where you want to paste it. 

3. Press Enter to paste the cut area. 

Note: Refer to the Cut (C) command for more information 
about cutting an area. 
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Quit (Esc Key) 

Use this command to leave the editing screen and return 
to the Main Menu and to exit commands. 

If you want to keep your screen for later use, be sure you 
save your screen (use the Save option) before exiting from 
the Main Menu. 

Using the Esc Command 

Press Esc to exit from a command. From the Main 
Command mode, press Esc to return to the main menu. 
Select Create or Edit to return to the editing screen. 

Screen Libraries (F2) 

The F2 command displays screens in the currently active 
library and lets you page through them. 

Using the TM.LIB Library 

1. Press F2. 

2. Press F2 again to rotate forward through the various 
screens in the library or press Shift - F2 to rotate 
backward. 

3. Use the Undo (U) command to return to the screen 
you came from. 

Creating an Alternate Library 

1. Create a screen to be stored in an alternate library. 

2. Save the screen using the Save option at the Main 
Menu. Select a new filename and use a .LIB exten­
sion. 
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3. Add to the library by using the filename and extension 
you've selected for the alternate library. Each time 
you save a screen, it is added to the end of the library 
file. 

Using an Alternate Library 

1. Select the Select Library Name option from the Text 
Maker Main Menu. The Select Library Name panel 
appears, displaying the default drive and directory 
path. 

2. Type the name of the library and press Enter or use 
the File Services panel to select another library. 

3. Return to the Create or Edit screen. 

4. Press F2 to rotate through the screens in this library. 

5. Use the Undo (U) command to return to the screen 
you came from. 

Moving an Image to a Screen in the Developing 
Story 

1. Press F2 until the screen with the image you want 
appears on the screen. 

2. Use the Cut (C) command to make a copy of it. 

3. Use the Undo (U) command to return to your screen. 

4. Use the Paste (P) command to put the design into 
your screen. 
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Adding a Screen to a Screen Library 

1. Retrieve the screen using the Get option from the 
Main Menu. 

2. To store the screen in a library such as TM.LIB, select 
the Save option from the Main Menu. Specify a path 
to the subdirectory that has the IBM Storyboard Plus 
programs. Type TM.LIB and press Enter. The screen 
will be added at the end of TM.LIB. Screens can also 
be added to library files you have created yourself 
using the same method. 

Set Palette (Alt S) 

Use this command to change the foreground color, back­
ground color, and blink setting in the Color/Character 
Table to the settings of the area under the cursor. 

Using the Set Palette Command 

1. Move the cursor to the position that contains the fore­
ground color, background color, and blink setting you 
want. 

2. Press Alt S. The settings in the Color/Character Table 
will be changed to the settings above the cursor. 

Text Entry (T) 

This command lets you type text onto the screen. You can 
type anywhere by positioning the cursor where you want 
to start. 
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Using the T Command 

1. Position the cursor at the desired starting point. 

2. Press T. 

3. Type the text you want. 

4. To check or change foreground and background colors, 
use function keys F7 through FlO. 

5. Press Enter to end the command. 

Steps to Erase Text or Part of a Drawing 

1. Make the foreground/background colors the same 
color as the background the text or drawing is on. 

2. Press T. 

3. Use the spacebar to move the cursor over the part you 
want to erase. ｾ＠

4. Press Enter to end the command. 

Notes: 

1. You cannot move the cursor diagonally. 

2. Moving the cursor does not change the color above the 
cursor unless you press the spacebar. 

3. When you are in the Text command and responding to a 
prompt, the Home key moves you to the first character of 
the line you are on. The End key moves you to the space 
after the last non-blank character of the line you are on. 

4. To include symbols or letters from foreign alphabets in 
your text, see the "Using the Color/Character Table" ｾ＠
earlier in this chapter. 

5. For examples of ways to change the color of letters and 
the background color without retyping text, see "Using 
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the Color/Character Table" in the beginning of this 
chapter. 

6. For examples of ways to make words blink, see "Using 
the Color/Character Table" in the beginning of this 
chapter. 

7. To cause immediate changes in the foreground and 
background colors of the text you are typing, use the Alt 
Kor the Alt S command. (See "Immediate Palette (Alt 
K)" and "Set Palette (Alt S)" earlier in this chapter.) 

Undo (U, Alt U) 

The U command lets you undo the last change to the 
screen, which is helpful when you make a mistake. 

The Alt U command erases the screen to a black back­
ground. 

ｾ＠ Using U and Alt U Commands 

1. Press U to remove the last change made to the screen. 
For example, if wording or placement following a Text 
(T) command is not correct, a U command removes the 
text just entered. 

2. Or, press Alt U to clear the screen. 

Notes: 

1. If you want to restore what you have just removed with 
either U or Alt U, press U again. This will reverse the 
undo. 

2. The U command is also used to return from a screen 
library to your current screen. See "Screen Libraries" 
earlier in this chapter. 
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X,Y Coordinate Display (X) 

This command displays the current location of the cursor 
by column and line number. This location is displayed at 
the top right of the screen and is updated as you move the 
cursor. 

Using the X Command 

1. Press X to view location information. 

2. Press X again to clear the location information. 

Hint Text Display (Alt X) 

This command either displays or omits the hint text 
shown at the bottom of the screen after a command is 
started. You may not want the hint text to appear when 
you are entering information on line 24 of the screen. 

Using the Alt X Command 

• Press Alt X to omit hint text if it is being displayed. 
The setting lasts only for the current session. 

• Press Alt X to display hint text if it is not being dis­
played. 
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Story Teller 

Story Teller is the program you use to run stories previously 
created with Story Editor. 

Story Teller begins with the first line in your show and 
continues in the same way as when you select Run Story in 
Story Editor, except that it also chains to another story if it 
encounters a /TELL command in the story being shown. 

The Story Teller module consists of the files ST.EXE and 
STl.PDR. Both of these files are required to run a story. 

Assembling a Story 

Additional copies of only the Story Teller module may be made 
to allow the user to distribute and show stories, provided each (\ 
diskette copy is labeled as follows: 
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Starting Story Teller 

If your Storyboard Plus programs are in a DOS subdirec­
tory (such as STORYBD, change to that directory by 

ｾ＠ using the Change Directory command. For example: 

C > cd\ storybd 

You can start Story Teller in several ways. You can start 
it without a story name. For example: 

C>st 

You will then be prompted to supply the STORYNAME. 
Enter the name of the story along with the drive and path, 
if needed. 

You can start Story Teller naming the drive, path, and 
name of the story at the same time, and bypassing the 
prompt. For example: 

ｾ＠ C >st c:\picfileA\mystory 

Or if Story Teller is on one drive and the story is on 
another: 

A> st b:mystory 

It is recommended that your story and all the files used in 
your story be placed in a single subdirectory or diskette. 

Or you can start Story Teller from one diskette without 
specifying a story name, but when prompted for 
STORYNAME, change to a second diskette having the 
story and pictures. Then enter the story name and run the 
show. 

Although Story Editor and Story Teller use the .SH- file 
extension to distinguish story files from other types of 
files, you do not need to enter the .SH- file extension 
after the story name. 
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Using Special Keys 

When Story Teller is running, the following keys can be 
used: 

F5 This function key causes the story to be 
presented one step at a time. Press F5 to 
continue stepping through the story. 

F6 This function key resumes normal story 
running. 

FlO This function key temporarily pauses the 
story. Press any key to resume the story. 

Spacebar Skips the current Wait period. 

Esc This key stops the story after the current 
picture is displayed. You are asked if you 
want to continue Story Teller. A "Y" 
response continues the story, but a "N" 
response stops Story Teller and return to 
DOS. 

- This key causes Story Teller to back up to 
the previous full picture or previous line 
with a period in the label field, and then 
wait until you press any key to continue. 

I Entering the slash (/) key followed by a 
label used in the story will cause an imme-
diate branch to the line in the story con-
taining that label. The label name entered 
does not display. If the label cannot be 
found, a beep sounds. 

+ This key returns to either the point in the 
story where you began backing up (using 
the - key), or to the point where you first 
took a direct branch using the / key. The 
story waits until you press any key to con-
tinue. 
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Using a Joystick 

You can also control the presentation sequence with the 
two buttons on a joystick connected to the IBM Game 
Control Adapter card. Button A advances the show if the 
show is waiting for any key to be pressed before contin­
uing, while button B backs up the story in the same 
manner as the - key. 

Any device that will close a contact across the IBM Game 
Control Adapter pins 2 and 4 will have the same effect as 
joystick button A, while a contact c1osure across pins 5 
and 7 will have the same effect as joystick button B. 
Buttons and momentary switches can be used. However, a 
convenient device is the Kodak EC-1 Remote Control for 
Kodak Carousel slide projectors. Note that you will need 
to construct an adapter so that the 5-pin plug on the EC-1 
can be connected to the 15-pin D-Shell Connector on the 
IBM Game Control Adapter card. 
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Appendix A. Messages 

ｾ＠ Storyboard Plus displays a message whenever it 
encounters an error condition. Most errors are minor and 
easily corrected. The errors are the result of physical lim­
itations or problems with certain elements of your com­
puter system. 

When you encounter one of these messages, simply locate 
the message in the following list and take the corrective 
action described. The messages Storyboard Plus produces 
and their meanings are listed in alphabetical order. 

Picture Maker and Story Editor 

Block not found. 
Return to story editing? 

ｾ＠ You have tried to copy or delete a block of lines and there 
is no block marked. 

Cannot create file. RETRY? 

Picture Maker/Story Editor attempted to store a picture 
on a disk and was unsuccessful. The probable cause is 
that the directory is full. The best solution is to store the 
drawing on a blank, formatted diskette. If you are storing 
your drawings on a fixed disk, create a new directory or 
erase files from your existing directory. 

Cannot display image 000. Image created 
in (resolution mode) mode. 
Press Button 1 for next image 
or press Button 2 to exit. 

You have selected an image to get or view in the Get 
Capture File panel which is contained in a file created 
with the Picture Taker program and Picture Maker/Story 
Editor cannot display this image. The image was created 
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in a higher graphics resolution, or if you are using 
Picture Maker, the image may have been created in text 
mode. Press Button 1 to move to the next image or 
Button 2 to return to the Get Capture File panel. 

Cannot find digitize card. 
Return to Digitize panel? 

You have selected YES on the Digitize panel, but the 
required digitize card cannot be found. Picture Maker 
requires special equipment to use the Digitize function. 
This equipment is either not installed in your computer or 
the jumpers are not set correctly on the digitize card. 
Please refer to the Digitize option in the "Using Picture 
Maker" section for specific information on the Chorus 
PC-EYE System hardware. 

Cannot find DIGITIZE.PDR file. 
Return to drawing area? 

Picture Maker cannot find the DIGITIZE.PDR file and 
this file is required for the Digitize option. The file may 
have been erased, renamed, or be on another one of the 
program diskettes if you are using a diskette-based system 
and you swapped diskettes. r---, 

Check to see if the file exists on your original PM 
program diskette (Diskette #2) and copy it to the disk on 
which you are trying to run Picture Maker. If you are 
using a diskette-based system, insert the PM program 
diskette (Diskette #2) into the default drive. 

To return to the drawing area, move the pointer to YES 
and press Button 1 if you are using anything other than 
the keyboard for the input device, or press Y if you are 
using the keyboard as the input device. 

Cannot find 
(LABEL) label. 
Return to Story Editor? 

Story Editor cannot find the label you have entered. ｾ＠
Select YES to return to story editing and check to see if 
you have entered the correct label. 
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Cannot find OTHERPRN.PDR file. 
Return to (drawing area/story editing) 

Picture Maker/Story Editor cannot find the 
OTHERPRN.PDR file and this file is required for printing 
when Other is selected as the printer. 

To return to the drawing area or story editing, move the 
pointer to YES and press Button 1 if you are using any· 
thing other than the keyboard for the input device, or 
press Y if you are using the keyboard as the input device. 

Cannot find PM.HLP file. 
Press any key to return to Drawing Area. 

You have pressed the Fl key for help, but Picture Maker 
can not find the PM.HLP file. The file may have been 
erased, renamed, or be on another one of the program 
diskettes if you are using a diskette-based system and you 
swapped diskettes. 

Check to see if the file exists on your original PM 
program diskette (Diskette #2) and copy it to the disk on 
which you are trying to run Picture Maker. If you are 
using a diskette-based system, insert the PM program 
diskette (Diskette #2) into the default drive and press Fl 
again. 

Cannot find PRINTER .PDR file. 
Return to (drawing area/story editing)? 

Picture Maker/Story Editor cannot find the 
PRINTER.PDR file and this file is required for printing. 
The file may have been erased, renamed, or be on another 
one of the program diskettes if you are using a diskette­
based system and you swapped diskettes. 

Check to see if the file exists on your original program 
diskette and copy it to the disk on which you are trying to 
run Picture Maker. If you are using a diskette-based 
system, insert the PM program diskette (Diskette #2) into 
the default drive. 

To return to the drawing area, move the pointer to YES 
and press Button 1 if you are using anything other than 
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the keyboard for the input device, or press Y if you are 
using the keyboard as the input device. 

Cannot find ROMAN .FAC file. RETRY? 

The ROMAN.FAC file cannot be found. The file may have 
been erased, renamed or be on another one of the program 
diskettes if you are using a diskette-based system and you 
swapped diskettes. 

Check to see if the file exists on your original program 
diskette and copy it to the disk on which you are trying to 
run Picture Maker. If you are using a diskette based 
system, insert the PM Program diskette (Diskette #2) into 
the default drive. 

If you are using a diskette-based system and are in text 
entry mode, insert the PM program diskette (Diskette #2) 
into the default drive and select YES to retry or select 
NO to have the Get Font File Services panel display on 
the screen so you can select a new font. 

If you are using a diskette-based system and select the Set 
Attributes panel, insert the PM program diskette (Diskette ('\, 
#2) into the default drive and select YES to retry or NO 
to display the Set Attributes panel. 

Cannot find SE.HLP file. 
Press any key to return to Editing Area. 

You have pressed the Fl key for help, but Story Editor 
cannot find the SE.HLP file. The file may have been 
erased, renamed, or be on another one of the program 
diskettes if you are using a diskette-based system and you 
swapped diskettes. 

Check to see if the file exists on your original SE program 
diskette and copy it to the disk on which you are trying to 
run Story Editor. If you are using a diskette based system, 
insert the SE program diskette into the default drive and 
press Fl again. ｾ＠

Cannot gain access to the card. 
Hardware or software missing. 
Return to story editing? 
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You have tried to used the Record Voice option or the 
/SPEAK, /SOUND EFFECTS, or /MUSIC ON command 
and you do not have the correct hardware or software 
installed in your system. 

In order to use the Record Voice option or the /SPEAK 
ｾ＠ command, you need to have either the IBM Voice Commu­

nications Option or the IBM Personal System/2 Speech 
Adapter installed in your system. If you are using the IBM 
Voice Communications Option, you must run the 
VOICE.BAT file before you start Story Editor. 

In order to use the /SOUND EFFECTS or /MUSIC ON 
command, you need to have the IBM Music Feature 
installed in your system and you must run KAPI.EXE 
before starting Story Editor. 

Cannot get file 

Locate the second line of the message in this list to find 
the corrective action you should take. 

Cannot get file. 
Continue? 

The file you have entered cannot be found. Check to see if 
you have entered the correct filename and that the file 
exists. 

Cannot get file. File created 
in ( sp_ecific resolution mode) mode. RETRY? 

Picture Maker/Story Editor cannot display the picture file 
you have selected in the resolution mode you are using. 
The message displays the resolution mode in which the 
picture file was created. Please refer to "Chapter 1. 
Getting Started" for the specific modes in which picture 
files can be transferred. 

Cannot print picture. 
Printer is not ready. RETRY? 

You have tried to print and your printer is not ready. Be 
sure your printer is switched on, on-line, properly loaded 
with paper, and connected to your computer. 
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To continue printing: 

1. Correct the problem with your printer. 

2. Align the paper to print the picture in the proper 
location. 

3. Turn the printer off momentarily and then back on 
again to reset the printer's buffer. 

4. Select YES to retry the printer. 

Cannot print story. 
Printer is not ready. RETRY? 

You have tried to print a story and your printer is not 
ready. Be sure your printer is switched on, is on-line, 
properly loaded with paper and connected to your com­
puter. 

To continue printing: 

1. Correct the problem with your printer. 

2. Select YES to retry the printer. 

Cannot read disk. 

Locate the second line of the message in this list to find 
the corrective action you should take. 

Disk is full. RETRY? 

Picture Maker/Story Editor attempted to store your 
picture on a disk and found that not enough space was 
available. If you have some unnecessary files on the disk, 
you can free some space by removing them. 

Disk is write-protected. RETRY? 

Picture Maker/Story Editor attempted to write to a write- ｾ＠
protected diskette. Ensure that the diskette is not write­
protected and select YES to retry. Select NO to return to 
the File Services panel. 
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Drive is not ready. RETRY? 

The diskette drive door is open. Ensure that a diskette is 
inserted into the drive and close the door. 

File about to be removed. Continue? 

ｾＮ＠ Picture Maker/Story Editor is about to erase the high­
lighted filename from the disk. Select YES to remove the 
file from the disk or NO to return to the File Services 
panel. 

File about to be replaced. Continue? 

Picture Maker/Story Editor is about to save the picture 
over an existing filename. Select YES to save this picture 
and overwrite the existing contents of the selected 
filename or NO to return to the File Services panel. 

File is not in .ESQ format. RETRY? 

The file you are attempting to retrieve for use with the 
/MUSIC ON or /SOUND EFFECTS command is not in the 
.ESQ format acceptable to Story Editor. 

File is not in .FAC format. RETRY? 

The file you are attempting to retrieve is not in a .F AC 
format acceptable to Picture Maker. The only .FAC 
formats acceptable to Picture Maker besides its own fonts 
files are PC Storyboard Picture Maker .FAC files. 

File is not in .LBR format. RETRY? 

The file you are attempting to retrieve is not in the .LBR 
format acceptable to Picture Maker. 

File is not in .PIC format. RETRY? 

The file you are attempting to retrieve is not in a .PIC 
format acceptable to Picture Maker/Story Editor. The 
only Picture Maker's own picture files are: Picture 
Maker .PIC files created with PC Storyboard, BSA VE 
files, Drawing Assistant 1.0 .ART and .PIC files, Graphing 
Assistant 2.0 Assistant Series Picture files and PCjr. 
Colorpaint files. 
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File is not in .SH- format. RETRY? 

The story file you are attempting to retrieve is not in a 
.SH- format acceptable to Story Editor. The only valid 
.SH- formats acceptable to Story Editor besides its own 
story files are PC Storyboard Story Editor .SH- files. 

File is not in .SPK format. RETRY? 

The file you are attempting to retrieve for use with the 
/SPEAK command is not in the .SPK format acceptable to 
Story Editor. 

File is not in .SPR format. RETRY? 

The file you are attempting to retrieve for use with the 
/MOVE SPRITE command is not in the .SPR format 
acceptable to Story Editor. 

File not removed. 

Locate the second line of the message in this list to find 
the corrective action you should take. 

File not saved. 

Locate the second line of the message in this list to find 
the corrective action you should take. 

Font Editor content will be erased 
to use Switch Page. Continue? 

Your computer does not have enough memory to use the 
Switch Page and the Font Editor options at the same time. 
If you use Switch Page, the contents of Font Editor will 
be erased. If you want to keep the contents of the Font 
Editor, select NO and use the Save Font option in Font 
Editor to save your latest changes. 

Font editor function not active. 
Additional memory required. 
Return to drawing area? 

Your computer must have additional memory to use Font 
Editor. The additional memory required for each mode is 
64Kb. 
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I/O error. RETRY? 

Some physical problem has been encountered with the 
disk drive, the disk controller, or the diskette. Some pos­
sible causes are: 

ｾ＠ Disk drive door open. Close the door. 

Malfunction. Stop using this diskette. If the I/O error per­
sists, try a new diskette, or take the disk drive to your 
dealer for testing. 

Label cannot be found. 
Continue? 

The label you have entered cannot be found. 

Memory is full. 
Return to story editing? 

You have tried to insert a line, copy a block of lines, or 
merge a story into the story table and the story table is 
full. 

ｾ＠ If you need to add more lines to a story, you can delete 
unneeded lines or create a second story and use the 
/TELL command to join the two stories together. 

Not enough memory to run 
PM.EXE. 
Return to story editing? 

You have selected the Picture Maker option on the Modes 
menu and there is not enough memory available in your 
system to run the program. 

Only .EXE and .COM files are allowed. 
Continue? 

You are using the /EXEC command and have selected a 
file that is not a .EXE or .COM file. Check to see if you 
have selected the correct filename. Select YES to return 
to the Get .EXE File Services panel and select a new 
filename. 

Picture will be added to the file. Continue? 
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Picture Maker adds the picture being saved to the end of 
the selected file. Picture Maker recognizes this file as one 
that has been created in the Picture Taker program with 
multiple images under the same file name. Select YES to 
add this picture to the selected filename or select NO to 
return to the File Services panel. 

Saving select box only. Continue? 

Picture Maker will save only the portion of the picture 
framed by the Select box. Select YES if you want only the 
portion of the picture framed by the Select box to be saved 
or select NO to return to File Services panel. 

Switch Page content will be erased 
to use Font Editor. Continue? 

Your computer does not have enough memory to use the 
Font Editor and Switch Page options at the same time. If 
you use the Font Editor, the contents of Switch Page will 
be erased. If you want to keep the contents of the Switch 
Page, select NO and use the Save Picture option on the 
File menu. 

Switch page function not active. 
Additional memory required. 
Return to drawing area? 

Your computer must have additional memory to use 
Switch Page in four of the resolution/color modes. The 
additional memory required for each mode is: 

Mode Additional Memory 
320 X 200 - 4 OKb 
320 X 200 - 256 64Kb 
640 X 200 - 16 64Kb 
640 X 350 - 16 128Kb 
640 X 480 - 16 128Kb 

The graphics mode you selected 
cannot be supported with your 
hardware. (Program name) has 
selected the 320 x 200 - 4 color 
mode for you. 

Press Enter to continue. 
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The graphics mode you selected in the Quick Menu/Setup 
program cannot be supported with your hardware. Picture 
Maker/Story Editor has automatically placed the program 
in the 320 X 200 - 4 color mode. Please refer to "Chapter 1. 
Getting Started" for specific information on hardware and 
resolution modes. 

This label exists already. 
Continue? 

The label you have entered already exists in the story. If 
you would like to change the label you entered, select 
NO. If you would like to continue editing the story 
without changing the label, select YES. 

You don't have necessary graphics 
hardware to run the program. 

Your computer does not have the necessary graphics hard­
ware to run the program. Please refer to "Chapter 1. 
Getting Started" for specific information on supported 
hardware and resolution modes. 

You have selected COMl (or COM2) for the 
ｾ＠ DOS Device Name and the card cannot be found. 

A serial card is not located on the COM port that you 
selected. You may have selected the wrong serial port or 
you have selected the wrong input device. First, check to 
make sure you selected the correct input device. If you 
have, use the Input Device Setup option and select the 
correct serial port. 

You have selected COM! (or COM2) for the 
Printer Port and the card cannot be found. 

A serial card is not located on the COM port that you 
selected. You may have selected the wrong serial port or 
you have selected the wrong printer. First, check to make 
sure you selected the correct printer. If you have, use the 
Printer Port option and select the correct serial port. 

You have selected LPTl (or LTP2, LPT3) for the 
Printer Port and the card cannot be found. 
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A parallel card is not located on the printer port that you 
selected. You may have selected the wrong printer port or 
you may have selected the wrong printer. First, check to 
make sure you selected the correct printer. If you have, 
use the Printer Port option and select the correct printer 
port. 

You have selected the Other option and the 
external device driver cannot be found. 

Exit Picture Maker/Story Editor and install the external 
driver for your input device. Then restart the program. 

You need more memory to run the program. 

Your computer does not have enough memory to run in 
the resolution mode you selected in the Quick 
Menu/Setup program. Please refer to "Chapter 1. Getting 
Started" for specific information on supported resolution 
modes and their minimum memory requirements. 

Picture Taker 

Drive is not ready. 

The diskette drive door is open. Ensure that a diskette is 
inserted into the drive and close the door. 

Drive I/O error. 

Some physical problem has been encountered with the 
disk drive, the disk controller, or the diskette. Some pos­
sible causes are: 

Disk drive door open. Close the door. 

Malfunction. Stop using this diskette. If the 1/0 error per­
sists, try a new diskette, or take the disk drive to your 
dealer for testing. 

Drive\path\f ilename you have selected 
is not in DOS format. 
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The drive\path\filename you have entered is not correct. 
Check to ensure that the drive\path\filename is entered 
correctly. 

Drive\path you have selected cannot 
be found. 

You have entered a drive\path and Picture Taker cannot 
find it. Check to ensure that the drive\path was entered 
correctly. 

Text Maker 

Cannot change library. 

Locate the second sentence of the message in this list to 
find the corrective action you should take. 

Cannot create file. 

Text Maker attempted to store a text screen on a disk and 
was unsuccessful. The probable cause is that the directory 
is full. The best solution is store the text screen file on a 
blank, formatted diskette. If you are storing your text 
screens on a fixed disk, create a new directory or erase 
files from your existing directory. 

Cannot get file. 

Locate the second sentence of the message in this list to 
find the corrective action you should take. 

Disk is full. 

Text Maker attempted to store your picture on a disk and 
found that not enough space was available. If you have 
some unnecessary files on the disk, free some space by 
removing them. 

Disk is write-protected. 

Text Maker attempted to write to a write-protected 
diskette. Ensure that the diskette is not write-protected 
and retry. 
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Drive is not ready. 

Text Maker attempted to access a disk and was unsuc­
cessful. The probable cause is that the drive door is open. 
Close the drive door and retry. 

ERROR in Alter Color specification: 
Invalid characters or format. No changes 
were made. 

The characters entered for the Alter Color specification or 
the format used were incorrect. After selecting the Alter 
Color command, press Fl for help on the correct format 
for Alter Color specifications. 

File extension must be .CAP or .LIB. 

You have selected a file for your active library with an 
extension other than .CAP or .LIB. If the file is in a 
library file format, rename it with a .CAP or .LIB exten­
sion to use it as a library. 

File is in an unusable format or is damaged. 

The file you are attempting to retrieve is not in a format ｾ＠
usable by Text Maker. The only formats Text Maker can 
use are: files created by Text Maker, text screens in a 
.CAP file created with Picture Taker, or .LIB files created 
from captured text screens. 

File not removed. 

Locate the second sentence of the message in this list to 
find the corrective action you should take. 

File not saved. 

Locate the second sentence of the message in this list to 
find the corrective action you should take. 

I/O error. 

Some physical problem has been encountered with the (\, 
disk drive, the disk controller, or the diskette. Some pos-
sible causes are: 
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The diskette is not formatted. Check to see that the 
correct diskette is inserted. 

Malfunction. Stop using this diskette. If the 1/0 error per­
sists, try a new diskette, or take the disk drive to your 
dealer for testing. 

Screen not appended to file. File is in invalid 
format. 

Text Maker cannot use the file in which you are trying to 
store your text screen. Save the text screen in a new file. 

Text Maker cannot find STB.PRO. 
Press 'Esc' to exit. 

Text Maker must read the STE.PRO file before beginning 
the program. The file may have been erased or renamed. 

Check to see if the file exists on your original Storyboard 
Plus Diskette #1 and copy it to the disk on which you are 
trying to run Text Maker. 

Text Maker cannot find your file. 

Text Maker cannot find the file in the current directory. 
Verify that you have entered the drive and directory 
names where your file is stored. 

Text Maker requires more memory to run. 

There is not enough memory available to run Text Maker. 
You may be running other programs which are using 
memory. Remove them from memory and retry running 
Text Maker. 

The file contains no text screens. 

The file selected as the current library is in the correct 
library format, but contains only graphic images. Choose 
another file that contains text screens for the active 

ｾ＠ library. 

The file is not in a library file format. 
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The file selected as the current library is not in a format 
usable by Text Maker. Choose another file for the active 
library. 

The file or device name is incorrect. 

The file or device name was not entered correctly. Check 
that the drive and directory information are valid. Check r-"\ 
that the filename was entered properly. 

The file TM.CAP is not in drive (drive) 
or it is improperly formatted. Please correct 
this and re-run Text Maker. Press 'Esc' to exit. 

The TM.CAP file is required when using Text Maker. The 
file may have been erased or renamed. 

Check to see if the file exists on your original TM 
program diskette and copy it to the disk on which you are 
trying to run Text Maker. If you are using a diskette­
based system, make sure that TM.CAP is on the TM 
program diskette. 

The specified screen number is not a text screen. 

You have selected a graphic image contained in a file 
created with the Picture Taker program and Text Maker 
cannot display graphic image files. 

The specified screen number is too large or is 
invalid. 

You have selected a text screen from a file containing 
multiple screen images and the sequence number is larger 
than the sequence number of the last screen in the file or 
is not a valid number. Check to make sure the sequence 
number of the screen you are trying to retrieve is correct. 

The Text Maker help file is either damaged 
or cannot be found. 

You have pressed the Fl key for help, but Text Maker 
cannot find the TM.HLP file. The file may have been r-'\ 
erased, renamed, or is on another one of the program 
diskettes if you are using a diskette-based system and you 
swapped diskettes. 
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Check to see if the file exists on your original TM 
program diskette and copy it to the disk on which you are 
trying to run Text Maker. If you are using a diskette­
based system, insert the TM program diskette into the 
default drive and press Fl again. 

ｾ＠ Unable to paste; no cut exists. 
Please cut first. 

You have attempted to use the Paste command, but no cut 
area exists. First cut an area with the Cut command, and 
then attempt the Paste command again. 

Warning: A color was not in picture 
or background value out of range. 
All valid changes were made. 

Your Alter Color specification contained a color that was 
not found in your text screen or you specified a color 
other than A through H for a background color change. 
Verify your color specifications and select the Alter Color 
command again. 

You are about to overwrite the working copy. 
Get and overwrite (y/n)? [n] 

Text Maker is about to replace the text screen currently 
displayed on the Create or Edit screen with the the one 
you're retrieving. Type Y to replace the current text 
screen. Type N to continue editing the current text screen. 

You are about to remove this file. If you do, 
the picture in it will be lost. 
Remove (y/n)? [n] · 

Text Maker is about to erase the specified filename from 
the disk. Type Y to remove the file from the disk or type 
N to return to the Remove File panel. 

You are about to save this file and 
overwrite the same file 
on disk. Save and overwrite? (y/n)? [n] 

Text Maker is about to save the text screen over an 
existing filename. Type Y to save this picture and over­
write the existing contents of the selected filename or type 
N to return to the Save File panel. 
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Your display cannot show 40 columns. 

The display you are currently using cannot show text 
screens in 40-column format. Change displays or display 
your text screens in 80-column format. 

Your screen has been added to the file. 

Text Maker has added the picture being saved to the end 
of the selected file. Text Maker recognizes this file as one 
that contains multiple images under the same file name. 
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Appendix B. Supported Hardware 

This appendix lists the hardware supported by Storyboard 
Plus. 

CPUs 

• IBM Personal System/2 Model 30 

• IBM Personal System/2 Model 50 

• IBM Personal System/2 Model 60 

• IBM PCjr. 

• IBM Personal Computer 

• IBM Personal Computer XT™, Models 086, 087, 088, 
089, 286, and 589 

• IBM Personal Computer AT®, Models 099, 239, 319 and 
339 

• IBM PC Convertible 

• IBM Portable Personal Computer 

• IBM 3270 Personal Computer (320 X 200 - 4 color mode 
only) 

• IBM 3270 Personal Computer AT® (320 X 200 - 4 color 
mode only) 

• IBM 3270 Personal Computer/G (320 X 200 - 4 color 
mode only). 
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Graphics Cards 

• IBM Color Graphics Adapter 

• IBM Enhanced Graphics Adapter 

• IBM 3270 PC AP A Adapter 

• IBM Personal System/2 Adapter. 

Note: The Graphics Memory Expansion Module and 
Memory Kit for the EGA is required for the 640 X 200 - 16 
color mode and the 640 X 350 - 16 color mode. 

Displays 

• IBM Color Display 

• IBM PCjr. Color Display 

• IBM Enhanced Color Display 

• IBM PC Convertible Color Display 

• IBM 3270 PC Color Display 

• IBM Personal System/2 8512 Display 

• IBM Personal System/2 8513 Display 

• IBM Personal System/2 8514 Display. 
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ｾ＠

Printers 

• IBM Color Printer 

• IBM Color Jetprinter 

• IBM Compact Printer 

• IBM Graphics Printer 

• IBM Proprinter 

• IBM Proprinter XL 

• IBM Proprinter X24 

• IBM Proprinter XL24 

• IBM Quietwriter Model 2 

• IBM Quietwriter III Printer 

• IBM 5140 System Printer 

• IBM Pageprinter 

• C. Itoh ProWriter, model number 85101 

• Epson FX80, FXlOO, MX 80, MX 100, RX 80, and RX 
1002 

• Hewlett-Packard LaserJet+ 3 

• Hewlett-Packard LaserJet 500 + 4 

C. ltoh Pro Writer is a trademark of C. ltoh Electronics, Inc. 
2 Epson is a registered trademark of Epson America, Inc. 
3 Hewlett-Packard LaserJet+ is a trademark of Hewlett-Packard Cor­

poration. 
4 Hewlett-Packard LaserJet 500+ is a trademark of Hewlett-Packard 

Corporation. 
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• IDS Prism 1235 

• NEC 8023, model number 8TC-Hl66 

• Okidata 82A7 

• Quadram Quadjet QJ9000.8 

Input Device 

• Keyboard 

• Joystick (IBM or any IBM compatible) 

• IBM Personal System/2 Mouse 

• Microsoft Mouse, model number 039-099, (serial inter­
face)9 

• Mouse Systems PC Mouse, part number 900120-214, 
(serial interface)10 

Note: The IBM PC and PC/XT Mouse is compatible 
with Mouse Systems PC Mouse, 3- button serial). 

• Visi On Mouse, part number 69910-1011, (serial inter­
face)11 

• Graphics Tablets 

- Summagraphics Summasketch MM120l 12 

5 IDS Prism is a trademark of Integral Data Systems, Inc. 
6 NEC is a trademark of Nippon Electric Corporation. 

('\ 

Okidata is a trademark of Okidata Corporation. Ｌｾ＠
B QuadJet and Quadram are trademarks of Quadram Corporation. 
9 Microsoft is a registered trademark of Microsoft Corporation. 
10 Mouse System is a trademark of Mouse Systems Corporation. 
11 Visi On is trademark of VisiCorp. 
12 Summagraphics is a registered trademark of Summagraphics Corpo­

ration. 
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Kurta Series One Tablets13 

Kurta Series Two Tablets. 

• Video Input Device 

Chorus PC-Eye 1000 Video Capture Board 

Chorus PC-Eye 1100 Video Capture Board 

Chorus PC-Eye 1200 Video Capture Board 

Chorus CA-1600 RGB Camera. 

• Frame advance (For Story Teller) 

- Kodak EC-1 Remote Control. 

• Sound Cards 

IBM Music Feature 

ｾ＠ IBM Personal System/2 Speech Adapter 

IBM Voice Communications Card. 

Notes: 

1. As of the date of announcement of Storyboard Plus, 
IBM has tested these mice, tablets, and printers. 
IBM does not warrant the compatibility of non-IBM 
devices. 

2. Other input devices and printers can be used if a 
device driver exists. Your dealer may be able to iden­
tify additional input devices and printers as they 
become available. 

13 Kurta is a trademark of Kurta Corporation. 
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Appendix C. Working with 
Assistant Series Members 

The instructions in this appendix explain: 

• How to add Storyboard Plus to the Assistant Series 
Quick Menu/Setup menu. 

• How to get charts from Graphing Assistant so you can 
edit them in Picture Maker. 

• How to include pictures created by Picture Maker or 
enhanced Graphing Assistant charts in documents 
created by IBM Writing Assistant or IBM Displaywrite 
Assistant. 

ｾ＠ Adding Storyboard Plus to the Assistant 
Series Quick Menu 

To add Storyboard Plus to the Assistant Series Quick 
Menu, follow these steps: 

1. Copy the MENUl.EXE, MENU.SCR, and MENU.PRO 
files from the Storyboard Plus Diskette #1 to the subdi­
rectory where the Assistant Series Quick Menu files 
are installed using the DOS COPY command. 

2. Start the Assistant Series Quick Menu. With the Pro­
grams menu displayed, press F3 and the Menu Mainte­
nance screen appears. 

3. Select Option 1: Add a program to the menu and 
Ｎｾ＠ specify the drive and directory where the Storyboard 

Plus programs are located. 

Storyboard Plus will then be added to the Assistant 
Series Quick Menu Programs menu. 
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Note: You should use the Storyboard Plus Quick 
Menu/Setup program only to set up your set up options 
for Storyboard Plus. 

Preparing Graphing Assistant Charts for 
Picture Maker 

To save a Graphing Assistant chart for use in Picture 
Maker: 

1. Start Graphing Assistant. 

2. Create the chart that you want to use in Picture 
Maker; or, if the chart you want to use has already 
been -saved, get the chart from your disk. 

3. On the Graphing Assistant Main Menu, select Save 
(Option 5). 

4. Select IBM Assistant Series picture. Then type the 
name you want to give the chart, followed by a .PIC 
extension, at the Filename panel and press the Enter ｾ＠
key. The chart is saved in a file format that is accept-
able to Picture Maker. 

Getting a Graphing Assistant Chart in 
Picture Maker 

Before you can bring a Graphing Assistant chart into 
Picture Maker, the chart must be saved in Graphing 
Assistant using the IBM Assistant Series picture option 
on the Save File panel. The filename should be followed 
by a .PIC extension. 

To bring a chart into Picture Maker so you can edit it: 

1. Start Picture Maker. 

2. Select Draw from the Main Menu. 
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3. When the drawing screen appears, select Get Picture 
from the File menu. 

The File Services panel will appear on the screen with 
a list of the files on the disk. Position the pointer on 
the filename you want to get and press Button 1. That 
filename is now highlighted. 

Move the pointer to YES and press Button 1. The 
chart you retrieved is displayed in the drawing space. 
You can now edit it using any of Picture Maker's func­
tions. 

If you can't find the file you want, move the pointer to 
the j or i box to the right of the filename column and 
press Button 1 until you see the file you want. 

Adding Pictures to Writing Assistant or 
Displaywrite Assistant Documents 

To include a Picture Maker picture in a Writing Assistant 
ｾ＠ or Displaywrite Assistant document: 

1. Save the picture by selecting Save Picture from 
Picture Maker's File menu. 

2. After you save the picture, exit Picture Maker. 

3. Start Writing Assistant or Displaywrite Assistant. 

4. Type the command: 

*GRAPH Drive:filename* 

at the location in the document where you want the 
picture to be printed. (The command can be abbreviated to 
*G filename*.) 
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For example, to include a picture with the name 
LAYOUT .PIC which is located on a diskette in drive B, 
you type: 

*GRAPH B:LAYOUT .PIC* 

at the location in the document where you want the ｾ＠
picture to appear. This allows you to place your picture 
left to right, up or down, or in the center. The first 
asterisk of the GRAPH command determines the upper 
left-hand corner of the picture. 

When Writing Assistant or Displaywrite Assistant 
reaches the part of the document where the picture is to 
appear, it reads the picture file from the specified file 
and prints it in the correct location. If the picture will 
not fit on the current page, Writing Assistant or 
Displaywrite Assistant starts a new page before printing 
it. 

You can include as many pictures in a document as you 
want; just enter the command wherever you want the 
pictures to appear. ｾ＠

Note: Pictures created in 320 x 200 - 4 color mode and 
320 X 200 - 256 color mode will not be printed in 
Displaywrite Assistant and Writing Assistant. 
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Appendix D. Requests for PM 
Picture File and Digitize Driver 
Format 

If you would like information explaining the Picture 
Maker picture file format or the Digitize driver format, 
please call the IBM Problem Support Center at 
1-800-IBM-2266 or write to the following address 
requesting this information: 

IBM Corporation 
P.O. Box 720576 
Atlanta, GA 30358-2576 
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Appendix E. Constructing a 
Remote Control Adapter 

In the "Story Teller Reference" chapter of this book, 
under the topic "Using a Joystick," an adapter for using 
a Kodak EC-1 Remote Control was mentioned. Wiring 
and parts for this adapter are shown below. Con­
struction by a qualified electrician is recommended. 

Koda"® Remote Control Adapter 

5-Pln lnline Socket 

Note: The numbers shown above are on the wire side of 
the Radio Shack1 274-1215 socket. They do not corre­
spond to the numbers on the plug of the Kodak EC-1. 
(Plug pin 1 is socket pin 2; plug pin 2 is socket pin 1; 
plug pin 3 is socket pin 4; plug pin 4 is socket pin 3.) 

1 Radio Shack is a registered trademark of the Tandy Corporation. 
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The leads are connected to plug and socket pins as 
follows: 

5-pin socket lead 1 connects to 15-pin plug lead 2. 
5-pin socket lead 2 connects to 15-pin plug lead 5. 
5-pin socket lead 3 connects to 15-pin plug lead 12. 
5-pin socket lead 4 connects to 15-pin plug lead 7. Ｎｾ＠

5-pin socket lead 5 connects to 15-pin plug lead 4. 

Parts list: 

5-pin inline socket with 
leads 

15-pin subminiature D plug 
assembly 

15-pin subminiature D plug 
housing 

Locking screw retainer 

3/32" heat shrink tubing 

1/2" heat shrink tubing 

E-2 

Radio Shack 274-1215, or 
equivalent 

AMP 728-2, or equivalent 

AMP 728-3, or equivalent 

AMP 732-2, or equivalent 

ICO Rally "Heatrax" 8502, 
or equivalent 

ICO Rally "Heatrax" 
HIX-1/2, or equivalent 



Appendix F. Storyboard Plus on 
the IBM PC Local Area Network 

This appendix is an aid for Storyboard Plus users who 
want to use this product on the IBM PC Local Area 
Network (LAN). This Appendix assumes you are 
familiar with the IBM PC Local Area Network and 
have the IBM Local Area Network user's guide. 

Installing Storyboard Plus on the IBM 
PC LAN 

To use Storyboard Plus on the IBM PC Local Area 
Network, use Backup/Install to install Storyboard Plus 
on the server computer's fixed disk to each individual's 
private subdirectory. Each individual must have write 
access to his private subdirectory. 

You can install to the server only from the server com­
puter. You cannot install to the server from a remote 
node. 

Starting Storyboard Plus on the IBM PC 
Network 

If you are at the server computer, start Storyboard Plus 
according to the instructions in "Chapter 2 Getting 
Started." 

If you are at a remote computer, be sure you make the 
remote directory the default directory. Then follow the 
instructions in "Chapter 2, Getting Started." 
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Index 

Special Charac­
ters 

/* 5-35 
- command (TM) 6-34 

A command 6-24 
Action keys 5-25 
adding lines 6-37 
Additional story table 
columns 5-81 

aligning text 3-31 
Alt A command 6-24 
Alt B command 6-28 
Alt D command 6-31 
Alt E command 6-35 
Alt I command 
(TM) 6-38 

Alt K command 6-36 
Alt K command 
(TM) 6-37 

alt library (TM) 6-40 
Alt U command 6-43 
Alt X command 6-44 
Alter Color command 
(TM) 6-24 

altering picture colors 
(PM) 3-24 

Area 5-88 

B command 6-26 
background color 
Background color 
(PM) 3-34 

Background color 
(TM) 6-20 

Backup 1-6 
Backup copy 1-7 
Backup program 
diskette 1-7 

Backup/Install 
program 1-6-1-7 

install 1-6 
blink setting 6-21 
Bold type (PM) 3-62 
border color 6-22 
Box Draw 
command 6-26 

Brush Icon 3-80 
paint with brush 3-80 

Brush Shape (PM) 3-37 
Buff er Fill 3-32 
button status 3-5 

C command 6-28-6-31 
change 3-100 

lines 3-100 
Change background 
color 6-20 

Change Font (PM) 3-58 
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font 3-58 
type sty le 3-58 

Change font size 
(PM) 3-59 

Change Program 
name 1-27 

Change Quick 
Menu\Setup screen 
color 1-27 

Change. border 
color 6-22 

changing background 
text (TM) 6-22 

changing foreground 
text (TM) 6-22 

changing background 
color (PM) 3-34 

changing brush 
shapes ＳｾＳＷ＠

changing Color 
palette 3-91 

colors 3-91 
changing graph shadow 
color 3-47 

changing graph shadow 
size 3-47 

Changing libraries 
(PM) 3-51 

Changing PT 
options 4-5 

changing screen back­
ground color (PM) 3-26 

Changing shadow 
directions 2-38 

Changing text color 
(PM) 3-64 

changing text 
positions 3-61 

Changing Typeface 2-33 
Changing with Erase 
command 6-20 

Changing with Erase 
command (TM), 6-18 

Checker 5-86 

X-2 

Circle icon 2-12, 3-90 
circles made perfect 3-31 
CLEAR 5-35 
clear monitor 5-28 
Clearing the drawing 
space 2-26 

clearing the screen {\, 
(PM) 3-25 

COLOR 5-36 
Color Mode (PM) 3-93 

320 x 200 color 
mode 3-93 

320 x 200 256/256,000 
color mode 3-94 

640 x 200 16 color 
mode 3-97 

640 x 350 16 color 
mode 3-97 

640 x 480 16 color 
mode 3-97 

Color palette 3-91 
colors 3-91 

color palette (TM) 6-41 ｾＧ＠

color palette area 
fixed 3-41 

Color pattern area 3-101 
color pattern editing 
(PM) 3-37 

Color/ character 
table 6-15-6-22 

background 
color 6-20 

blink 6-21 
text character 6-15 

colors 3-91 
COMMAND 
column 5-33 

/* 5-35 
/Clear 5-35 
/Color 5-36 ｾ＠
/Display 5-37 
/End 5-56 
/Exec 5-54 



/Gosub 5-52 
/Goto 5-52 
/If 5-50 
/Ifnot 5-51 
/Input 5-49 
/Int 5-53 
/Lock off 5-55 
/Lock on 5-55 
/Move sprite 5-39 
/Music off 5-4 7 
/Music on 5-46 
/Palette 5-48 
/Print 5-48 
/Return 5-53 
/Show 5-38 
/Sound effects 5-45 
/Speak 5-44 
/Tell 5-55 
Input comment 5-34 

composite monitor 
(TM) 6-24 

composite video 
(TM) 6-24 

Composite Video 
(PM) 3-32 

Constrain (PM) 3-31 
Coordinates X, Y 3-40 
copy block 5-21 
Copy command 6-28 
copying a picture 
(PM) 3-28 

Create a new font 
(PM) 3-71-3-73 

Create or Edit (TM) 6-4 
creating a new color 
pattern 3-37 

creating and editing a 
story 5-8 

Creating animation 
sequences 5-94 

creating fonts 3-67 
Crosshair (PM) 3-32 
Crush 5-83 

Cursor movement 
(TM) 6-12 

Customizing 
program 1-13 

Using F2 =Setup 
Data path 1-15 
DOS Device 
Name 1-17 

F2 =Setup 1-13 
Input device 1-16, 
1-18 

Printer 1-21 
Resolution 
modes 1-23 

Screen color 1-23 
Sound On/Off 1-26 

Cut command 6-28-6-31 
Cutting a picture 
(PM) 3-23 

D command 6-31 
decreasing a picture 
size 3-22 

Default data path 1-15 
delete block 5-22 
delete line 5-20 
deleting a picture 3-17 
deleting lines 6-31 
Description of drawing 
screen 3-102 

Diagonal 5-86 
Diagonal keys (PM) 3-7 
Digitize (PM) 3-55 

Digitizing 
options 3-56 

Digitizing 
options 3-56-3-57 

DISPLAY 5-37 
Displaying 
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cursor location 6-44 
hint text 6-44 
screens from disk 6-5 

Displays (TM) 6-10 
DOS Device Name 1-17 

DOS Device 
Name 1-17 

Button 1-19 
Hand 1-18 

Double horizontally 
(PM) 3-60 

Double Vertically 3-60 
draw continuous line 
command 6-31 

draw option set 
command 6-34 

Drawing 2-6 
Exercise 2-6 

drawing colors 3-41 
drawing library picture 
(PM) 3-54 

Drawing screen 2-3 

E command 6-35 
Edit (TM) 6-4 
Edit menu (PM) 

X-4 

Alter Color 3-24 
Clear 3-25 
Cut 3-23 
Flip Horizontal 3-20 
Flip Vertical 3-20 
Invert 3-19 
Paste 3-24 
Rotate 3-20 
Scale 3-22 
Undo 3-19 

edit menu (SE) 5-19 
Edit Pattern 
(PM) 3-37-3-38 

Editing an existing font 
(PM) 3-71-3-73 

Elastic Box (TM) 6-14 
ellipses 3-31 
END 5-56, 5-73 
Ending Story Teller 7-4 
enlarging a picture 
size 3-22 

entering information on 
a story line 5-30 

Erase icon 2-22, 3-78 
Erase text (TM) 6-17 
Erase.with Draw 
command (TM) 6-17 

erasing a picture 3-17 
erasing the screen 
(PM) 3-25 

escape command 
(TM) 6-39 

EXEC 5-54 
exit 5-18 
Exit Draw 2-48 

Exiting Draw 2-48 
Exit font editor 
(PM) 3-68 

Exit Microscope 2-31 
exiting a menu 3-12, 
5-11 

Exiting File Menu 3-18 
Exiting the get capture 
file panel 5-63 

Exiting the Set Shadow 
panel 3-48 

Exiting to PM Main 
Menu 3-18 

Explode 5-84 
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Fade 5-84 
Fast, med, and slow 5-78 
File menu (PM) 

BSave 3-16 
File Services 
(PM) 3-9 

Get picture 3-13 
Main Menu 3-18 
Print picture 3-17 
Remove picture 3-17 
Save picture 
(PM) 3-15 

Show page 3-17 
file menu (SE) 5-12 
File Services (TM) 6-8 
File Services Panel 
(SE) 5-9 

Fill icon 2-23, 3-81 
Filling a shape 3-81 

filling a shape 
(PM) 3-30 

Fix Palette (PM) 3-41 
Flipping a picture hor­
izontally 3-20 

Flipping a picture verti­
cally 3-20 

Font Editor 3-65 
creating fonts 3-67 
Defining the font 
Baseline 3-70 

editing an existing 
font 3-71 

Exiting the font 
editor 3-68 

font editor using the 
Brush icon 3-69 

Font editor using the 
cut option 3-69 

Font editor using the 
paste option 3-70 

Font editor using the 
Pencil icon 3-68 

Font editor using the 
undo option 3-71 

Getting a font 3-65 
Keeping original font 
size 3-66 

Making a new 
font 3-71 

Saving fonts 3-66 
Scaling font to current 
size 3-66 

Selecting a font 
size 3-66 

foreground color 
Foreground color 
(TM) 6-18 

formats acceptable to 
Picture Maker/Story 
Editor besides A-7 

forty-column 
screens .6-24 

From picture to 
screen 5-88 

Full Screen 5-24 
Full Screen (PM) 3-41 
function 

Picture Maker x - xi 
Picture Taker ix 
Story Editor xi - xii 
Story Teller xii 

F2=Setup 1-13 
F3=Menu 
Maintenance 1-27 

X-5 



Get (TM) 6-5 
Get background 
color 5-68 

Get capture file 
panel 5-61 

Get color 5-57 
Get existing label 5-7 4 
Get existing name 5-60 
Get font (PM) 3-65 

Retrieving a font 3-65 
Get line color 5-87 
Get palette colors 5-67 
Get picture 2-6 
Get picture (PM) 3-13 
get story 5-12 
Get Text (PM) 3-64 
get voice file 5-16 
Get 1 color 5-58 
Get 2 colors 5-60 
Getting a picture 2-6 
Getting PM .Cap 
file 3-13 

Retrieving PM 
.CAP 3-13 

Getting screens from 
disk 6-5 

GOSUB 5-52 
Gosub label 5-72 
GOTO 5-52 
goto Label 5-32, 5-71 
Graph 3-42-3-50 
Graph (PM) 

X-6 

changing graph 
Appearance 3-46 

Changing shadow 
size 3-47 

Graph data 3-42 
Graph 
Parameters 3-43 

Graph type 3-43 

Multiple Color 
Fill 3-46 

One Color Fill 3-46 
Graph Appearance 
(PM) 3-46 

Graph Parameters 
(PM) 3-43 

Graph shadow box 3-48 
Graph type 
(PM) 3-43-3-46 

Graphing 2-41 
graphs 3-31 
Grids (PM) 3-31 

hardware requirements 
xiii 

optional equipment 
xiv 

hardware systems x 
Help 1-5 
Help for Text 
Maker 6-13 

TM-Help 6-13 
Help Text iii 
hint text 6-44 
Hint Text (TM) 6-13 
Hollow Shape (PM) 3-30 

Icon area 3-7 4 
Icons 

Brush 3-80 
Circle 3-90 
Erase 3-78 
Fill 3-81 
Line 3-88 

(\ 



Microscope 3-85 
Pencil 3-88 
Rectangle 3-89 
Scroll icon 3-75 
Select 3-76 
Spray 3-79 
Text 3-83 

IF 5-50 
IFNOT 5-51 
immediate palette 6-36 
increasing a picture 
size 3-22 

INPUT 5-49 
Input action time 5-78 
Input Comment 5-34 
Input device 1-16, 1-18 

Button 1-19 
Hand 1-18 

input device 
(joystick) 1-19 

Input label 5-31, 5-75 
Input name 5-64 
Input number 5-70 
Input parameters 5-76 
Input wait delay 5-79 
insert line 5-19 
inserting lines 6-37 
inserting text 3-57 

fonts 3-57 
installation disk 1-6 
Installing 
program 1-8-1-9 

INT 5-53 
Inverting a picture 3-19 
Italic (PM) 3-62 

joystick 1-19 
Joystick (ST) 7-4 

Keeping original font 
size (PM) 3-66 

Key 5-80 
keyboard buttons identi­
fied 3-6 

LABEL column 5-31 
Labelling a graph 
(PM) 3-50 

Library (PM) 3-50 
changing 
libraries 3-51 

drawing library 
picture 3-54 

library images 3-54 
Multiple color fill (for 
library 
pictures) 3-52 

One color fill (for 
library 
pictures) 3-52 

Set shadow 3-53 
View Picture 3-51 

Library (TM) 6-39 
licensing viii 
line 3-100, 5-86 

styles 3-100 
widths 3-100 

Line icon 2-26, 3-88 
lines 3-31 
LOCK OFF 5-55 
LOCK ON 5-55 
looking at a page 3-17 

X-7 



Magnifying part of a 
drawing 3-85 

Main Menu 3-18, 5-18 
Making a graph 3-48 
mark block 5-20 
Memory 
requirements 1-23 

Memory requirements for 
Font Editor 3-65 

Memory requirements for 
Switch Page 3-36 

Menu area 3-11 
merge story 5-13 
method and dir 5-82 
Microscope icon 2-28 
3-85 ' 

minimum memory x 
Minus key 3-6 
mistakes 3-78 
Modes menu (PM) 

Background 
Color 3-34 

Buff er Fill 3-32 
Composite Video 3-32 
Constrain 3-31 
Copy 3-28 
Crosshair 3-32 
Fill Shape 3-30 
Grid 3-31 
Hollow Shape 3-30 
Move 3"27 
Opaque 3-29 
Transparent 3-29 
Transparent 
color 3-33 

Modes menu (SE) 5-23 
Monitor 5-24 
Monochrome 6-4 
mouse buttons 
identified 3-4 

X-8 

Mouse Operation 3-4 
move command 6-28 
MOVE SPRITE 5-39 
moving a drawing 
(PM) 3-27 

Moving text 3-61 
moving the cursor ｾ＠
(TM) 6-12 

Multiple Color Fill 3-46 
Multiple color fill (for 
library pictures) 3-52 

MUSIC OFF 5-47 
MUSIC ON 5-46 

no label 5-32 
No line 5-87 
None 5-83 
Normal 5-66 

0 (no wait) 5-69 
One Color Fill 3-4 7 
ｏｾ･＠ color fill (for library 
pictures) 3-52 

Opaque (PM) 3-29 
making a color 
opaque 3-29 

opening a menu 3-12, 
5-11 

Operating considerations 
for PT 4-4 

outlining text 2-35 
Outlining type ｾ＠
(PM) 3-62 

ovals 3-31 
Overview iii 



P command 6-38 
paintbrush 3-37 
PALETTE 5-48 
palette (TM) 6-41 
Parameters column 5-57 
Paste command 6-38 
pasting a picture 
(PM) 3-24 

Pencil icon 3-88 
freehand 
drawing 3-88 

Using the pencil 
icon 3-88 

Picture files (PM) 3-13 
Picture Maker 5-23 

Brush 3-80 
Circle 3-90 
Erase 3-78 
Fill 3-81 
Line 3-88 
Microscope 3-85 
Pencil 3-88 
Rectangle 3-89 
Scroll 3-75 
Select 3-76 
Spray 3-79 
Text 3-83 

Picture Taker 
introduction 4-2 

playback 5-17 
Plus key 3-6 
PM Keyboard mode 3-6 
Pointer 2-4 
Practicing drawing 2-6 
PRINT 5-48 
print options 3-18 
print story 5-18 
Printer 1-21 
Printing a picture 
(PM) 3-17 

Problem reporting 
form vi 

program names 1-27 
program specifications 

function 
Picture Maker x -
xi 

Picture Taker ix 
Story Editor xi -
xii 

Story Teller xii 
hardware require­
ments xiii 

optional equipment 
xiv 

ｳｯｾｴｷ｡ｲ･＠ requirements 
XlV 

Push 5-84 

Quick Menu/Setup 1-12 
Quick 
Menu/Setup-Help 1-5 

Quick Reference 
Card m 

rearranging program 
names 1-27 

Selecting draw 2-3 
record voice 5-14 
recording 5-17 
Rectangle icon 2-8, 3-89 

Icons 2-8 
Circle 2-12 
Erase 2-22 
Fill 2-23 

X-9 



Line 2-26 
Microscope 2-28, 
2-31 

Rectangle Icon 2-8 
Text 2-31 

reducing a picture 
size 3-22 

remote control 
adapter E-1 

Remove (TM) 6-8 
Remove Picture 3-17 
remove story 5-14 
Removing picture 2-26 
Removing program 1-10 
Replace 5-85 
resolution mode 
chart 3-41 

Resolution modes 1-23 
Retrieve picture 
(PM) 3-13 

Retrieving a picture 2-6 
Retrieving PT . Cap pic­
tures 4-6 

Retrieving screens from 
disk 6-5 

RETURN 5-53 
Returning 7-4 
Returning to PM Main 
Menu 3-18 

Rewrite last Text 
(PM) 3-57 

Rotating a picture 3-20 
Run menu (SE) 5-25 
run story 5-27 

Save (TM) 6-6 
Save BSave 320 x 200 
(PM) 3-16 

Save ｐｩ｣ｴｵｲｾ＠ (PM) 3-15 
save story 5-12 

X-10 

save voice file 5-16 
Saving a font (PM) 3-66 
Saving a picture 2-13 
Scale font to current size 
(PM) 3-66 

Scaling a picture 3-22 
Screen Color 1-23 
screen library 6-39 
scrolling Story Table 
lines 5-29 

Select icon 3-76 
Select Library 6-11 

select library 
(TM) 6-11 

Selecting a font size 
(PM) 3-66 

selecting brushes 3-37 
Selecting foreground 
color (TM) 6-18 

selecting library 
images 3-54 

selecting menu options 
with a keyboard 5-6 

Selecting type 
styles 3-64 

service, statement of xv 
- XVll 

Set on monitor and set 
on full screen 5-90 

Set Shadow 
(PM) 3-38-3-40 

Set Spacing panel 
(PM) 3-60-3-61 

Set text attributes 
Change Font 3-58 
Change Font 
Size 3-59 

change text 
position 3-61 

Changing text 
color 3-64 

Double 
Hori?:ontally 3-60 



Double 
Vertically 3-60 

Selecting type 
styles 3-62 

Set Spacing 3-60 
Shadowing text 3-63 
Spacing text 3-61 

Setting shadow 
(PM) 3-53 

Setting up program 1-13 
Setup menu 1-14 

date 1-14 
Shadow directions 2-38 
Shadowing a 
picture 3-38 

Shadowing text 2-36 
Shadowing type 3-63 
Shadowing type 
(PM) 3-62 

SHOW 5-38 
Show Page (PM) 3-17 
software x 
software requirements 
Xlll 

SOUND EFFECTS 5-45 
Sound on/off 1-26 
Spacing text 
(PM) 3-61-3-62 

SPEAK 5-44 
Split 5-85 
Spray Icon 3-79 
spray painting 3-79 
squares made 
perfect 3-31 

start new story 5-22 
Starting Picture 
Taker 4-2 

Starting Story 
Editor 5-5 

Starting Storyboard 
Plus 1-11 

Starting text maker 6-3 
Status 2-12 
Status boxes 2-12 

step story 5-26 
Story Editor menus 5-11 
Story Table 5-28 
Story Teller 7-4 

backing up in the 
story (-) 7-4 

branching to a label 
(/) 7-4 

resuming the story 
(F6) 7-4 

stepping through the 
story (F5) 7-4 

stopping the story 
(Esc) 7-4 

Story Teller Reference 
Introduction 7-2 
Special keys 7-4 

backing up in the 
story (-) 7-4 

branching to a 
label (/) 7-4 

resume running the 
story (F6) 7-4 

Returning ( + ) 7-4 
stepping through 
the story (F5) 7-4 

stopping the story 
(Esc) 7-4 

Start Story Teller 7-3 
Starting the story 7-3 

Storyboard Plus installa­
tions 1-8 

program 
installations 1-8 

straight lines 3-88 
Stripes 5-85 
Supported 
Hardware B-1 

CPUs B-1 
Displays B-2 
Graphic cards B-2 
Input device B-4 
Printers B-3 

X-11 



Switch Page 
(PM) 3-35-3-36 

T command 6-41 
Taking pictures using 
PT 4-5 

TELL 5-55 
Text character 6-15 

Erase text (TM) 6-17 
examples of text 
(TM) 6-17 

Text Entry 
command 6-41 

Text icon 2-31, 3-83 
Changing 
Typeface 2-33 

creating fonts 3-67 
Outlining 2-35 
Shadowing text 2-36 

Text maker 6-3 
with two 
monitors 6-4 

Text Menu 3-57 
Text menu (PM) 

Change Font 3-58 
Change Font 

X-12 

Size 3-59 
change text 
position 3-61 

Changing text 
color 3-64 

defining the font 
Baseline 3-70 

Double 
Horizontally 3-60 

Double 
Vertically 3-60 

editing an existing 
font 3-71 

Exiting the font 
editor 3-68 

Font editor 3-65 
font editor using cut 
option 3-69 

font editor using the 
Brush icon 3-69 

font editor using the 
paste option 3-70 

Font editor using the 
Pencil icon 3-68 

font editor using the 
undo option 3-71 

Get Text 3-64 
getting a font 3-65 
Keeping original font 
size 3-66 

Making a new 
font 3-71 

Memory requirements 
(Font Editor) 3-65 

Rewrite Last 
Text 3-57 

Saving fonts 3-66 
Scaling font to current 
size 3-66 

Selecting a font 
size 3-66 

Selecting type 
styles 3-62 

Set Spacing 3-60 
Set Text 
Attributes 3-58 

shadowing text 3-63 
Spacing text 3-61 

Time 5-77 
Tools menu (PM) 

Brush Shapes 3-37 
changing 
libraries 3-51 

Digitize 3-55 
drawing library pic­
tures 3-54 



Edit Pattern 3-37 
Fix Palette 3-41 
Full Screen 3-41 
Graph 3-42 
Graph 
appearance 3-46 

Graph data 3-42 
Graph 
parameters 3-43 

Graph shadows 3-4 7 
Graph type 3-43 
Library 3-50 
memory requirements 
for Switch page 3-36 

Multiple color fill (for 
library 
pictures) 3-52 

One color fill (for 
library 
pictures) 3-52 

selecting library 
images 3-54 

Set Shadow 3-38 
Set shadow (for 
library 
pictures) 3-53 

Switch Page 3-35 
View picture 3-51 
X Y Coordinates 3-40 

' Zoom 3-40 
Transferring files 1-26 
Transparent (PM) 3-29 

making a color trans­
parent 3-29 

Transparent color 
(PM) 3-33 

Turn page 5-66 
Turning a picture 3-20 
Tutorial 2-6 
Type Styles (PM) 3-62 
typing text 3-57 

U command 6-43 
Underlining type 
(PM) 3-62 

Undo command 6-43 
Undoing a step 
(PM) 3-19 

unmark block 5-22 
Use pm palette 5-69 
Using a joystick 7-4 
Using a joystick 
(ST) 7-4 

Using a select box with 
/clear and /color 5-90 

Using a select box with 
/display and 
/show. 5-91 

Using composite video 
(PM) 3-32 

Using Fl=Help 1-5 
Using F3 =Menu Mainte­
nance 1-27 

F3 =Menu Mainte­
nance 1-27 

Change Program 
name 1-27 

Change Quick 
Menu/Setup 
color 1-27 

Using get picture 5-62 
Using input 
coordinates 5-93 

Using Picture 
Maker 3-4 

Using the 
Color/Character 
Table 6-15 

using the file services 
panel 5-10 

Using the Graph 
option 2-41 

X-13 



Using the Keyboard with 
PM 3-6 

using the keyboard with 
SE 5-6 

Using the PrtSc key with 
PT 4-4 

using the screen 
libraries 6-39 

using the select library 
(TM) 6-11 

Using view picture 5-63 

Video Capture 
(PM) 3-55 

Video Cassette Recorder 
(VCR) PM 3-32 

View .Cap pictures 
(PM) 3-14 

View picture 5-65 
View picture (PM) 3-51 
viewing a page 3-17 

X-14 

Wait column 5-79 
warranty viii 
Weave 5-86 
writing text on 
screens 6-41 

X command 6-44 
x, y coordinate display 
command 6-44 

X, Y Coordinates 3-40 

Zoom (PM) 3-40 

I Numerics I 
0 5-80 
1 Keystroke 5-70 
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Continued from inside front cover. 

SUCH WARRANTIES ARE IN LIEU OF 
ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. 

Some states do not allow the exclusion 
of implied warranties, so the above 
exclusion may not apply to you. 

LIMITATION OF REMEDIES 
IBM's entire liability and your exclusive 
remedy shall be as follows: 
1) IBM will provide the warranty 

described in IBM's Statement of 
Limited Warranty. If IBM does not 
replace defective media or, if appli­
cable, make the Program operate as 
warranted or replace the Program 
with a functionally equivalent Pro­
gram, all as warranted, you may 
terminate your license and your 
money will be refunded upon the 
return of all of your copies of the 
Program. 

2) For any claim arising out of IBM's 
limited warranty, or for any other 
claim whatsoever related to the 
subject matter of this Agreement, 
IBM's liability for actual damages, 
regardless of the form of action, 
shall be limited to the greater of 
$5,000 or the money paid to IBM, its 
Authorized Dealer or its approved 
supplier for the license for the 
Program that caused the damages 
or that is the subject matter of, or is 
directly related to, the cause of 
action. This limitation will not apply 
to claims for personal injury or 
damages to real or tangible personal 
property caused by IBM's negligence. 

3) In no event will IBM be liable for any 
lost profits, lost savings, or any 
incidental damages or other conse­
quential damages, even if IBM, its 
Authorized Dealer or its approved 
supplier has been advised of the 
possibility of such damages, or for 
any claim by you based on a third 
party claim. 

Some states do not allow the limitation 
or exclusion of incidental or consequen­
tial damages so the above limitation or 
exclusion may not apply to you. 

GENERAL 
You may terminate your license at any 
time by destroying all your copies of the 
Program or as otherwise described in 
this Agreement. 

IBM may terminate your license if you 
fail to comply with the terms and condi­
tions of this Agreement. Upon such 
termination, you agree to destroy all your 
copies of the Program. 

Any attempt to sublicense, rent, lease or 
assign, or, except as expressly provided 
herein, to transfer any copy of the 
Program is void. 

You agree that you are responsible for 
payment of any taxes, including personal 
property taxes, resulting from this 
Agreement. 

No action, regardless of form, arising 
out of this Agreement may be brought by 
either party more than two years after 
the cause of action has arisen except for 
breach of the provisions in the Section 
entitled "License" in which event four 
years shall apply. 

This Agreement will be construed under 
the Uniform Commercial Code of the 
State of New York. 
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